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Πεξίιεςε 

 
΢θνπφο ηεο παξνχζαο δηπισκαηηθήο είλαη ε παξνπζίαζε ηνπ ινγηζκηθνχ παθέηνπ 

DIgSILENT PowerFactory θαη ε δηεξεχλεζε ησλ δπλαηνηήησλ πνπ παξέρεη αλαθνξηθά κε ηε 

κειέηε ξνψλ θνξηίνπ, ηφζν ζε απιά δίθηπα ειεθηξηθήο ελέξγεηαο φζν θαη ζε ειεθηξηθά 

δίθηπα πινίσλ. Παξάιιεια, γίλεηαη αλαθνξά θαη ζην πεδίν ηεο εθθίλεζεο επαγσγηθψλ 

θηλεηήξσλ κε ζηφρν ηε κειέηε ηεο δηαδηθαζίαο απηήο ζε δίθηπα πινίσλ. ΢ηελ θαηεχζπλζε 

απηή, ε δηπισκαηηθή επηρεηξεί αθελφο λα θαηαζηήζεη ην PowerFactory πην εχρξεζην θαη 

θαηαλνεηφ αθαδεκατθά, θαζφηη είλαη έλα ζχλζεην ππνινγηζηηθφ παθέην πςεινχ επηπέδνπ, 

θαη αθεηέξνπ λα επηιχζεη πξνβιήκαηα πνπ ζρεηίδνληαη κε ηε κνληεινπνίεζε ειεθηξηθψλ 

δηθηχσλ πινίσλ θαη ηελ κειέηε ξνήο θνξηίνπ ζηελ πιαηθφξκα ηνπ ελ ιφγσ πξνγξάκκαηνο. 

Αξρηθά, πξαγκαηνπνηείηαη κία εηζαγσγή ζηα βαζηθά ραξαθηεξηζηηθά θαη ηηο ιεηηνπξγίεο ηνπ 

πξνγξάκκαηνο. ΢ηε ζπλέρεηα, εθηίζεληαη νη απαξαίηεηεο αλαθνξέο ζηε ζεσξία ησλ ξνψλ 

θνξηίνπ ζε έλα ζχζηεκα ειεθηξηθήο ελέξγεηαο κε ζηφρν ηελ θαηαλφεζε ηεο κεζνδνινγίαο 

πνπ εθαξκφδεηαη θαη ζην ινγηζκηθφ ηνπ PowerFactory. Καηφπηλ, παξνπζηάδεηαη αλαιπηηθά ν 

ηξφπνο κνληεινπνίεζεο θαη ππνινγηζκνχ ξνψλ θνξηίνπ  απινπνηεκέλσλ ειεθηξηθψλ 

δηθηχσλ κε έκθαζε ζηα δίθηπα πνπ θαιείηαη λα αληηκεησπίζεη έλαο θνηηεηήο ζηα αληίζηνηρα 

πξνπηπρηαθά καζήκαηα ηεο ζρνιήο Ναππεγψλ Μεραλνιφγσλ Μεραληθψλ. Αθνινπζεί έλα 

αληηπξνζσπεπηηθφ παξάδεηγκα κειέηεο εθθίλεζεο αζχγρξνλνπ θηλεηήξα ελφο πξαγκαηηθνχ 

πινίνπ μεξνχ θνξηίνπ. Σέινο, ζρεδηάδεηαη έλα ππαξθηφ δίθηπν ειεθηξηθήο ελέξγεηαο 

δεμακελφπινηνπ κε ζηφρν ηνλ ππνινγηζκφ ηεο ξνήο θνξηίνπ ζε δηαθνξεηηθέο θαηαζηάζεηο, 

αληηκεησπίδνληαο παξάιιεια ην πξφβιεκα δηακνηξαζκνχ ηεο απαηηνχκελεο ηζρχνο ζηηο 

γελλήηξηεο ηνπ ζπζηήκαηνο.  

 

Λέμεηο θιεηδηά: ζπζηήκαηα ειεθηξηθήο ελέξγεηαο πινίσλ, DIgSILENT PowerFactory, 

αλαπαξάζηαζε ειεθηξηθψλ δηθηχσλ πινίσλ, ξνή θνξηίνπ, εθθίλεζε θηλεηήξα, ξεχκα 

εθθίλεζεο, power frequency controller 
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Abstract  

 
The aim of this diploma thesis is the presentation of the DIgSILENT PowerFactory software 

and the exploration of the opportunities it offers regarding the study of load flow both on 

simple electricity networks and on ship electrical networks. A reference is also made to the 

field of induction motor starting aiming to the study of this procedure on ship networks. In 

this direction, on the one hand, the thesis attempts to make PowerFactory user friendlier and 

comprehensible academically, because it is a complex and superior computing package, and, 

on the other hand, to resolve problems related to the modeling of ship electrical networks and 

the load flow study on the PowerFactory platform. Initially, an introduction to the basic 

characteristics and the functions of the program is made. Subsequently, the necessary 

references to the load flow theory on a power system aiming to the comprehension of the 

methodology that is applied on the PowerFactory software. In the next step, the modeling 

and load flow calculation on simple electrical networks are represented with emphasis on 

networks that an undergraduate student is asked to deal with at relative courses of the School 

of Naval Architecture and Marine Engineering. A representative example of an inductive 

motor starting simulation follows, which belongs to a real dry cargo ship. Finally, a real ship 

electricity network is modeled for load flow calculations to be done in different loading 

conditions, while dealing with the problem of the required power distribution among the 

system generators. 

 

 

Keywords: ship power systems, DIgSILENT PowerFactory, ship electrical networks 

representation, load flow, motor starting, starting current, power frequency controller 
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ΚΕΥΑΛΑΙΟ 1 
 

Ειςαγωγό 
 

Ζ παξνχζα δηπισκαηηθή εξγαζία εθπνλήζεθε θαηά ην αθαδεκατθφ έηνο 2015-2016 ζηνλ 

Σνκέα Ναπηηθήο Μεραλνινγίαο ηεο ΢ρνιήο Ναππεγψλ Μεραλνιφγσλ Μεραληθψλ ηνπ 

Δζληθνχ Μεηζφβηνπ Πνιπηερλείνπ. Πεδίν εθαξκνγήο ηεο είλαη ε ζρεδίαζε θαη ε αλάιπζε 

ζπζηεκάησλ ειεθηξηθήο ελέξγεηαο πινίσλ κε ηε βνήζεηα ειεθηξνληθνχ ππνινγηζηή. 

Δπηρεηξεί λα ζπκβάιεη, θπξίσο απφ αθαδεκατθή άπνςε, ζηηο ζχγρξνλεο αλάγθεο 

αλαπαξάζηαζεο ειεθηξηθψλ δηθηχσλ θαη ειεθηξνινγηθψλ αξηζκεηηθψλ ππνινγηζκψλ κε ηε 

ρξήζε ηζρπξψλ θαη νινθιεξσκέλσλ ππνινγηζηηθψλ εξγαιείσλ. Υαξαθηεξηζηηθή είλαη ε 

πεξίπησζε ηεο κειέηεο ξνήο ηζρχνο ζε ειεθηξηθά δίθηπα κε έκθαζε ζηα δίθηπα πινίσλ.  

 

Αληηθείκελν ηεο παξνχζαο δηπισκαηηθήο εξγαζίαο είλαη ε παξνπζίαζε ηνπ ινγηζκηθνχ 

DIgSILENT PowerFactory θαη ε δηεξεχλεζε ησλ δπλαηνηήησλ πνπ πξνζθέξεη αλαθνξηθά κε 

ηε κειέηε ξνψλ θνξηίνπ ηφζν ζε απιά δίθηπα ειεθηξηθήο ελέξγεηαο φζν θαη ζε ειεθηξηθά 

δίθηπα πινίσλ. ΢θνπφο ηεο εξγαζίαο είλαη αθελφο λα θαηαζηήζεη ην PowerFactory πην 

εχρξεζην θαη θαηαλνεηφ αθαδεκατθά, θαζφηη είλαη έλα ζχλζεην ππνινγηζηηθφ παθέην 

πςεινχ επηπέδνπ, θαη αθεηέξνπ λα επηιχζεη πξνβιήκαηα πνπ ζρεηίδνληαη κε ηε 

κνληεινπνίεζε ειεθηξηθψλ δηθηχσλ πινίσλ θαη ηελ κειέηε ξνήο θνξηίνπ ζηελ πιαηθφξκα 

ηνπ ελ ιφγσ πξνγξάκκαηνο. 

 

Σν PowerFactory ηεο εηαηξείαο DIgSILENT είλαη έλα ηδηαίηεξα ρξήζηκν ινγηζκηθφ αλάιπζεο 

ζπζηεκάησλ ειεθηξηθήο ελέξγεηαο, ην νπνίν ρξεζηκνπνηείηαη γηα εθαξκνγέο ζρεηηθέο κε ηελ 

παξαγσγή, ηε κεηάδνζε θαη ηε δηαλνκή ειεθηξηθήο ελέξγεηαο, θαζψο θαη γηα κειέηεο 

βηνκεραληθψλ ζπζηεκάησλ, κε ηε βνήζεηα ειεθηξνληθνχ ππνινγηζηή. ΢ρεδηάζηεθε σο έλα 

πξνεγκέλν θαη νινθιεξσκέλν ινγηζκηθφ παθέην εηδηθά γηα ηελ αλάιπζε ειεθηξηθψλ 

ζπζηεκάησλ  ειέγρνπ, έηζη ψζηε λα επηηπγράλνληαη νη θχξηνη ζηφρνη ηεο βειηηζηνπνίεζεο 

ζην ζρεδηαζκφ θαη ηε ιεηηνπξγία ησλ ζπζηεκάησλ απηψλ. Σν DIgSILENT είλαη αθξσλχκην 

ηνπ «Digital SImuLation of Electrical NeTworks». Ζ έβδνκε έθδνζε ηνπ παθέηνπ απνηέιεζε 

ην πξψην παγθνζκίσο ινγηζκηθφ αλάιπζεο ζπζηεκάησλ ελέξγεηαο κε έλα νινθιεξσκέλν 

γξαθηθφ κνλνγξακκηθφ πεξηβάιινλ. Σν κνλνγξακκηθφ απηφ δηάγξακκα πεξηειάκβαλε 

δηάθνξεο ιεηηνπξγίεο ζρεδηαζκνχ, επηινγέο παξακεηξνπνίεζεο θαζψο θαη φιεο ηηο επηινγέο 

ζηαηηθψλ θαη δπλακηθψλ ππνινγηζκψλ. 

 

Σν PowerFactory ζρεδηάζηεθε θαη αλαπηχρζεθε απφ θαηαξηηζκέλνπο κεραληθνχο θαη 

πξνγξακκαηηζηέο κε εκπεηξία πνιιψλ ρξφλσλ ηφζν ζηα ειεθηξηθά ζπζηήκαηα ηζρχνο φζν 

θαη ζην πεδίν ηνπ πξνγξακκαηηζκνχ. Ζ αθξίβεηα θαη ε εγθπξφηεηα ησλ απνηειεζκάησλ πνπ 

ιακβάλνληαη απφ ην PowerFactory έρνπλ επηβεβαησζεί ζε έλα κεγάιν αξηζκφ εθηειέζεσλ 

απφ νξγαληζκνχο ζε φιν ηνλ θφζκν, νη νπνίνη αζρνινχληαη κε ην ζρεδηαζκφ θαη ηε 

ιεηηνπξγία ζπζηεκάησλ ειεθηξηθήο ελέξγεηαο. Ζ ρξήζε κίαο κφλν βάζεο δεδνκέλσλ, πνπ 

πεξηιακβάλεη φια ηα ζηνηρεία πνπ κπνξνχλ λα ζπκκεηέρνπλ ζε έλα ζχζηεκα ηζρχνο 
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(ζηνηρεία γελλεηξηψλ, ζηνηρεία γξακκψλ, ζηνηρεία πξνζηαζίαο θ.ιπ.), δίλεη ηε δπλαηφηεηα λα 

εθηειεζηνχλ εχθνια φιεο νη γλσζηέο ιεηηνπξγίεο πξνζνκνίσζεο ησλ ζπζηεκάησλ. 

 

Ζ γεληθή ηδέα γηα ην ζρεδηαζκφ ζπζηεκάησλ ζηελ πιαηθφξκα ηνπ PowerFactory 

ζπλνςίδεηαη ζηα εμήο ζεκεία: 

 Σν ινγηζκηθφ απηφ ρξεζηκνπνηείηαη ζαλ έλα απιφ εθηειέζηκν πξφγξακκα θαη είλαη 

ζπκβαηφ κε ηηο πεξηζζφηεξεο εθδφζεηο ησλ Windows. Ζ κέζνδνο πξνγξακκαηηζκνχ 

επηηξέπεη ηε γξήγνξε θαη εχθνιε επηινγή δηάθνξσλ ππνινγηζκψλ. Γελ είλαη 

αλαγθαίν λα ελεκεξσζνχλ θαη λα κεηαθεξζνχλ ηα δεδνκέλα θαη ηα απνηειέζκαηα 

κεηαμχ ησλ δηάθνξσλ εθαξκνγψλ ηνπ πξνγξάκκαηνο. Γηα παξάδεηγκα, ε ξνή 

θνξηίνπ, ηα βξαρπθπθιψκαηα θαη ε αλάιπζε αξκνληθψλ, κπνξνχλ λα εθηειεζηνχλ 

δηαδνρηθά ρσξίο λα γίλεη επαλαθνξά ηνπ πξνγξάκκαηνο θαη ρσξίο λα ρξεηάδεηαη λα 

ελεξγνπνηεζνχλ άιιεο ιεηηνπξγίεο θαη ππνπξνγξάκκαηα ηνπ ινγηζκηθνχ. 

 Σα κνληέια, ηα νπνία ζρεδηάδνληαη κε ην ινγηζκηθφ απηφ, κπνξνχλ λα κνηξάδνληαη 

γηα λα εθηειεζηνχλ φιεο νη αλαιχζεηο. Δπηπξφζζεηα, κειέηεο πνπ αθνξνχλ ηελ 

παξαγσγή ξεχκαηνο, ηε δηαλνκή θαη ηελ αλάιπζε βηνκεραληθψλ ζπζηεκάησλ 

κπνξνχλ λα νινθιεξσζνχλ κέζα ζην PowerFactory. Γε ρξεηάδνληαη, δειαδή, 

μερσξηζηά πξνγξάκκαηα γηα λα γίλεη ε αλάιπζε ησλ δηάθνξσλ ηνκέσλ 

ελδηαθέξνληνο ελφο ζπζηήκαηνο (ξνή θνξηίνπ, βξαρπθχθισκα θ.ιπ.), θαζψο ην 

PowerFactory κπνξεί λα δηεθπεξαηψζεη ηα πάληα κέζα ζε έλα νινθιεξσκέλν 

πξφγξακκα θαη κία νινθιεξσκέλε βάζε δεδνκέλσλ. 

 Σν πξφγξακκα πξνζθέξεη άξηζηε νξγάλσζε δεδνκέλσλ θαη νξηζκψλ, πνπ είλαη 

απαξαίηεηα γηα λα εθηειεζηνχλ νη δηάθνξνη ππνινγηζκνί, θαζψο θαη πιήξε 

απνκλεκφλεπζε ησλ ξπζκίζεσλ ηνπ ρξήζηε. Σν πεξηβάιινλ ηεο βάζεο δεδνκέλσλ 

ηνπ PowerFactory ελνπνηεί φια ηα δεδνκέλα πνπ ρξεηάδνληαη γηα ηελ πινπνίεζε 

ππνζέζεσλ εξγαζίαο (study cases), ζελαξίσλ ιεηηνπξγίαο (operation scenarios), 

κνλνγξακκηθψλ ζρεδίσλ θαη απνηειεζκάησλ ηφζν ζε θείκελν φζν θαη ζε γξαθηθφ 

πεξηβάιινλ (δηαγξάκκαηα θ.ιπ.).  

 Όια ηα δεδνκέλα, ηα νπνία θαζνξίδνπλ έλα κνληέιν ζπζηήκαηνο ελέξγεηαο, 

απνζεθεχνληαη ζην θάθειν project ηεο βάζε δεδνκέλσλ (database). Μέζα ζε έλαλ 

ηέηνην θάθειν, νη study cases ρξεζηκνπνηνχληαη γηα λα θαζνξίδνπλ δηαθνξεηηθέο 

κειέηεο ηνπ ίδηνπ ζπζηήκαηνο, ιακβάλνληαο ππφςε νιφθιεξν ην δίθηπν θαη 

θνκκάηηα απηνχ ή δηαθνξνπνηήζεηο ζηελ θαηάζηαζε ηνπ.  

 Σν πξφγξακκα πξνζθέξεη, επίζεο, ιεηηνπξγία γηα πνιιαπινχο ρξήζηεο, φπνπ ν 

θαζέλαο έρεη ην δηθφ ηνπ project ή κπνξεί λα κνηξάδεηαη θαη δεδνκέλα απφ άιινπο 

ρξήζηεο. Ο ιεγφκελνο database administrator ηνπ PowerFactory είλαη ππεχζπλνο γηα 

ηα αλσηέξσ. Δπηπιένλ, πξνζθέξεη ηε δπλαηφηεηα ζην ρξήζηε λα πξνζαξκφζεη 

θαηάιιεια ην «πξνθίι» ηνπ κε βάζε ηηο πξνηηκήζεηο ηνπ. Σν πξνεπηιεγκέλν πξνθίι 

είλαη ην Base Package, ην νπνίν πεξηιακβάλεη ηηο βαζηθέο εληνιέο ζηε βαζηθή 

γξακκή εξγαιείσλ πνπ ρξεζηκνπνηεί έλαο λένο ρξήζηεο, φπσο ην Load Flow θαη ην 

Short-Circuit.  Απφ εθεί θαη πέξα, ν ρξήζηεο κπνξεί λα πξνζαξκφζεη θαη λα 

δηακνξθψζεη πιήξσο ηε γξακκή εξγαιείσλ, ηε γξακκή εξγαιείσλ ζρεδίαζεο, ην 

θχξην κελνχ, ηνλ Data Manager, ηα παξάζπξα ξπζκίζεσλ θάζε ζηνηρείνπ (element 

dialogue) θ.ν.θ. 

 

Ζ εξγαζία απνηειείηαη απφ επηά (7) θεθάιαηα, ην πξψην εθ ησλ νπνίσλ είλαη ε παξνχζα 

εηζαγσγή, κε ηε δνκή ηεο λα εθθηλεί απφ ηε γεληθή παξνπζίαζε ηνπ πξνγξάκκαηνο, λα 

πεξηιακβάλεη ηηο απαξαίηεηεο ζεσξεηηθέο αλαθνξέο θαη λα επηθεληξψλεηαη ζηελ αλάιπζε 

ξνψλ θνξηίνπ θαη δεπηεξεχνληνο ζηελ εθθίλεζε θηλεηήξσλ. Σν Κεθάιαην 2 απνηειεί κία 

εηζαγσγή ζηηο βαζηθέο πηπρέο ηνπ PowerFactory, κέζα απφ ηελ έθζεζε αλαιπηηθψλ νδεγηψλ 
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γηα ηε ιεηηνπξγία ηνπ, πξνθεηκέλνπ λα θαηαζηεί εθηθηή ε αθαδεκατθή ρξήζε ηνπ γηα 

εθαξκνγέο ζην πεδίν ηεο λαπηηθήο κεραλνινγίαο. Σν Κεθάιαην 3 εθζέηεη, ζε γεληθέο 

γξακκέο, ηε ζεσξία ξνψλ θνξηίνπ κε έκθαζε ζηελ αξηζκεηηθή κέζνδν επίιπζεο Newton-

Raphson. Σν Κεθάιαην 4 παξνπζηάδεη ηελ κνληεινπνίεζε απιψλ ειεθηξηθψλ δηθηχσλ επί 

ησλ νπνίσλ πξαγκαηνπνηνχληαη ππνινγηζκνί ξνψλ θνξηίνπ, ψζηε λα δηεξεπλεζνχλ ηα 

πξνβιήκαηα πνπ πξνθχπηνπλ θαηά ηε δηαδηθαζία θαη λα εμεηαζηνχλ ηα απνηειέζκαηα ησλ 

πξνζνκνηψζεσλ ππφ ην πξίζκα ησλ θιαζηθψλ ζεσξεηηθψλ ζρέζεσλ ηεο ειεθηξνηερλίαο. Σν 

Κεθάιαην 5 ζπληζηά κηα εθθίλεζε επαγσγηθνχ θηλεηήξα, κε αλαθνξά ζην ξεχκα εθθίλεζεο 

θαη ηελ πξνθαινχκελε πηψζε ηάζεο. Σν Κεθάιαην 6 παξνπζηάδεη κία αληηπξνζσπεπηηθή 

πεξίπησζε κειέηεο ξνψλ θνξηίνπ ζην ειεθηξηθφ δίθηπν ελφο πξαγκαηηθνχ πινίνπ 

κεηαθνξάο παξαγψγσλ πεηξειαίνπ, κε βάζε ζρεηηθφ θπιιάδην ηνπ πινίνπ γηα ηνλ ειεθηξηθφ 

ηζνινγηζκφ ζε δηάθνξεο θαηαζηάζεηο. Σέινο, ην Κεθάιαην 7 πεξηιακβάλεη ηα αλαγθαία 

ζπκπεξάζκαηα, ηφζν γηα ηε ζπλεηζθνξά ηεο εξγαζίαο φζν θαη γηα ηε ρξεζηκφηεηα ηνπ 

PowerFactory, θαζψο θαη πξνηάζεηο γηα ηελ έληαμε ηνπ πξνγξάκκαηνο ζε αθαδεκατθφ 

πιαίζην. 

 

Ζ παξνχζα δηπισκαηηθή εξγαζία εθπνλήζεθε καδί κε ηε δηπισκαηηθή εξγαζία Μειέηε 

Βξαρπθπθισκάησλ ζε ΢πζηήκαηα Ζιεθηξηθήο Δλέξγεηαο Πινίσλ κε Υξήζε ηνπ 

PowerFactory, ζε ζπλεξγαζία κε ηνλ ζπλάδειθν Γεψξγην Παληαδφπνπιν. Πξφθεηηαη γηα δχν 

εξγαζίεο πνπ απνηεινχλ πξντφλ κίαο εληαίαο πξνζπάζεηαο. ΢ην ζεκείν απηφ, ζα ήζεια λα 

επραξηζηήζσ γηα ηε ζπκπαξάζηαζε θαη ηελ αλεθηίκεηε βνήζεηά ηνπο φινπο φζνη κε 

ζηήξημαλ θαηά ηε δηάξθεηα εθπφλεζεο ηεο εξγαζίαο. Ηδηαίηεξα: 

 

Σνλ θ. Ησάλλε Μ. Πξνπζαιίδε, Αλαπιεξσηή Καζεγεηή ηεο ΢ρνιήο Ναππεγψλ 

Μεραλνιφγσλ Μεραληθψλ ηνπ Δζληθνχ Μεηζφβηνπ Πνιπηερλείνπ, γηα ηελ ακέξηζηε βνήζεηα 

θαη ζπκπαξάζηαζή ηνπ θαη ην άξηζην θιίκα ζπλεξγαζίαο πνπ θαιιηέξγεζε. 

 

Σνπο θ. Γεκνζζέλε ΢παζή θαη Θνδσξή Κνπξκπέιε, ππνςήθηνπο δηδάθηνξεο ζηνλ Σνκέα 

Ναπηηθήο Μεραλνινγίαο ηεο ΢ρνιήο Ναππεγψλ Μεραλνιφγσλ Μεραληθψλ ηνπ Δζληθνχ 

Μεηζφβηνπ Πνιπηερλείνπ, γηα ηε δηαξθή βνήζεηα πνπ πξφζπκα παξείραλ ζε εκέλα θαη ηνλ 

ζπλάδειθν Γεψξγην Παληαδφπνπιν θαηά ηελ εθπφλεζε ησλ δχν εξγαζηψλ. 

 

Σέινο, ζα ήζεια λα αθηεξψζσ ηελ παξνχζα δηπισκαηηθή εξγαζία ζηελ νηθνγέλεηα κνπ. 
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ΚΕΥΑΛΑΙΟ 2 
 

Γενικϋσ οδηγύεσ για το PowerFactory 
 

Σν ζπγθεθξηκέλν θεθάιαην πξαγκαηεχεηαη ηα βαζηθά ραξαθηεξηζηηθά, ηε δνκή, ηα 

ζρεδηαζηηθά θαη ππνινγηζηηθά εξγαιεία θαη ηηο παξακέηξνπο ηνπ ινγηζκηθνχ DIgSILENT 

PowerFactory. ΢θνπφο είλαη ε γλσξηκία ηνπ αλαγλψζηε κε ηηο βαζηθέο πηπρέο ηνπ 

πξνγξάκκαηνο, πξνθεηκέλνπ λα θαηαζηεί εθηθηή ε αθαδεκατθή ρξήζε ηνπ γηα εθαξκνγέο 

ζηνλ ηνκέα ηεο λαπηηθήο κεραλνινγίαο. ΢ηε βάζε απηή, ην θείκελν είλαη φζν ην δπλαηφ πην 

αλαιπηηθφ θαη έρεη ηε κνξθή θξνληηζηεξηαθψλ νδεγηψλ (tutorial instructions), κέζσ ησλ 

νπνίσλ ν αλαγλψζηεο έρεη ηε δπλαηφηεηα λα απνθηήζεη κία πξψηε εμνηθείσζε κε ην 

πξφγξακκα. 

 

 

2.1. Δημιουργύα ενόσ νϋου ςχεδύου και αποθόκευςη 
 

Σν πξψην βήκα γηα ην ζρεδηαζκφ ελφο ζπζηήκαηνο ειεθηξηθήο ελέξγεηαο είλαη ε δεκηνπξγία 

ελφο ζρεδίνπ (project). Σν project πξνζθέξεη ηε βαζηθή δνκή εληφο ηεο νπνίαο θαζνξίδνληαη 

θαη απνζεθεχνληαη νη πξνζδηνξηζκνί ηνπ ζπζηήκαηνο ειεθηξηθήο ελέξγεηαο, καδί κε ηηο 

επηκέξνπο παξακέηξνπο ηνπο, ηα κνλνγξακκηθά δηαγξάκκαηα, ηνπο δηάθνξνπο ηχπνπο 

βηβιηνζεθψλ, ηα βήκαηα θαη ηηο εληνιέο ππνινγηζκνχ. ΢ηελ ελφηεηα απηή δίλνληαη νη 

βαζηθέο νδεγίεο γηα ηε δεκηνπξγία ελφο λένπ project κε ζπγθεθξηκέλα ραξαθηεξηζηηθά, 

δηαδηθαζία ε νπνία είλαη απαξαίηεηε θαηά ηελ έλαξμε νπνηαζδήπνηε δξαζηεξηφηεηαο ζην 

PowerFactory. 

 

 

2.1.1. Εκκύνηςη του PowerFactory και δημιουργύα νϋου project 
 

Σν πξφγξακκα δηαζέηεη κία βάζε δεδνκέλσλ (Database), ε νπνία πεξηιακβάλεη ην θάθειν 

ηνπ ρξήζηε (User folder) κε αληίζηνηρε νλνκαζία. ΢ηελ εηθφλα 2.1 θαίλεηαη ε ζπγθεθξηκέλε 

ηεξαξρηθή δηάξζξσζε ηνπ πξνγξάκκαηνο. Ο δηαρεηξηζηήο δεδνκέλσλ (Data Manager) ζα 

αλαιπζεί ζηελ ελφηεηα 2.3 ηνπ θεθαιαίνπ. 
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Εικόνα 2.1: Παξάδεηγκα ελεξγνύ θαθέινπ ρξήζηε 

 

Γηα ηε δεκηνπξγία ελφο λένπ project ζην θάθειφ ζαο, αθνινπζήζηε ηα εμήο βήκαηα: 

 Αλνίμηε ην File menu ζηελ κπάξα ηνπ θχξηνπ κελνχ. 

 Δπηιέμηε New. 

 Δπηιέμηε Project…, φπσο θαίλεηαη ζηελ εηθφλα 2.2. 

 

 
Εικόνα 2.2: Γεκηνπξγία ελόο λένπ Project από ην File menu 

 

 Θα αλνίμεη ην παξάζπξν δηαιφγνπ ηεο Δηθφλαο 2.3, ην νπνίν δίλεηαη ζπκπιεξσκέλν 

γηα ηνπο ζθνπνχο ηνπ θεηκέλνπ. 

 

 
Εικόνα 2.3: Σν παξάζπξν ηνπ λένπ project 
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 Ολνκάζηε ην project “Project 1”. 

 Κάληε θιηθ ζηελ επηινγή OK. 

 

Ζ δεκηνπξγία ελφο λένπ project απελεξγνπνηεί νπνηνδήπνηε πηζαλφ ελεξγφ project θαη θιείλεη 

φια ηα ζρεηηθά παξάζπξα. Έλα project ρξεηάδεηαη ηνπιάρηζηνλ έλα πιέγκα (θάθεινο grid), 

φπνπ εληάζζεηαη ην ζχζηεκα ειεθηξηθήο ελέξγεηαο. Γηα ην ιφγν απηφ, δεκηνπξγείηαη 

απηφκαηα έλαο θάθεινο grid θαη αλνίγεη ην παξάζπξφ ηνπ, φπσο θαίλεηαη ζηελ Δηθφλα 2.4. 

 

 
Εικόνα 2.4: Σν παξάζπξν επεμεξγαζίαο ηνπ grid 

 

 Οξίζηε ην φλνκα ηνπ grid σο “Part 1”. 

 Δπηιέμηε (ελδεηθηηθά) ην κπιε ρξψκα. 

 Οξίζηε ηε ζπρλφηεηα ζηα 50 Hz. 

 Γψζηε φλνκα Owner “NTUA”, θάηη πνπ είλαη πξναηξεηηθφ. 

 Παηήζηε OK. 

 

Παξαηεξήζηε φηη δεκηνπξγήζεθε ην λέν grid “Part 1”, ζε ζπλδπαζκφ κε έλα θάθειν 

νλφκαηνο “Study Case”, ν νπνίνο ρξεζηκνπνηείηαη γηα ηελ ελεξγνπνίεζε ηνπ grid θαη ηελ 

εθηέιεζε ησλ ζρεηηθψλ ππνινγηζκψλ. Σν φλνκα ηεο “Study Case” ζα αιιαρζεί ζηε ζπλέρεηα. 

Δπίζεο, δεκηνπξγήζεθε έλα λέν θελφ παξάζπξν γηα ηε δεκηνπξγία ηνπ κνλνγξακκηθνχ 

δηαγξάκκαηνο. Ο ρψξνο εξγαζίαο ηνπ PowerFactory ζα πξέπεη λα έρεη ηε κνξθή πνπ δίλεηαη 

ζηελ αθφινπζε εηθφλα, ζηελ νπνία έρνπκε ηα εμήο ζηνηρεία αξηζκεκέλα: 

1. Σελ κπάξα ηνπ θχξηνπ κελνχ (main menu bar). 

2. Σελ κπάξα ησλ θχξησλ εηθνληδίσλ (main icon bar) γηα ηελ εθηέιεζε ζπγθεθξηκέλσλ 

πξάμεσλ (ππνινγηζκψλ θ.ιπ.). 

3. Σελ κπάξα ηνπ παξαζχξνπ ησλ γξαθηθψλ (graphics window icon bar). 

4. Σν θελφ παξάζπξν γξαθηθψλ (παξάζπξν κνλνγξακκηθνχ δηαγξάκκαηνο – single line 

graphics window), ην νπνίν πεξηιακβάλεη θαηάιιειν πιέγκα γηα ην ζρεδηαζκφ. Οη 

ηειείεο ηνπ πιέγκαηνο δείρλνπλ ηα ζεκεία φπνπ «θιεηδψλνπλ» ηα δηάθνξα ζηνηρεία, 

εθφζνλ είλαη ελεξγνπνηεκέλε ε ζρεηηθή επηινγή. 

5. Σελ εξγαιεηνζήθε γηα ην ζρεδηαζκφ ησλ ζηνηρείσλ ηνπ ζπζηήκαηνο (drawing 

toolbox), ζηα δεμηά ηνπ παξαζχξνπ κνλνγξακκηθνχ δηαγξάκκαηνο. 



19 
 

6. Σν παξάζπξν εμφδνπ (output window), θάησ απφ ην παξάζπξν κνλνγξακκηθνχ 

δηαγξάκκαηνο, ζην νπνίν δίλνληαη κελχκαηα θεηκέλνπ, αλαθνξέο γηα ηνπο δηάθνξνπο 

ππνινγηζκνχο θαη ελεξγνί ζχλδεζκνη γηα ηε δηφξζσζε ιαζψλ ζην ζχζηεκα. 

7. Σελ κπάξα θαηάζηαζεο (status bar), θάησ απφ ην παξάζπξν εμφδνπ, ε νπνία δίλεη 

πιεξνθνξίεο γηα ηελ θαηάζηαζε ηνπ PowerFactory, φπσο είλαη ε ζέζε ηνπ δείθηε ηνπ 

πνληηθηνχ ζην παξάζπξν κνλνγξακκηθνχ δηαγξάκκαηνο ή ζην παξάζπξν εμφδνπ, 

θαζψο θαη ην φλνκα ηνπ ελεξγνχ project. 

 

 
Εικόνα 2.5: Ο ρώξνο εξγαζίαο ύζηεξα από ηε δεκηνπξγία ελόο λένπ project 

 

 

2.1.2. Επεξεργαςύα τησ study case 
 

Παξφηη ην project, πνπ δεκηνπξγήζακε πξνεγνπκέλσο, κπνξεί λα ρξεζηκνπνηεζεί σο έρεη, ζα 

αιιάμνπκε ην φλνκα ηεο study case ζε θάηη πην αληηπξνζσπεπηηθφ: 

 Δπηιέμηε Edit → Project Data → Study Case… ζην θχξην κελνχ. 

 

Αλνίγεη, έηζη, ην παξάζπξν δηαιφγνπ ηεο study case, φπσο απηφ απεηθνλίδεηαη παξαθάησ. 
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Εικόνα 2.6: Σν παξάζπξν δηαιόγνπ ηεο study case 

 

 Μεηνλνκάζηε ηε study case ζε “Case 1”. 

 Πξνθεηκέλνπ λα ξπζκίζεηε ηελ ψξα (Study Time), θάληε θιηθ ζην θνπκπί κε ηηο ηξεηο 

ηειείεο (…). Έλα παξάζπξν κε ηίηιν “Set Study Time” εκθαλίδεηαη, ζχκθσλα κε ηελ 

Δηθφλα 2.7. 

 

 
Εικόνα 2.7: Ρύζκηζε ώξαο θαη εκεξνκελίαο ηεο study case 

 

 Παηήζηε ην θνπκπί “-> Date" θαη ην θνπκπί “-> Time" γηα λα ρξεζηκνπνηήζεηε ηελ 

εκεξνκελία θαη ηελ ψξα ηνπ ππνινγηζηή ζαο γηα ηε study case. 

 Δπηβεβαηψζηε ηηο αιιαγέο κε ην θνπκπί OK. Σν παξάζπξν δηαιφγνπ ηεο study case 

ζα πξέπεη λα είλαη φπσο δείρλεη ε Δηθφλα 2.8. 

 Παξαηεξήζηε φηη κπνξείηε λα ξπζκίζεηε ηηο κνλάδεο ησλ κεηαβιεηψλ εμφδνπ (Output 

Variables). 
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 Παηήζηε OK γηα λα απνζεθεχζεηε ηηο αιιαγέο γηα ηε study case. 

 

 
Εικόνα 2.8: Σν παξάζπξν δηαιόγνπ ηεο study case ύζηεξα από ηηο αιιαγέο ηωλ ξπζκίζεωλ 

 

Σν φλνκα ηεο study case ζηε ιίζηα ζηα αξηζηεξά ζα πξέπεη λα έρεη αιιάμεη ζε “Case 1”. ΢ηε 

ιίζηα δίλεηαη ε ελεξγή study case. Απφ εθεί κπνξεί λα επηιεγεί θάπνηα άιιε study case. 

 

 

2.1.3. Σα tutorials του PowerFactory 
 

΢ην ζεκείν απηφ, λα ζεκεησζεί φηη ην PowerFactory πεξηιακβάλεη κία ζεηξά απφ αζθήζεηο 

γλσξηκίαο θαη εμνηθείσζεο κε ην πξφγξακκα, νη νπνίεο ζπλνδεχνληαη απφ θαηάιιειν νδεγφ 

[1] θαη κπνξνχλ λα πξνζπειαζηνχλ σο εμήο: 

 Αλνίμηε ην κελνχ Help ζηελ κπάξα ηνπ θχξηνπ κελνχ 

 Δπηιέμηε ην Start Tutorial… 

 

Αλνίγεη έλα παξάζπξν πνπ νλνκάδεηαη Tutorial Manager θαη δίλεη ηε δπλαηφηεηα επηινγήο 

κεηαμχ ησλ επηά αζθήζεσλ, φπσο ζηελ Δηθφλα 2.9: 

 Δπηιέμηε ηελ άζθεζε πνπ επηζπκείηε κέζσ ηνπ Start → Exercise. 

 Παηήζηε Execute. 

 



22 
 

 
Εικόνα 2.9: Σν παξάζπξν ηνπ Tutorial Manager 

 

 

2.1.4. Σερματιςμόσ και επανεκκύνηςη του PowerFactory 
 

Οη ρξήζηεο ζα πξέπεη λα πξνζέμνπλ φηη ην PowerFactory δε δηαζέηεη επηινγή απνζήθεπζεο 

(Save) γηα ηα projects. Όιεο νη αιιαγέο, νη νπνίεο πξαγκαηνπνηνχληαη ζηε βάζε δεδνκέλσλ 

ηνπ ζπζηήκαηνο, απνζεθεχνληαη άκεζα θαη απηφκαηα ζηε βάζε δεδνκέλσλ ηνπ θαθέινπ ηνπ 

πξνγξάκκαηνο, ζην δίζθν ηνπ ππνινγηζηή. Απηφ ζεκαίλεη φηη κπνξείηε λα ηεξκαηίζεηε ηε 

ιεηηνπξγία ηνπ πξνγξάκκαηνο αλά πάζα ζηηγκή, ρσξίο λα ρξεηάδεηαη λα απνζεθεχζεηε ηελ 

πξφνδφ ζαο ζε νπνηνδήπνηε project πξψηα. Μφιηο εθθηλήζεηε ην ινγηζκηθφ, δε ζα 

ελεξγνπνηεζεί ην ηειεπηαίν ελεξγφ project. Ωζηφζν, ηα ηειεπηαία ελεξγά projects κπνξνχλ 

λα θνξησζνχλ κέζσ ηνπ File ζηελ κπάξα ηνπ θχξηνπ κελνχ, απιά επηιέγνληαο ην επηζπκεηφ 

project. Πεξηζζφηεξεο ιεπηνκέξεηεο γηα ηελ απνζήθεπζε ησλ projects δίλνληαη ζηελ ελφηεηα 

2.3 ηνπ θεθαιαίνπ, φπνπ αλαιχεηαη ε ιεηηνπξγία ηνπ Data Manager. 

 

 

2.2. Δημιουργύα βαςικών ςτοιχεύων ςυςτημϊτων 
ηλεκτρικόσ ενϋργειασ 

 
Σν PowerFactory επηηξέπεη ηε δεκηνπξγία λέσλ ζπζηεκάησλ ειεθηξηθήο ελέξγεηαο κέζσ ηεο 

ρεηξνθίλεηεο επηινγήο θαη ζχλδεζεο ησλ επηκέξνπο ειεθηξνινγηθψλ ζηνηρείσλ. Ο πην 

βνιηθφο ηξφπνο γηα θάηη ηέηνην είλαη ε αιιειεπίδξαζε κε ην παξάζπξν ηνπ κνλνγξακκηθνχ 

δηαγξάκκαηνο, ζην νπνίν ηνπνζεηνχληαη ζηνηρεία πνπ επηιέγνληαη απφ ηελ εξγαιεηνζήθε ζηα 

δεμηά. Σν πξφγξακκα είλαη θαηάιιεια ζρεδηαζκέλν, ψζηε λα δίλεη ηε δπλαηφηεηα πιήξνπο 

αιιειεπίδξαζεο ηνπ ρξήζηε κε ηα δηάθνξα ζηνηρεία ελφο ζπζηήκαηνο, πξνθεηκέλνπ λα 

ξπζκηζηνχλ νη εθάζηνηε παξάκεηξνη κέζα απφ αληίζηνηρα παξάζπξα δηαιφγνπ. ΢ηε ζπλέρεηα, 

παξνπζηάδνληαη ηα βαζηθφηεξα ζηνηρεία γηα ηε δεκηνπξγία ζπζηεκάησλ ειεθηξηθήο 

ελέξγεηαο, κε ζηφρν ηελ εμνηθείσζε ηνπ ρξήζηε κε απηά. Γηα ην ζθνπφ απηφ, γίλεηαη ρξήζε 

ηνπ project ηεο πξνεγνχκελεο ελφηεηαο, εληφο ηνπ νπνίνπ ζα δεκηνπξγεζεί έλα απιφ 

ζχζηεκα ειεθηξηθήο ελέξγεηαο, ψζηε λα παξνπζηαζηνχλ νη δπλαηφηεηεο ηνπ πξνγξάκκαηνο 

αλαθνξηθά κε ηε ξνή θνξηίνπ θαη ην βξαρπθχθισκα. 
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2.2.1. Ειςαγωγό των ςτοιχεύων του ςυςτόματοσ 
 

2.2.1.1. Δημιουργύα υποςταθμών με ζυγούσ 
 

Αξρηθά, ηνπνζεηνχληαη νη δπγνί ηνπ ζπζηήκαηνο. Σν PowerFactory δηαζέηεη δηαθνξεηηθέο 

δηαηάμεηο δπγψλ, φπσο είλαη ν απιφο δπγφο (single busbar system), ν απιφο δπγφο κε 

δηαθφπηε (single busbar system with tie breaker), ν δηπιφο δπγφο (double busbar system), ν 

δηπιφο δπγφο κε δηαθφπηε (double busbar system with tie breaker) θαη άιιεο δηαηάμεηο. 

Δπίζεο, ην πξφγξακκα δίλεη ηε δπλαηφηεηα επηινγήο κεηαμχ ιεπηνκεξψλ δπγψλ, φπσο νη 

πξνεγνχκελνη, φπνπ ν ρξήζηεο ζπλδέεη ην εθάζηνηε ζηνηρείν ζε ζπγθεθξηκέλν αθξνδέθηε 

ηνπ δπγνχ, θαζψο θαη δπγψλ ρσξίο ηε δπλαηφηεηα απηή (busbar), φπνπ ην εθάζηνηε ζηνηρείν 

ζπλδέεηαη απηφκαηα. 

 

΢ην ζπγθεθξηκέλν παξάδεηγκα ρξεζηκνπνηείηαη ε θαηεγνξία ηνπ απινχ δπγνχ (single busbar 

system): 

 Αλ ε εξγαιεηνζήθε ζρεδηαζκνχ δελ είλαη νξαηή ζηε δεμηά πιεπξά ηνπ πξνγξάκκαηνο, 

παηήζηε ην εηθνλίδην  ζηελ κπάξα ηνπ παξαζχξνπ ησλ γξαθηθψλ, ψζηε λα 

ελεξγνπνηεζεί ε ιίζηα κε ηα εξγαιεία. 

 

Σν εηθνλίδην  (Freeze Mode) αιιάδεη ηε κέζνδν επεμεξγαζίαο ηνπ ζπζηήκαηνο. Όηαλ 

είλαη ελεξγνπνηεκέλν, ε εξγαιεηνζήθε θαη ην κνλνγξακκηθφ δηάγξακκα «παγψλνπλ», κε 

απνηέιεζκα λα κελ κπνξνχλ λα πξαγκαηνπνηεζνχλ αιιαγέο. Ωζηφζν, κπνξνχλ λα γίλνπλ 

αιιαγέο ζηα ήδε ππάξρνληα ζηνηρεία ηνπ ζπζηήκαηνο (αιιαγέο παξακέηξσλ), ρσξίο βέβαηα 

λα κπνξνχλ λα κεηαθηλεζνχλ, λα κεηαβιεζνχλ νη ζπλδέζεηο ή λα δεκηνπξγεζνχλ λέα 

ζηνηρεία. Μφιηο απελεξγνπνηεζεί ε επηινγή, ελεξγνπνηείηαη μαλά ε εξγαιεηνζήθε. 

 

 Δληνπίζηε θαη επηιέμηε ην εηθνλίδην Single Busbar System ( ), πξνζέρνληαο φηη ην 

εηθνλίδην είλαη παλνκνηφηππν κε απηά ησλ Busbar θαη Busbar (Short). 

 Σνπνζεηήζηε ην δπγφ ζην παξάζπξν ηνπ κνλνγξακκηθνχ δηαγξάκκαηνο. Θα 

εκθαληζηεί έλαο δπγφο κε πξνεπηιεγκέλν φλνκα “SingleBusbar/BB", φπνπ 

“SingleBusbar” είλαη ην είδνο ηνπ δπγνχ θαη BB ε νλνκαζία ηνπ. 

 Αλ επηιέμεηε θάπνην άιιν ιάζνο, κπνξείηε λα αλαηξέζεηε ηελ επηινγή ζαο παηψληαο 

ην θνπκπί . Αθφκα, θαηά ηε δηαδηθαζία εηζαγσγήο ελφο ζπγθεθξηκέλνπ ζηνηρείνπ 

ζην κνλνγξακκηθφ δηάγξακκα (ελφο απινχ δπγνχ ζηελ πξνθεηκέλε πεξίπησζε), ην 

ζχκβνιν ηνπ ζηνηρείνπ αθνινπζεί ην βέινο ηνπ πνληηθηνχ, ελψ, παηψληαο είηε ην 

πιήθηξν Esc είηε δεμί θιηθ, κπνξείηε λα επαλέιζεηε ζηελ αξρηθή θαηάζηαζε. 

 

Ο δπγφο κπνξεί λα κεηαθηλεζεί θαη λα ιάβεη δηαθνξεηηθφ κέγεζνο, αλάινγα κε ηηο αλάγθεο 

ηνπ ζπζηήκαηνο: 

 Δπηιέμηε ην δπγφ, ν νπνίνο ιακβάλεη έλα θφθθηλν ρξψκα κε δχν κηθξά ηεηξάγσλα ζηα 

άθξα ηνπ. 

 Μεηαθηλήζηε ην ζηνηρείν, θξαηψληαο παηεκέλν ην αξηζηεξφ πιήθηξν ηνπ πνληηθηνχ 

επάλσ ζηελ θχξηα γξακκή ηνπ ζηνηρείνπ θαη ζχξνληάο ην ζηελ επηζπκεηή ζέζε. 

Αθήζηε ην πιήθηξν ηνπ πνληηθηνχ γηα λα νξίζεηε ηε λέα ζέζε. 

 Αιιάμηε ην κέγεζνο ηνπ ζηνηρείνπ, θάλνληαο θιηθ ζε θάπνην απφ ηα δχν άθξα 

ζρήκαηνο ηεηξαγψλνπ θαη ζχξνληαο πξνο ηα αξηζηεξά ή ηα δεμηά, ζχκθσλα κε ηελ 

παξαθάησ απεηθφληζε. 
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΢εκεηψλεηαη φηη ν δείθηεο ηνπ πνληηθηνχ κπνξεί λα εκθαλίζεη έλα βνεζεηηθφ πιαίζην, 

εθφζνλ ηνπνζεηεζεί επάλσ ζην φλνκα ηνπ δπγνχ ή νπνηνπδήπνηε άιινπ ζηνηρείνπ ηνπ 

κνλνγξακκηθνχ δηαγξάκκαηνο, ψζηε λα είλαη επθνιφηεξε ε αλάγλσζε ηνπ θεηκέλνπ ρσξίο λα 

ρξεηάδεηαη zoom. 

 

 
Εικόνα 2.10: Αιιαγή κεγέζνπο ηνπ δπγνύ 

 

΢ηε ζπλέρεηα, δεκηνπξγήζηε άιινπο δχν απινχο δπγνχο, αθνινπζψληαο ηελ ίδηα δηαδηθαζία: 

 Δπηιέμηε ην ζηνηρείν  απφ ηελ εξγαιεηνζήθε θαη ηνπνζεηήζηε έλα δεχηεξν θαη 

έλα ηξίην δπγφ, κε ζεηξά ν έλαο θάησ απφ ηνλ άιιν θαη ηθαλά δηαζηήκαηα ζην 

ελδηάκεζν. 

 Μεηαθηλήζηε θαη αιιάμηε ηα κεγέζε ησλ δπγψλ θαηάιιεια, ψζηε ε ηειηθή δηάηαμε 

λα είλαη παξφκνηα κε ηελ αθφινπζε. 

 

 
Εικόνα 2.11: Σνπνζέηεζε ηξηώλ δπγώλ 

 

Οη επηινγέο κεγέζπλζεο θαη επαλαθνξάο ζην αξρηθφ κέγεζνο (Zoom In θαη Zoom Back) 

κπνξνχλ λα αμηνπνηεζνχλ γηα δηεπθφιπλζε θαηά ηελ ηνπνζέηεζε ησλ δπγψλ: 

 Δπηιέμηε ην Zoom In ( ). 

 ΢ρεδηάζηε έλα ηεηξάγσλν γχξσ απφ ηνπο ηξεηο δπγνχο, παηψληαο ην αξηζηεξφ 

πιήθηξν ηνπ πνληηθηνχ θαη ζχξνληαο ην πνληίθη κέρξη ηελ απέλαληη γσλία κε ην 

πιήθηξν παηεκέλν. Ζ επηιεγκέλε πεξηνρή ζα κεγεζπλζεί κφιηο αθήζηε ην πιήθηξν. 

 

Ζ κεγεζπκέλε πεξηνρή κπνξεί λα κεηαθηλεζεί κε ρξήζε ηνπ Hand Tool: 

 Παηήζηε ην εηθνλίδην  ψζηε ν δείθηεο ηνπ πνληηθηνχ λα ιάβεη ηε κνξθή ελφο 

ρεξηνχ. 

 Παηήζηε θιηθ εληφο ηνπ παξαζχξνπ γξαθηθψλ θαη θξαηήζηε ην πιήθηξν παηεκέλν. 
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 Μεηαθηλήζηε ην πνληίθη ζηελ επηζπκεηή θαηεχζπλζε γηα λα κεηαθηλήζεηε ηελ εηθφλα. 

 Αθήζηε ην πιήθηξν ηνπ πιήθηξν ηνπ πνληηθηνχ. 

 Παηήζηε μαλά ην εηθνλίδην Hand Tool ή ην πιήθηξν Esc γηα λα επηζηξέςεηε ζηελ 

αξρηθή θαηάζηαζε. 

 

Παξαηεξήζηε φηη ην Hand Tool είλαη δηαζέζηκν κφλν εθφζνλ έρεηε κεγεζχλεη θάπνηα 

πεξηνρή. Μπνξείηε λα επαλαθέξεηε ην παξάζπξν γξαθηθψλ ζηελ αξρηθή θαηάζηαζε, 

επηιέγνληαο Zoom Back ( ). Δπίζεο, παηψληαο ην εηθνλίδην Zoom All ( ), εκθαλίδεηαη 

νιφθιεξε ε πεξηνρή ηνπ δηαγξάκκαηνο. 

 

2.2.1.2. Δημιουργύα ςτοιχεύων διακλϊδωςησ 
 

Αθνινχζσο, νη ηξεηο δπγνί ζπλδένληαη κέζσ δχν κεηαζρεκαηηζηψλ: 

 Δπηιέμηε ην κεηαζρεκαηηζηή 2-Winding Transformer ( ) απφ ηελ εξγαιεηνζήθε. 

 Πξνθεηκέλνπ λα ζρεδηάζεηε ηνλ πξψην κεηαζρεκαηηζηή, θάληε θιηθ ζηνλ πξψην 

δπγφ. 

 Παξαηεξήζηε φηη αλνίγεη απηφκαηα ην ιεπηνκεξέο γξάθεκα κε ηηο ππνδνρέο ηνπ 

δπγνχ. ΢πλδέζηε ην κεηαζρεκαηηζηή θάλνληαο θιηθ ζε έλα δηαθφπηε, φπσο θαίλεηαη 

ζηελ Δηθφλα 2.12. Σν απνηέιεζκα κεηά ηε ζχλδεζε ζα πξέπεη λα είλαη φπσο ζηελ 

Δηθφλα 2.13. 

 Ο κεηαζρεκαηηζηήο είλαη ηψξα ζπλδεκέλνο ζηνλ πξψην δπγφ ζηελ ππνδνρή πνπ 

επηιέμαηε. 

 Δπηιέμηε ην κεζαίν δπγφ γηα λα δεκηνπξγήζεηε θαη ηε δεχηεξε ζχλδεζε ηνπ 

κεηαζρεκαηηζηή. 

 Αλνίγεη ην ιεπηνκεξέο γξάθεκα ηνπ δεχηεξνπ δπγνχ. ΢πλδέζηε, φπσο θαη πξηλ, ην 

κεηαζρεκαηηζηή ζε νπνηνδήπνηε δηαθφπηε. 

 

 
Εικόνα 2.12: ΢ύλδεζε ηνπ κεηαζρεκαηηζηή κε ηνλ απιό δπγό (ιεπηνκεξέο γξάθεκα) 
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Εικόνα 2.13: Μεηαζρεκαηηζηήο ζπλδεκέλνο ζηνλ απιό δπγό 

 

Πξέπεη λα ζεκεησζεί ε δηαθνξά κεηαμχ ησλ απιψλ ηεξκαηηθψλ ρσξίο επηινγέο ζχλδεζεο, 

φπσο είλαη νη δπγνί ηχπνπ Busbar, θαη ησλ πην ζχλζεησλ ηεξκαηηθψλ κε ππνζηαζκφ 

(substation), φπσο είλαη νη δπγνί ηχπνπ Single Busbar System πνπ ρξεζηκνπνηήζεθαλ. ΢ηε 

δεχηεξε πεξίπησζε, νπνηαδήπνηε ζχλδεζε αλνίγεη απηφκαηα ην ιεπηνκεξέο γξάθεκα ηνπ 

ππνζηαζκνχ θαη ν ρξήζηεο θαιείηαη λα πξαγκαηνπνηήζεη ηε ζχλδεζε κε ζπγθεθξηκέλν 

αθξνδέθηε ζρήκαηνο ηεηξαγψλνπ. Παηψληαο δεμί θιηθ ζην ζηνηρείν (π.ρ. ζην δπγφ), ζην 

παξάζπξν ηνπ κνλνγξακκηθνχ δηαγξάκκαηνο, θαη επηιέγνληαο Show Detailed Graphic of 

Substation, αλνίγεη ην ιεπηνκεξέο γξάθεκα γηα πεξαηηέξσ επεμεξγαζία. Αληίζεηα, ζηελ πην 

απιή πεξίπησζε, ε ζχλδεζε πξαγκαηνπνηείηαη απηφκαηα. 

 

 Υξεζηκνπνηήζηε ηελ παξαπάλσ κέζνδν, πξνθεηκέλνπ λα ζπλδέζεηε έλα δεχηεξν 

κεηαζρεκαηηζηή κεηαμχ ηνπ δεχηεξνπ θαη ηνπ ηξίηνπ δπγνχ. 

 

Σν κνλνγξακκηθφ δηάγξακκα ζα πξέπεη λα ιάβεη ηε κνξθή ηεο Δηθφλαο 2.14. 

 

 
Εικόνα 2.14: ΢ύζηεκα ηξηώλ δπγώλ κε δύν κεηαζρεκαηηζηέο 
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Ο κεηαζρεκαηηζηήο κπνξεί λα κεηαθηλεζεί κε ηξφπν παξφκνην κε απηφλ πνπ παξνπζηάζηεθε 

γηα ηνπο δπγνχο: 

 Δπηιέμηε ην κεηαζρεκαηηζηή. 

 Μεηαθηλήζηε ην ζηνηρείν, θξαηψληαο παηεκέλν ην αξηζηεξφ πιήθηξν ηνπ πνληηθηνχ 

θαη ζχξνληάο ην ζηελ επηζπκεηή ζέζε. Αθήζηε ην πιήθηξν ηνπ πνληηθηνχ γηα λα 

νξίζεηε ηε λέα ζέζε. 

 

Σέινο, εθηφο απφ επζεία γξακκή ζχλδεζεο, ππάξρεη ε δπλαηφηεηα δεκηνπξγίαο άιιεο 

κνξθήο ζχλδεζεο ηνπ κεηαζρεκαηηζηή: 

 Δπηιέμηε ηνλ πξψην δπγφ γηα ηε δεκηνπξγία ηεο πξψηεο ζχλδεζεο. 

 Παηψληαο κία θνξά ην αξηζηεξφ πιήθηξν ηνπ πνληηθηνχ ζηελ επηθάλεηα ζρεδίαζεο, 

θαζνξίδεηε ηηο γσλίεο ηεο γξακκήο ζχλδεζεο. 

 Παηψληαο δχν θνξέο ην αξηζηεξφ πιήθηξν ηνπ πνληηθηνχ, ηνπνζεηείηε ην ζχκβνιν 

ηνπ κεηαζρεκαηηζηή. 

 ΢πλερίδεηε ηελ πνξεία ηεο γξακκήο κεηά ην ζχκβνιν ηνπ κεηαζρεκαηηζηή, παηψληαο 

θαη πάιη κία θνξά ην αξηζηεξφ πιήθηξν ηνπ πνληηθηνχ. 

 Δπηιέμηε ην δεχηεξν δπγφ γηα λα νινθιεξψζεηε ηε ζχλδεζε. 

 

2.2.1.3. Δημιουργύα ςτοιχεύων μονόσ ςύνδεςησ 
 

Σα ζηνηρεία κνλήο ζχλδεζεο (single-port elements) ζπληζηνχλ ζηνηρεία πνπ ζπλδένληαη ζε 

έλα ηεξκαηηθφ κφλν. Υαξαθηεξηζηηθά παξαδείγκαηα είλαη νη γελλήηξηεο, νη θηλεηήξεο, ηα 

θνξηία θαη ηα εμσηεξηθά δίθηπα. ΢ην ζεκείν απηφ, πεξηγξάθεηαη ε δηαδηθαζία εηζαγσγήο ζην 

ζχζηεκα δχν θηλεηήξσλ θαη κίαο γελλήηξηαο. 

 

Γηα ηελ εηζαγσγή δχν αζχγρξνλσλ θηλεηήξσλ ζην ζχζηεκα: 

 Δπηιέμηε ην εηθνλίδην Asynchronous Machine ( ). 

 ΢πλδέζηε ηνλ πξψην θηλεηήξα ζηνλ θαηψηεξν δπγφ. 

 Αλνίγεη απηφκαηα ην ιεπηνκεξέο γξάθεκα ηνπ δπγνχ. Πξαγκαηνπνηήζηε ηε ζχλδεζε 

ζε κία θελή ππνδνρή. 

 ΢πλδέζηε έλα δεχηεξν θηλεηήξα ζην κεζαίν δπγφ. 

 

Δθηφο απφ επζείεο γξακκέο ζχλδεζεο, κπνξνχλ λα ζρεδηαζηνχλ ζπλδέζεηο δηαθνξεηηθήο 

κνξθήο σο εμήο: 

 Παηήζηε αξηζηεξφ θιηθ ζηελ επηθάλεηα ζρεδίαζεο γηα λα ηνπνζεηήζεηε ην ζχκβνιν 

ηνπ θηλεηήξα. 

 Γεκηνπξγήζηε ηελ επηζπκεηή θαηεχζπλζε ηεο γξακκήο, ρξεζηκνπνηψληαο ην 

αξηζηεξφ θιηθ. 

 Οινθιεξψζηε ηε ζχλδεζε κε ην ηεξκαηηθφ. 

 

Δπηπιένλ, πξέπεη λα ζπλδεζεί κία γελλήηξηα, ε νπνία ζα παξέρεη ηελ απαξαίηεηε ειεθηξηθή 

ηζρχ ζην ζχζηεκα: 

 Δπηιέμηε ην εηθνλίδην Synchronous Machine ( ). 

 ΢πλδέζηε ηε γελλήηξηα ζηνλ πξψην δπγφ. 

 ΢ην ιεπηνκεξέο γξάθεκα, πξαγκαηνπνηήζηε ηε ζχλδεζε ζε έλα θελφ ηεξκαηηθφ. 

 

Αλ ε γελλήηξηα ζπλδεζεί, ζην κνλνγξακκηθφ δηάγξακκα, ζηελ ίδηα ζέζε κε ην 

κεηαζρεκαηηζηή, ηφηε ην ζχκβνιφ ηεο ηνπνζεηείηαη απηφκαηα πάλσ απφ ην δπγφ. 



28 
 

Γηαθνξεηηθά, ηνπνζεηείηαη θάησ απφ ην δπγφ ζην πιάη ηνπ κεηαζρεκαηηζηή. ΢ηε δεχηεξε 

πεξίπησζε, ε γελλήηξηα κπνξεί λα αληηζηξαθεί γχξσ απφ ην δπγφ, ψζηε λα ηνπνζεηεζεί ζηελ 

επάλσ πιεπξά: 

 Παηήζηε δεμί θιηθ ζηε γελλήηξηα, φπσο θαίλεηαη ζηελ Δηθφλα 2.15. 

 Κάληε θιηθ ζηελ επηινγή Flip At Busbar. Σν ζχκβνιν πεξηζηξέθεηαη θαηά 180 κνίξεο 

γχξσ απφ ην δπγφ. 

 

Με ηελ ηνπνζέηεζε ηεο γελλήηξηαο, νινθιεξψλεηαη ε δηαδηθαζία δεκηνπξγίαο ησλ ζηνηρείσλ 

ηνπ ζπζηήκαηνο ειεθηξηθήο ελέξγεηαο θαη ηεο ζρεηηθήο ηνπνινγίαο. Σν ζχζηεκα ζα πξέπεη 

λα έρεη ηε κνξθή ηεο Δηθφλαο 2.16. Σν κνλνγξακκηθφ δηάγξακκα κπνξεί λα δηνξζσζεί, αλ 

ρξεηάδεηαη, κέζσ ησλ εληνιψλ κεηαθίλεζεο, αιιαγήο κεγέζνπο θαη πεξηζηξνθήο γχξσ απφ ηε 

ζχλδεζε. 

 

 

 
Εικόνα 2.15: Πεξηζηξνθή ηεο γελλήηξηαο γύξω από ην δπγό 
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Εικόνα 2.16: Σειηθή κνξθή ηνπ ζπζηήκαηνο ειεθηξηθήο ελέξγεηαο 

 

 

2.2.2. Επεξεργαςύα των ςτοιχεύων του ςυςτόματοσ 
 

To PowerFactory πξνζθέξεη δηάθνξεο κεζφδνπο γηα ηελ επεμεξγαζία ησλ παξακέηξσλ ησλ 

ζηνηρείσλ ελφο ζπζηήκαηνο ειεθηξηθήο ελέξγεηαο, απφ απιά παξάζπξα δηαιφγνπ κέρξη 

εχρξεζηα πεξηβάιινληα, ηα νπνία κνηάδνπλ κε ππνινγηζηηθά θχιια, γηα ηελ ηαπηφρξνλε 

επεμεξγαζία πεξηζζφηεξσλ ηνπ ελφο ζηνηρείσλ. Ζ πην εχθνιε θαη άκεζε κέζνδνο, βέβαηα, 

είλαη κέζσ δηπινχ θιηθ ζην επηζπκεηφ ζηνηρείν ηνπ κνλνγξακκηθνχ δηαγξάκκαηνο, 

πξνθεηκέλνπ λα εκθαληζηεί ην αληίζηνηρν παξάζπξν. 

 

Σα πεξηζζφηεξα ζηνηρεία ελφο ζπζηήκαηνο θαζνξίδνληαη κέζσ ζπγθεθξηκέλνπ ηχπνπ (Type). 

Γηα παξάδεηγκα, έλα ζχλνιν κεηαζρεκαηηζηψλ ζε έλα δίθηπν κπνξεί λα ραξαθηεξίδεηαη απφ 

έλα ζπγθεθξηκέλν ηχπν, κε απνηέιεζκα φινη νη κεηαζρεκαηηζηέο λα κνηξάδνληαη θνηλέο 

ειεθηξηθέο παξακέηξνπο. Οη παξάκεηξνη απηνί κπνξνχλ λα πξνζδηνξηζηνχλ κέζσ ηεο 

επηινγήο Type ζην παξάζπξν νπνηνπδήπνηε κεηαζρεκαηηζηή ηνπ ζπλφινπ. Κάζε 

κεηαζρεκαηηζηήο αλαθέξεηαη, κε απηφλ ηνλ ηξφπν, ζηελ ίδηα θαηεγνξία. ΢ηελ θαηεχζπλζε 

απηή, ππάξρνπλ έηνηκα ηππνπνηεκέλα ζηνηρεία ζηε βηβιηνζήθε ηνπ πξνγξάκκαηνο, ελψ 

παξάιιεια ν ρξήζηεο κπνξεί λα δεκηνπξγήζεη δηθνχο ηνπ ηπραίνπο ηχπνπο γηα ηα ζηνηρεία 

ελφο ζπζηήκαηνο. 
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2.2.2.1. Επεξεργαςύα των ζυγών 
 

Ζ επεμεξγαζία ηνπ αλψηεξνπ δπγνχ γίλεηαη σο εμήο: 

 

 Δπηιέμηε κε δηπιφ θιηθ ην δπγφ, ψζηε λα αλνίμεη ην παξάζπξν δηαιφγνπ πνπ 

απεηθνλίδεηαη ζηελ Δηθφλα 2.17. 

 

Σν παξάζπξν πεξηιακβάλεη: 

 

 Καξηέιεο γηα ηελ εηζαγσγή ζπγθεθξηκέλσλ ππνινγηζηηθψλ παξακέηξσλ (Basic Data, 

Load Flow, θ.ιπ.). 

 Σν φλνκα ηνπ ηεξκαηηθνχ. 

 Σνλ ηχπν ηνπ (Type), καδί κε έλα θνπκπί γηα ηελ επηινγή ηχπνπ θαη έλα γηα ηελ 

επεμεξγαζία ηνπ. 

 Σε δψλε (Zone) θαη ηελ πεξηνρή (Area) πνπ αλήθεη ην ηεξκαηηθφ, ηα νπνία δε ζα καο 

απαζρνιήζνπλ εδψ. 

 Σνλ ππνζηαζκφ (Substation) ζηνλ νπνίν αλήθεη ην ηεξκαηηθφ, κε ζρεηηθή επηινγή γηα 

άλνηγκα ηνπ παξαζχξνπ ηνπ ππνζηαζκνχ. 

 Σνλ ηχπν ηνπ ζπζηήκαηνο (System Type) κε επηινγέο AC (ελαιιαζζφκελνπ 

ξεχκαηνο), DC (ζπλερνχο ξεχκαηνο) ή AC/BI γηα ζπζηήκαηα AC δχν θάζεσλ (π.ρ. 

ζπζηήκαηα ζηδεξνδξφκσλ). 

 Σελ ηερλνινγία ησλ θάζεσλ (Phase Technology) γηα ηνλ θαζνξηζκφ ηνπ αξηζκνχ ησλ 

θάζεσλ. Γηα παξάδεηγκα, κπνξεί λα επηιεγεί ε ρξήζε νπδέηεξνπ ή φρη. 

 Σελ νλνκαζηηθή ηάζε ηνπ δπγνχ. 

 

 
Εικόνα 2.17: Σν παξάζπξν δηαιόγνπ ηνπ δπγνύ 
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Δπεμεξγαζηείηε ηνλ αλψηεξν δπγφ ζχκθσλα κε ηα αθφινπζα βήκαηα: 

 Ολνκάζηε ην δπγφ “Busbar 1”. 

 Γηα λα δείηε ηνπο δηαζέζηκνπο ηχπνπο, θάληε θιηθ ζηελ επηινγή  θαη επηιέμηε 

Select Global Type. Αλνίγεη ε βηβιηνζήθε ζην δέληξν δεδνκέλσλ (database tree). 

Πινεγεζείηε πξνο ηελ θαηεγνξία Bars ζην θάθειν Types, φπσο δείρλεη ε Δηθφλα 

2.18, ρξεζηκνπνηψληαο ην ζχκβνιν “+” ή ην δηπιφ θιηθ αλ ρξεηάδεηαη. 

 ΢ην ζπγθεθξηκέλν παξάδεηγκα, ζα δεκηνπξγήζνπκε έλα δηαθνξεηηθφ ηχπν δπγνχ. 

 Παηήζηε Cancel γηα λα ελεξγνπνηεζεί μαλά ην παξάζπξν ηνπ δπγνχ. 

 Κάληε θιηθ ζηελ επηινγή  θαη επηιέμηε New Project Type. Αλνίγεη ην παξάζπξν 

δεκηνπξγίαο λένπ ηχπνπ. 

 Ολνκάζηε ηνλ ηχπν “BB 33 kV”. 

 ΢ην ρψξν ηεο νλνκαζηηθήο ηάζεο (Nominal Voltage) εηζάγεηε ηηκή 33 kV (Δηθφλα 

2.19). 

 Παηήζηε OK γηα λα επηζηξέςεηε ζην θεληξηθφ παξάζπξν ηνπ δπγνχ. 

 ΢ην ρψξν ηεο νλνκαζηηθήο ηάζεο (Nominal Voltage), αιιάμηε ηελ πνιηθή ηάζε 

(Line-Line) ζε 33 kV. Παξαηεξήζηε φηη ε θαζηθή ηάζε (Line-Ground) είλαη 19.05256 

kV, αθνχ 05256.193/33  . 

 Παηήζηε ην θνπκπί  ζην ρψξν ηνπ Substation γηα λα επεμεξγαζηείηε ηνλ 

ππνζηαζκφ. 

 Δκθαλίδεηαη ην παξάζπξν δηαιφγνπ ηνπ Substation (Δηθφλα 2.20). Αιιάμηε ην φλνκα 

ζε “Station 1”. 

 Δηζάγεηε “S1” σο ζχληνκν φλνκα (Short Name). 

 Παηήζηε OK γηα λα θιείζεηε ην παξάζπξν ηνπ ππνζηαζκνχ. 

 Δπηβεβαηψζηε κε OK ηηο αιιαγέο ζην δπγφ γηα λα θιείζεηε ην αξρηθφ παξάζπξν. ΢ην 

παξάζπξν πνπ ζα ζαο ξσηήζεη αλ επηζπκείηε λα δηαηεξήζεηε ηηο αιιαγέο ζηελ 

νλνκαζηηθή ηάζε θαη ζηελ ηερλνινγία ησλ θάζεσλ, παηήζηε Yes. 

 

 
Εικόνα 2.18: Δπηινγή ηύπνπ γηα ην δπγό 
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Εικόνα 2.19: Γεκηνπξγία λένπ ηύπνπ δπγνύ 

 

 
Εικόνα 2.20: Ρύζκηζε ηεο νλνκαζηηθήο ηάζεο ηνπ δπγνύ θαη επεμεξγαζία ηεο νλνκαζίαο ηνπ 

ππνζηαζκνύ 

 

Ο κεζαίνο δπγφο πξνζδηνξίδεηαη κε αληίζηνηρα βήκαηα: 

 Αλνίμηε ην παξάζπξν δηαιφγνπ ηνπ δπγνχ. 

 Name=”Busbar 2” 

 Γεκηνπξγήζηε λέν ηχπν κε νλνκαζία “BB 11 kV” θαη νλνκαζηηθή ηάζε 11 kV. 

 Ρπζκίζηε ηελ νλνκαζηηθή ηάζε ζηα 11 kV. 

 Substation: Name=”Station 2”, Short Name=”S2” 

 Κιείζηε ην παξάζπξν ηνπ δπγνχ επηβεβαηψλνληαο ηηο αιιαγέο κε OK. 
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Ο θαηψηεξνο δπγφο έρεη ηα αθφινπζα ραξαθηεξηζηηθά: 

 Name=”Busbar 3” 

 Γεκηνπξγήζηε λέν ηχπν κε νλνκαζία “BB 3.3 kV” θαη νλνκαζηηθή ηάζε 3.3 kV. 

 Ολνκαζηηθή ηάζε ζηα 3.3 kV. 

 Substation: Name=”Station 3”, Short Name=”S3” 

 Δπηβεβαηψζηε κε OK. 

 

2.2.2.2. Περιόγηςη μεταξύ των ςτοιχεύων του δικτύου 
 

Σν PowerFactory πξνζθέξεη ηε δπλαηφηεηα πεξηήγεζεο κεηαμχ ησλ ζηνηρείσλ ηνπ 

ζπζηήκαηνο, κε ηε ζεηξά πνπ απηά εκθαλίδνληαη ζηελ ηνπνινγία ηνπ δηθηχνπ. Σν παξάζπξν 

θάζε ζηνηρείνπ δηαζέηεη ηελ επηινγή Jump to…, κε ηελ νπνία ν ρξήζηεο κπνξεί λα πεξάζεη 

ζην παξάζπξν ηνπ επφκελνπ ζπλδεκέλνπ ζηνηρείνπ, αλ ππάξρεη κφλν έλα, ή λα επηιέμεη έλα 

κεηαμχ άιισλ απφ κία ιίζηα. 

Πξνθεηκέλνπ λα γίλεη ρξήζε ηεο δπλαηφηεηαο απηήο ζην ππφ ζρεδίαζε δίθηπν: 

 Αλνίμηε ην παξάζπξν ηεο γελλήηξηαο κε δηπιφ θιηθ. 

 Παηήζηε Jump to… ψζηε λα εκθαληζηεί ην παξάζπξν ηνπ πξψηνπ δπγνχ ”Busbar 1”. 

 Παηήζηε μαλά Jump to… θαη παξαηεξήζηε ηε ιίζηα κε ηα ζπλδεκέλα ζηνηρεία. 

Δπηιέμηε ην κεηαζρεκαηηζηή. Αλνίγεη ηψξα ην αληίζηνηρν παξάζπξν. 

 ΢ε θάζε πεξίπησζε, παηψληαο ην θνπκπί Cancel επηζηξέθεηε ζην κνλνγξακκηθφ 

δηάγξακκα ρσξίο λα πξαγκαηνπνηήζεηε αιιαγέο ζε θάπνην ζηνηρείν. 

 

2.2.2.3. Επεξεργαςύα ςτοιχεύων διπλόσ ςύνδεςησ 
 

Γηα λα επεμεξγαζηείηε ηα ραξαθηεξηζηηθά ησλ κεηαζρεκαηηζηψλ, πνπ είλαη ζηνηρεία δηπιήο 

ζχλδεζεο (two-port elements), μεθηλήζηε απφ ηνλ επάλσ κεηαζρεκαηηζηή σο εμήο: 

 Αλνίμηε ην παξάζπξν δηαιφγνπ κε δηπιφ θιηθ. 

 Ολνκάζηε ην κεηαζρεκαηηζηή “Transformer 1”. 

 Οξίζηε λέν ηχπν κεηαζρεκαηηζηή, επηιέγνληαο Type → New Project Type. Αλνίγεη ην 

παξάζπξν δεκηνπξγίαο λένπ ηχπνπ (Δηθφλα 2.21). 

 Ολνκάζηε ηνλ ηχπν “33/11 kV”. 

 Rated Power=20 MVA 

 Nominal Frequency=60 Hz 

 Rated Voltage: HV-Side=33 kV, LV-Side=11 kV 

 Θεσξήζηε ζπληειεζηή ηάζεο βξαρπθπθιψκαηνο, ν νπνίνο απμάλεηαη φζν απμάλεηαη ε 

ηάζε ιεηηνπξγίαο κίαο πιεπξάο, uk=10%, θαζψο θαη κεδεληθέο απψιεηεο ραιθνχ. 

 Παηήζηε OK. 

 Αλνίμηε ηελ θαξηέια Load Flow ζην παξάζπξν ηνπ κεηαζρεκαηηζηή. 

 Διέγμηε φηη ε επηινγή Automatic Tap Changing είλαη απελεξγνπνηεκέλε θαη φηη ε 

επηινγή Tap Position είλαη ξπζκηζκέλε ζην κεδέλ. 

 Παηήζηε OK. 

 

Θα εκθαληζηεί έλα κήλπκα ζθάικαηνο αλ νη πιεπξέο πςειήο θαη ρακειήο ηάζεο ηνπ 

κεηαζρεκαηηζηή δελ είλαη ζπλδεκέλεο νξζά. ΢ε απηήλ ηελ πεξίπησζε: 

 ΢ην παξάζπξν ηνπ κεηαζρεκαηηζηή θαη ζηελ θαξηέια Basic Data, παηήζηε ην θνπκπί 

Flip Connections. 

 Δπηιέμηε OK. 
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Πξέπεη λα ζεκεησζεί φηη ην παξάζπξν ηνπ κεηαζρεκαηηζηεί δείρλεη ηα ζπλδεκέλα ηεξκαηηθά, 

ηα πεδία ησλ νπνίσλ έρνπλ ζπκπιεξσζεί απηφκαηα θαηά ηε ζχλδεζε ηνπ κεηαζρεκαηηζηή 

αλάκεζα ζηνπο δχν δπγνχο. Σα νλφκαηα ησλ δχν δπγψλ θαίλνληαη κε θφθθηλν ρξψκα. 

 

Δπεμεξγαζηείηε θαη ην δεχηεξν κεηαζρεκαηηζηή: 

 Αλνίμηε ην παξάζπξν δηαιφγνπ ηνπ κεηαζρεκαηηζηή. 

 Name=”Transformer 2” 

 Type → New Project Type: Name=”11/3.3 kV”, Rated Power=5 MVA, Nominal 

Frequency=60 Hz, HV-Side=11 kV, LV-Side=3.3 kV, uk=5%, Copper Losses=0 kW 

 Παηήζηε OK. 

 Αλνίμηε ηελ θαξηέια Load Flow θαη ειέγμηε φηη ε επηινγή Automatic Tap Changing 

είλαη απελεξγνπνηεκέλε θαη φηη ε επηινγή Tap Position είλαη ξπζκηζκέλε ζην κεδέλ. 

 Δπηιέμηε OK. 

 

 
Εικόνα 2.21: Σν παξάζπξν ηνπ κεηαζρεκαηηζηή θαη ην παξάζπξν δεκηνπξγίαο λένπ ηύπνπ 

 

2.2.2.4. Επεξεργαςύα ςτοιχεύων μονόσ ςύνδεςησ 
 

Γηακνξθψζηε θαηάιιεια ηε γελλήηξηα ηνπ δηθηχνπ κέζσ ησλ παξαθάησ βεκάησλ: 

 

 Αλνίμηε ην παξάζπξν δηαιφγνπ ηεο γελλήηξηαο. 

 Γψζηε φλνκα “Generator”. 

 Οξίζηε λέν ηχπν γελλήηξηαο, επηιέγνληαο Type → New Project Type. Αλνίγεη ην 

παξάζπξν δεκηνπξγίαο λένπ ηχπνπ. 

 Name=”G 10 MVA” 

 Ζ νλνκαζηηθή θαηλφκελε ηζρχο (Nominal Apparent Power) αλέξρεηαη ζηα 10 MVA 

θαη ε νλνκαζηηθή ηζρχο (Nominal Voltage) ζηα 33 kV. 

 Ο ζπληειεζηήο ηζρχνο (Power Factor) είλαη 0.8 θαη ε ζχλδεζε YN (αζηέξαο κε 

νπδέηεξν). 

 Παηήζηε OK. 
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 Αλνίμηε ηελ θαξηέια Load Flow ζην παξάζπξν ηεο γελλήηξηαο. 

 Οξίζηε ηε γελλήηξηα σο γελλήηξηα αλαθνξάο, κέζσ ηεο επηινγήο Reference Machine. 

 ΢ηελ θαηεγνξία Mode of Local Voltage Controller επηιέμηε Voltage. 

 ΢ην ρψξν επηινγψλ Dispatch, νξίζηε ηα ραξαθηεξηζηηθά ηεο γελλήηξηαο κε Input 

Mode S, cos(phi) (κε βάζε ηε θαηλφκελε ηζρχ θαη ην ζπληειεζηή ηζρχνο), φπσο 

δείρλεη ε Δηθφλα 2.22: Apparent Power=10 MVA, Power Factor=0.8, Voltage=1 p.u., 

Angle=0 deg. 

 Δπηβεβαηψζηε ηηο αιιαγέο παηψληαο OK. 

 

 
Εικόνα 2.22: Ρύζκηζε παξακέηξωλ γελλήηξηαο 

 

΢ηε ζπλέρεηα, επεμεξγαζηείηε ηνλ θηλεηήξα πνπ είλαη ζπλδεκέλνο ζην δπγφ ησλ 11 kV: 

 Αλνίμηε ην παξάζπξν ηνπ θηλεηήξα. 

 Name=”Motor 1” 

 Πξνζδηνξίζηε ηνλ ηχπν ηνπ θηλεηήξα κέζσ Type → New Project Type. Αλνίγεη ην 

παξάζπξν δεκηνπξγίαο λένπ ηχπνπ. 

 Name=”M 5 MVA” 

 Rated Voltage=11 kV 

 Input Mode=Electrical Parameter 

 ΢ηελ επηινγή Power Rating νξίζηε ηε θαηλφκελε ηζρχ ίζε κε: Rated Apparent 

Power=5000 kVA. 

 Nominal Frequency=60 Hz 

 Ζ ζχλδεζε είλαη D (ηξίγσλν). 

 Παηήζηε OK. 

 Αλνίμηε ηελ θαξηέια Load Flow ζην παξάζπξν ηνπ θηλεηήξα. 



36 
 

 Οξίζηε ηελ ελεξγή ηζρχ (Active Power) ζηα 4 MW. 

 Δπηιέμηε OK. 

 

Με ηελ ίδηα κέζνδν, πξνζδηνξίζηε ηα ραξαθηεξηζηηθά ηνπ δεχηεξνπ θηλεηήξα: 

 Αλνίμηε ην παξάζπξν ηνπ θηλεηήξα. 

 Name=”Motor 2” 

 Type → New Project Type: Name=”M 2 MVA”, Rated Voltage=3.3 kV, Rated 

Apparent Power=2000 kVA, Nominal Frequency=60 Hz 

 Παηήζηε OK. 

 Load Flow: Active Power=1 MW 

 

΢ην ηέινο φισλ ησλ πξνεγνχκελσλ επεμεξγαζηψλ, ην ζχζηεκα ζα πξέπεη λα έρεη ηε κνξθή 

πνπ δίλεηαη ζηελ Δηθφλα 2.23. 

 

 
Εικόνα 2.23: Σν ππό ζρεδίαζε δίθηπν ύζηεξα από ηελ επεμεξγαζία ηωλ ζηνηρείωλ ηνπ 
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2.2.3. Τπολογιςμόσ ροόσ φορτύου (load flow calculation) 
 

Μεηά ηελ νινθιήξσζε ηεο επεμεξγαζίαο ησλ ζηνηρείσλ ηνπ δηθηχνπ, κπνξεί λα 

πξαγκαηνπνηεζεί έλαο ππνινγηζκφο ξνήο θνξηίνπ, κέζσ ηνπ νπνίνπ ζα ειεγρζνχλ ε 

νξζφηεηα ηεο πξνεγνχκελεο ζρεδίαζεο θαη ηα κεγέζε πνπ πξνθχπηνπλ θαηά ηε ιεηηνπξγία. 

Γηα ηελ εκθάληζε ηνπ ζρεηηθνχ παξαζχξνπ, αθνινπζήζηε ηε δηαδξνκή Calculation → Load 

Flow → Load Flow… απφ ην θχξην κελνχ. Θα αλνίμεη, έηζη, ην παξάζπξν δηαιφγνπ γηα ηνλ 

ππνινγηζκφ, φπσο δείρλεη ε Δηθφλα 2.24. Δλαιιαθηηθά, ην παξάζπξν ηνπ ππνινγηζκνχ ηεο 

ξνήο θνξηίνπ κπνξεί λα αλνίμεη κέζσ ηνπ ζρεηηθνχ εηθνληδίνπ ζηελ κπάξα ησλ θχξησλ 

εηθνληδίσλ, κε νλνκαζία Calculate Load Flow ( ). 

 

Ο ππνινγηζκφο ηεο ξνήο θνξηίνπ ελφο ζπζηήκαηνο δηαζέηεη κία ζεηξά παξακέηξσλ γηα ηνλ 

θαζνξηζκφ ηνπ. Γηα ην ζθνπφ ηεο ξνήο θνξηίνπ ηνπ ζπγθεθξηκέλνπ παξαδείγκαηνο, 

αθνινπζήζηε ηα εμήο βήκαηα: 

 Οξίζηε σο κέζνδν ππνινγηζκνχ (Calculation Method) ηελ AC Load Flow, balanced, 

positive sequence. 

 Δπηιέμηε σο Temperature Dependency: Line/Cable Resistances ηνπο 20 
o
C (…at 20 

o
C). 

 Απελεξγνπνηήζηε φιεο ηηο ππφινηπεο επηινγέο ζηελ θαξηέια Basic Options. 

 ΢ηελ θαξηέια Active Power Control, ρξεζηκνπνηήζηε ηελ επηινγή as Dispatched σο 

Active Power Control θαη ζηγνπξεπηείηε φηη είλαη ελεξγνπνηεκέλε ε επηινγή Consider 

Active Power Limits. 

 

Παξαηεξήζηε φηη ην παξάζπξν ηεο ξνήο θνξηίνπ δηαζέηεη επηινγέο ζρεηηθέο κε ηε κέζνδν 

ππνινγηζκνχ θαη ηηο επαλαιήςεηο, ζηηο θαξηέιεο Advanced Options θαη Iteration Control 

αληίζηνηρα. 

 

 Παηήζηε ην θνπκπί Execute γηα λα μεθηλήζεη ν ππνινγηζκφο ηεο ξνήο θνξηίνπ. 
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Εικόνα 2.24: Σν παξάζπξν ηνπ ππνινγηζκνύ ηεο ξνήο θνξηίνπ 

 

Αλ ν ζρεδηαζκφο ηνπ δηθηχνπ είλαη νξζφο, ζα πξέπεη λα εκθαληζηεί ην κήλπκα ηεο Δηθφλαο 

2.25 ζην παξάζπξν εμφδνπ (output window), ην νπνίν δειψλεη ηελ επηηπρή εθηέιεζε ηνπ 

ππνινγηζκνχ. Σν κήλπκα αλαθέξεη φηη ε γελλήηξηα απνηειεί ην ζηνηρείν αλαθνξάο γηα ηα 

κεγέζε, θαζψο νξίζηεθε σο ηέηνην θαη είλαη ην κφλν ζηνηρείν ηνπ παξαδείγκαηνο πνπ κπνξεί 

λα απνηειέζεη ζηνηρείν αλαθνξάο. Δπίζεο, αλαθέξεηαη ν αξηζκφο ησλ επαλαιήςεσλ πνπ 

ρξεηάζηεθαλ γηα ηε ζχγθιηζε ηνπ αιγνξίζκνπ Newton-Raphson. 

 

 
Εικόνα 2.25: Σν κήλπκα ηνπ παξαζύξνπ εμόδνπ γηα ηνλ ππνινγηζκό ηεο ξνήο θνξηίνπ 

 

Σν παξάζπξν ρξεζηκεχεη γηα ηνλ εληνπηζκφ θαη ηε δηφξζσζε ζθαικάησλ ζην δίθηπν, ψζηε 

λα κπνξνχλ λα εθηειεζηνχλ νη δηάθνξνη ππνινγηζκνί. Γηα παξάδεηγκα, αλ δελ έρεη νξηζηεί ν 

ηχπνο ηνπ κεηαζρεκαηηζηή, ζα εκθαληζηεί θαηάιιειν κήλπκα κε ζχλδεζκν πνπ νδεγεί ζην 

πξνβιεκαηηθφ ζηνηρείν (ζην κεηαζρεκαηηζηή ζηελ πξνθεηκέλε πεξίπησζε). Μέζσ δηπινχ 

θιηθ ζηε γξακκή κε ην φλνκα ηνπ ζηνηρείνπ, ν ρξήζηεο κεηαθέξεηαη απηφκαηα ζην παξάζπξν 

ηνπ ζηνηρείνπ απηνχ. Μέζσ ηεο ζπγθεθξηκέλεο δηαδηθαζίαο αιιειεπίδξαζεο, πνπ πξνζθέξεη 
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ην παξάζπξν εμφδνπ ηνπ PowerFactory, ν ρξήζηεο έρεη ηε δπλαηφηεηα εχθνιεο δηφξζσζεο 

πηζαλψλ ζθαικάησλ θαηά ην ζρεδηαζκφ ηνπ ζπζηήκαηνο. 

 

Σα απνηειέζκαηα ηεο ξνήο θνξηίνπ ζην δίθηπν δίλνληαη ζε πιαίζηα απνηειεζκάησλ γηα θάζε 

ζηνηρείν, φπσο δείρλεη ε Δηθφλα 2.26. Απεηθνλίδνληαη ε ελεξγφο ηζρχο P, ε άεξγνο ηζρχο Q 

θαη ην αλαπηπζζφκελν ξεχκα I. Αλ ηνπνζεηεζεί ν δείθηεο ηνπ πνληηθηνχ επάλσ ζε θάπνην 

πιαίζην, εκθαλίδεηαη έλα βνεζεηηθφ πιαίζην κε ηηο ίδηεο ηηκέο κεγεζπκέλεο, γεγνλφο πνπ 

θαζηζηά επθνιφηεξε ηελ αλάγλσζε ησλ ηηκψλ. Σν ραξαθηεξηζηηθφ απηφ ηνπ πξνγξάκκαηνο 

είλαη ηδηαίηεξα ρξήζηκν φηαλ απεηθνλίδεηαη έλα κεγάιν κέξνο ηνπ δηθηχνπ ή νιφθιεξν ην 

δίθηπν ζην παξάζπξν γξαθηθψλ, θαζψο ηα ζηνηρεία θαη ηα πιαίζηα απνηειεζκάησλ κπνξεί λα 

είλαη κηθξά θαη δπζαλάγλσζηα.  

 

 
Εικόνα 2.26: Απνηειέζκαηα ηνπ ππνινγηζκνύ ηεο ξνήο θνξηίνπ ζε ηκήκα ηνπ δηθηύνπ 

 

Δπηπιένλ, ν ππνινγηζκφο ηεο ξνήο θνξηίνπ παξέρεη πιεξνθνξίεο ζρεηηθά κε ηε θφξηηζε ησλ 

ζηνηρείσλ ηνπ δηθηχνπ θαη ηα απνδεθηά φξηα. Σα πνζνζηά θφξηηζεο δίλνληαη αλ ν δείθηεο 

ηνπ πνληηθηνχ ηνπνζεηεζεί επάλσ ζην φλνκα ηνπ επηζπκεηνχ ζηνηρείνπ. ΢ην ππφ κειέηε 

παξάδεηγκα, ε γελλήηξηα παξνπζηάδεη θφξηηζε 55.0%, ν πξψηνο κεηαζρεκαηηζηήο 27.5%, ν 

πξψηνο θηλεηήξαο 86.0%, ν δεχηεξνο κεηαζρεκαηηζηήο 23.1% θαη ν δεχηεξνο θηλεηήξαο 

56.8%. Αθφκα, κεηά ηνλ ππνινγηζκφ ρξσκαηίδνληαη θαηάιιεια ηα ζηνηρεία ηνπ δηθηχνπ, 

ψζηε λα θαίλεηαη ην επίπεδν θφξηηζεο (π.ρ. θφθθηλν γηα ππεξθφξηηζε ελφο ζηνηρείνπ). Ζ 

επηινγή Diagram Colouring ( ) ζηελ κπάξα ηνπ παξαζχξνπ ησλ γξαθηθψλ δίλεη ην 

ππφκλεκα ησλ ρξσκάησλ. 

 

Πην ζπγθεθξηκέλα: 

 Αλνίμηε ην παξάζπξν κέζσ ηεο επηινγήο Diagram Colouring. 

 ΢ηελ θαξηέια Load Flow, επηιέμηε Colour Settings. Αλνίγεη ην ζρεηηθφ παξάζπξν ηεο 

Δηθφλαο 2.27. 
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΢ην παξάζπξν απηφ κπνξείηε λα εμεηάζεηε ηελ αληηζηνηρία ρξσκάησλ θαη επηπέδσλ ηάζεσλ-

θνξηίζεσλ, θαζψο θαη λα πξαγκαηνπνηήζεηε αιιαγέο ζηα ρξεζηκνπνηνχκελα ρξψκαηα. 

 

 
Εικόνα 2.27: Σν παξάζπξν αληηζηνηρίαο ρξωκάηωλ θαη επηπέδωλ θόξηηζεο ηωλ ζηνηρείωλ ηνπ δηθηύνπ 

 

Αθφκα, κέζσ ηεο επηινγήο Colour Legend Block ( ) ζηελ κπάξα ηνπ παξαζχξνπ ησλ 

γξαθηθψλ, ελεξγνπνηείηαη ή απελεξγνπνηείηαη ην ππφκλεκα γηα ηα ρξεζηκνπνηνχκελα 

ρξψκαηα, ην νπνίν θαίλεηαη ζηελ Δηθφλα 2.28. 

 

 
Εικόνα 2.28: Σν ππόκλεκα γηα ηελ αληηζηνηρία ρξωκάηωλ θαη ηάζεωλ-θνξηίζεωλ 

 

Σέινο, ζηελ Δηθφλα 2.29 δίλεηαη ε γεληθή εηθφλα ηνπ δηθηχνπ, χζηεξα απφ ηελ εθηέιεζε ηνπ 

ππνινγηζκνχ ηεο ξνήο θνξηίνπ. 

 



41 
 

 
Εικόνα 2.29: Σν ππό κειέηε δίθηπν κεηά ηνλ ππνινγηζκό ηεο ξνήο θνξηίνπ 

 

 

2.2.4. Επεξεργαςύα των αποτελεςμϊτων του υπολογιςμού 
 

Σα κεγέζε πνπ δίλνληαη ζηα πιαίζηα απνηειεζκάησλ δελ είλαη ζηαζεξά, θαζψο κπνξνχλ λα 

επηιεγνχλ άιια. Σν PowerFactory πξνζθέξεη εχρξεζηα εξγαιεία γηα ηνλ πξνζδηνξηζκφ ησλ 

εκθαληδφκελσλ απνηειεζκάησλ, θαζψο θαη γηα ηελ ηξνπνπνίεζε ησλ πιαηζίσλ 

απνηειεζκάησλ. Δμάιινπ, ηα πιαίζηα απνηειεζκάησλ είλαη, νπζηαζηηθά, κηθξέο 

ππνινγηζηηθέο αλαθνξέο, ηηο νπνίεο ν ρξήζηεο κπνξεί λα δηακνξθψζεη θαηάιιεια. 

 

Όπσο αλαθέξζεθε ήδε, ηα πιαίζηα απνηειεζκάησλ, κεηά ηνλ ππνινγηζκφ ηεο ξνήο θνξηίνπ, 

αλαθέξνπλ ηηο ηηκέο γηα ηα κεγέζε P, Q θαη I. Μπνξεί, φκσο, λα είλαη απαξαίηεην λα 

πξνζηεζεί ε ηηκή ηεο θφξηηζεο. Ζ αιιαγή απηή ζα πξαγκαηνπνηεζεί, ελδεηθηηθά, ζην πιαίζην 

απνηειεζκάησλ ηνπ επάλσ κεηαζρεκαηηζηή: 

 Παηήζηε ηελ επηινγή Freeze Mode ( ) γηα λα απελεξγνπνηεζεί ε δπλαηφηεηα 

αιιαγψλ ζην κνλνγξακκηθφ δηάγξακκα. 

 Παηήζηε δεμί θιηθ ζε έλα απφ ηα δχν πιαίζηα απνηειεζκάησλ ηνπ κεηαζρεκαηηζηή. 

Αλνίγεη έλα κηθξφ κελνχ. 
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Τπάξρνπλ δχν επηινγέο, νη Format for Edge Elements θαη Format for 2-Winding 

Transformer, νη νπνίεο αλνίγνπλ έλα δεχηεξν κελνχ. Απφ εθεί κπνξεί λα επηιεγεί 

δηαθνξεηηθή κνξθή γηα ην πιαίζην απνηειεζκάησλ. Έλα ζχκβνιν ηηθ δείρλεη πνηα κνξθή 

ρξεζηκνπνηείηαη θάζε θνξά. ΢ηελ παξνχζα θάζε, ρξεζηκνπνηείηαη ε κνξθή Format for Edge 

Elements → Branch Flow. 

 

Δπίζεο, ε επηινγή Edit Format for Edge Elements αθνξά ηηο δπλαηφηεηεο κεηαβνιήο ηεο 

ρξεζηκνπνηνχκελεο κνξθήο απνηειεζκάησλ: 

 Κάληε θιηθ ζηελ επηινγή Edit Format for Edge Elements ψζηε λα αλνίμεη ην ζρεηηθφ 

παξάζπξν. 

 Παηήζηε ην θνπκπί Input Mode θαη επηιέμηε User Selection. 

 Δπηβεβαηψζηε κε OK. 

 

Σν αξρηθφ παξάζπξν πεξηιακβάλεη ηηο ηξεηο επηιεγκέλεο κεηαβιεηέο γηα ηα απνηειέζκαηα. 

Πξνθεηκέλνπ λα απνθηήζεηε πξφζβαζε ζην πιαίζην κε φιεο ηηο κεηαβιεηέο, αθνινπζήζηε ηα 

εμήο βήκαηα: 

 Παηήζηε δηπιφ θιηθ π.ρ. ζηελ ηξίηε γξακκή, ε νπνία αθνξά ην ξεχκα (ζηε ιίζηα 

δίλεηαη κε ηελ νλνκαζία “m:I:_LOCALBUS”). ΢ην παξάζπξν πνπ εκθαλίδεηαη, ε 

κεηαβιεηή απηή είλαη ελεξγνπνηεκέλε θαη φιεο νη άιιεο απελεξγνπνηεκέλεο. 

 Δλεξγνπνηήζηε ηε κεηαβιεηή cosphi:_LOCALBUS ψζηε λα πξνζζέζεηε ην 

ζπληειεζηή ηζρχνο ζηηο εκθαληδφκελεο κεηαβιεηέο, φπσο δείρλεη ε Δηθφλα 2.30. 

 Όιεο νη κεηαβιεηέο κε ηηθ πξνζηίζεληαη ζηε ιίζηα απνηειεζκάησλ. 

 Παηήζηε ην θνπκπί OK θαη ζηα δχν παξάζπξα. 

 Παξαηεξήζηε ηελ αιιαγή ζην πιαίζην απνηειεζκάησλ ηνπ κεηαζρεκαηηζηή ην νπνίν 

πεξηιακβάλεη, πιένλ, θαη ην ζπληειεζηή ηζρχνο. Ζ ίδηα αιιαγή αθνξά θαη βνεζεηηθφ 

πιαίζην απνηειεζκάησλ, πνπ εκθαλίδεηαη αλ ηνπνζεηεζεί ν δείθηεο ηνπ πνληηθηνχ 

επάλσ ζην αξρηθφ πιαίζην. 

 Παξαηεξήζηε φηη φια ηα πιαίζηα απνηειεζκάησλ έρνπλ αιιάμεη. 

 Δπηιέμηε ην Edit Format for Edge Elements μαλά. Γνθηκάζηε λα ξπζκίζεηε ηα 

εκθαληδφκελα δεθαδηθά ςεθία ησλ κεηαβιεηψλ ζε 3 ή 4, θαζψο θαη λα ειέγμεηε ηε 

ρξεζηκφηεηα ησλ ππφινηπσλ ξπζκίζεσλ. 

 

Αλ ην πιαίζην απνηειεζκάησλ, ζην κνλνγξακκηθφ δηάγξακκα, είλαη ππεξβνιηθά κηθξφ γηα λα 

ζπκπεξηιάβεη φιεο ηηο επηιεγκέλεο πιεξνθνξίεο: 

 Παηήζηε ην Freeze Mode ψζηε λα ελεξγνπνηεζεί ε δπλαηφηεηα αιιαγψλ. 

 Παηήζηε δεμί θιηθ ζην πιαίζην θαη επηιέμηε Adapt Width. 

 

΢πλήζσο δελ είλαη απαξαίηεηε ε πξνζζήθε κνλάδσλ ή πεξηγξαθψλ ζηα πιαίζηα 

απνηειεζκάησλ, θαζφηη νη πιεξνθνξίεο απηέο δίλνληαη απηφκαηα. Αθφκα, ππάξρεη ην 

ππφκλεκα ηνπ κνλνγξακκηθνχ δηαγξάκκαηνο, ζηελ θάησ αξηζηεξή γσλία ηνπ παξαζχξνπ 

γξαθηθψλ, ην νπνίν αλαλεψλεηαη απηφκαηα ζχκθσλα κε ηηο αιιαγέο ζηηο κεηαβιεηέο. Σν 

ππφκλεκα απηφ εκθαλίδεηαη ή απνθξχπηεηαη κέζσ ηεο επηινγήο Show Legend Block ( ) 

ζηελ κπάξα ηνπ παξαζχξνπ ησλ γξαθηθψλ. 
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Εικόνα 2.30: Δπεμεξγαζία ηωλ πιαηζίωλ απνηειεζκάηωλ κε ηε ρξήζε πξνθαζνξηζκέλωλ κεηαβιεηώλ 

 

 

2.2.5. Τπολογιςμόσ βραχυκυκλώματοσ (short-circuit calculation) 
 

Ο ππνινγηζκφο βξαρπθπθιψκαηνο κπνξεί λα μεθηλήζεη αθνινπζψληαο ηε δηαδξνκή 

Calculation → Short-Circuit → Short-Circuit… απφ ην θχξην κελνχ, παηψληαο ην θνπκπί 

Calculate Short-Circuit ( ) ζηελ κπάξα ησλ θχξησλ εηθνληδίσλ ή θαηεπζείαλ απφ ην 

κνλνγξακκηθφ δηάγξακκα: 

 Παηήζηε ην Freeze Mode. 

 Παηήζηε δεμί θιηθ ζην δπγφ ησλ 11 kV θαη επηιέμηε Calculate → Short-Circuit, φπσο 

δείρλεη ε Δηθφλα 2.31. 
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Εικόνα 2.31: Έλαξμε ηνπ ππνινγηζκνύ βξαρπθπθιώκαηνο από ην κνλνγξακκηθό δηάγξακκα 

 

Με ηνπο παξαπάλσ ηξφπνπο αλνίγεη ην παξάζπξν δηαιφγνπ γηα ην βξαρπθχθισκα: 

 Οξίζηε σο κέζνδν ηελ IEC 61363, ε νπνία αθνξά ζπζηήκαηα ειεθηξηθήο ελέξγεηαο 

ζηε ζάιαζζα. 

 Παξαηεξήζηε φηη γηα ηε ζπγθεθξηκέλε κέζνδν ν ηχπνο ζθάικαηνο είλαη 3-Phase 

Short-Circuit θαη δελ αιιάδεη. 

 ΢ηγνπξεπηείηε φηη είλαη επηιεγκέλε ε Standard IEC 61363 Method ζην ρψξν ηνπ 

Calculate Using. 

 Καζνξίζηε σο ζέζε ηνπ βξαρπθπθιψκαηνο (Fault Location) φινπο ηνπο δπγνχο (All 

Busbars). Τπάξρεη, βέβαηα, θαη ε επηινγή User Selection, φπνπ ν ρξήζηεο θαζνξίδεη 

κία ζπγθεθξηκέλε ζέζε. Αλ ην παξάζπξν ηνπ βξαρπθπθιψκαηνο έρεη αλνίμεη κέζσ 

ελφο δπγνχ ζην κνλνγξακκηθφ δηάγξακκα, ηφηε απηφκαηα ε ζέζε ηνπ ζθάικαηνο είλαη 

απηή ηνπ ζπγθεθξηκέλνπ δπγνχ. Δπίζεο, ππάξρεη θαη ε επηινγή Busbars and Junction 

Nodes, αιιά ζην ππφ κειέηε παξάδεηγκα ρξεζηκνπνηείηαη ε επηινγή γηα φινπο ηνπο 

δπγνχο. 

 ΢ηελ θαξηέια Advanced Options, νξίζηε φηη ζα πξαγκαηνπνηεζεί πξψηα κία ξνή 

θνξηίνπ (use load flow initialization). 

 Σν παξάζπξν δηαιφγνπ ζα πξέπεη λα έρεη ηψξα ηε κνξθή ηεο Δηθφλαο 2.32. 

 Παηήζηε Execute. 
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Εικόνα 2.32: Σν παξάζπξν ηνπ ππνινγηζκνύ ηνπ βξαρπθπθιώκαηνο 

 

Δθηειείηαη ν ππνινγηζκφο βξαρπθπθιψκαηνο κε ην πξφγξακκα λα ζεσξεί φηη ην ζθάικα 

ζπκβαίλεη εθεί πνπ νξίζηεθε. ΢ηελ πξνθεηκέλε πεξίπησζε, έρνπκε βξαρπθπθιψκαηα ζηνπο 

ηξεηο δπγνχο ηνπ δηθηχνπ. Σα απνηειέζκαηα πεξηιακβάλνπλ ηα ξεχκαηα βξαρπθχθισζεο θαη 

ηηο ηζρχεηο ζε φιν ην δίθηπν, εθηφο απφ ηα επίπεδα θφξηηζεο ησλ ζηνηρείσλ, ηα νπνία 

ακεινχληαη. Σα κεγέζε ηνπ ξεχκαηνο θαη ηεο ηζρχνο δίλνληαη γηα ην εθάζηνηε ηεξκαηηθφ 

ζεσξψληαο φηη πξνθχπηνπλ απφ βξαρπθχθισκα ζην ζπγθεθξηκέλν ηεξκαηηθφ. Σν παξάζπξν 

εμφδνπ ζα πξέπεη λα εκθαλίζεη, εθηφο απφ ην κήλπκα γηα ηε ξνή θνξηίνπ, ην κήλπκα ηεο 

Δηθφλαο 2.33. 
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Εικόνα 2.33: Σν κήλπκα ηνπ παξαζύξνπ εμόδνπ γηα ηνλ ππνινγηζκό ηνπ βξαρπθπθιώκαηνο 

 

Γηα ηνλ ππνινγηζκφ ελφο πνιιαπινχ ζθάικαηνο, ην νπνίν ζπκβαίλεη ζε πεξηζζφηεξα ηνπ 

ελφο ζηνηρεία ηαπηφρξνλα, αθνινπζήζηε ηα εμήο βήκαηα: 

 Πξαγκαηνπνηήζηε έλαλ ππνινγηζκφ ξνήο θνξηίνπ κε ηα ραξαθηεξηζηηθά πνπ 

εθηέζεθαλ ζηελ παξάγξαθν 2.2.3 (balanced load flow). 

 Δπηιέμηε ηαπηφρξνλα δχν ηεξκαηηθά (π.ρ. ηνλ πξψην θαη ην δεχηεξν δπγφ) 

ρξεζηκνπνηψληαο ην πιήθηξν CTRL. 

 Παηήζηε δεμί θιηθ ζηελ επηινγή θαη αθνινπζήζηε ηε δηαδξνκή Calculate → Multiple 

Faults. 

 Αλνίγεη έλα παξάζπξν κε κία ιίζηα ησλ ζέζεσλ ησλ ζθαικάησλ. Ζ ιίζηα 

πεξηιακβάλεη ηα επηιεγκέλα ηεξκαηηθά θαη πξφζζεηα ηεξκαηηθά, εθφζνλ έρνπλ 

επηιεγεί ζε πξνεγνχκελε θάζε. Μπνξείηε λα επεμεξγαζηείηε ηε ιίζηα, δηαγξάθνληαο 

θαηαρσξήζεηο ή δεκηνπξγψληαο λέεο κέζσ ηεο επηινγήο New Object ( ). 

 Παηήζηε Close. 

 Αλνίγεη απηφκαηα ην παξάζπξν βξαρπθπθιψκαηνο. Θα πξέπεη λα είλαη επηιεγκέλε ε 

κέζνδνο complete θαη λα είλαη ελεξγνπνηεκέλν ην Multiple Faults. 

 Παηήζηε Execute. 

 

Πξαγκαηνπνηείηαη ν ππνινγηζκφο κε ην πξφγξακκα λα ζεσξεί φηη ζπκβαίλνπλ ηα δχν 

νξηζκέλα βξαρπθπθιψκαηα ηαπηφρξνλα. 
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2.3. Ο Data Manager 
 

΢ηελ παξνχζα ελφηεηα, ζα παξνπζηαζηνχλ νη βαζηθέο ιεηηνπξγίεο θαη δπλαηφηεηεο ηνπ Data 

Manager, ην νπνίν απνηειεί θχξην εξγαιείν ηνπ PowerFactory. Γηα ην ζθνπφ απηφ, 

ρξεζηκνπνηείηαη ην ππφβαζξν ηεο άζθεζεο 3 ησλ tutorials, ην δίθηπν ηεο νπνίαο είλαη 

παλνκνηφηππν κε απηφ πνπ δεκηνπξγήζεθε ζηελ ελφηεηα 2.2. Αθνινπζήζηε ηα εμήο βήκαηα 

γηα ηελ εθθίλεζε ηεο άζθεζεο: 

 Αθνινπζήζηε ηε δηαδξνκή Help → Start Tutorial… απφ ηελ κπάξα ηνπ θχξηνπ 

κελνχ. 

 Δπηιέμηε ην Start θαη θαηφπηλ ηελ άζθεζε πνπ επηζπκείηε, ελ πξνθεηκέλσ επηιέμηε 

Exercise 3. 

 Παηήζηε ην Execute. 

Σν κνλνγξακκηθφ δηάγξακκα ζα πξέπεη λα επαλεκθαληζηεί κε δηαθνξεηηθφ κνηίβν. Ζ βάζε 

δεδνκέλσλ ζηελ νπνία απνζεθεχνληαη φιεο νη αιιαγέο δελ ρξεζηκνπνηήζεθε άκεζα ζηα 

πξνεγνχκελα tutorials. Πξνθεηκέλνπ λα γίλεη ρξήζε ηεο βάζεο απηήο, είλαη απαξαίηεηε ε 

πξφζβαζε ζην πεξηβάιινλ ηνπ Data Manager. Πην ζπγθεθξηκέλα: 

 Παηήζηε ην θνπκπί Open Data Manager ( ) πνπ βξίζθεηαη αξηζηεξά ζηελ κπάξα 

ησλ θχξησλ εηθνληδίσλ. Σν παξάζπξν ηνπ Data Manager ζα εκθαληζηεί ζηελ νζφλε, 

φπσο θαίλεηαη ζηελ Δηθφλα 2.34. 

 

 
Εικόνα 2.34: Σν παξάζπξν δηαιόγνπ ηνπ Data Manager 

 

Ο Data Manager έρεη δχν παξάζπξα: 

 Σν δέληξν ηεο βάζεο δεδνκέλσλ ζηα αξηζηεξά, πνπ αλαπαξηζηά ζε κνξθή δέληξνπ 

νιφθιεξε ηε βάζε. 

 Σν παξάζπξν πεξηήγεζεο ζηα δεμηά πνπ δείρλεη ην πεξηερφκελν ηνπ επηιεγκέλνπ 

θαθέινπ απφ ην δέληξν. 
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2.3.1. Φρηςιμοποιώντασ τον Data Manager 
 

Αλνίγνληαο ηνλ Data Manager, ν ρξήζηεο έρεη ηε δπλαηφηεηα λα δεη ην πεξηερφκελν ηνπ 

θαθέινπ ηνπ (Database/User). Δθηφο απφ ηα πξνεγνχκελα projects, πιένλ ν Tutorial 

Manager έρεη δεκηνπξγήζεη θαη ελεξγνπνηήζεη έλα λέν project κε ηίηιν “Tutorial Exercise 3”. 

Έλα ελεξγφ project ππνδειψλεηαη κε έληνλα (bold) γξάκκαηα κέζα ζηνλ Data Manager. 

Δθφζνλ ν ρξήζηεο επηζπκεί λα κεηαβεί ζε θάπνην άιιν project, ζα πξέπεη λα ην 

ελεξγνπνηήζεη παηψληαο δεμί θιηθ ζηνλ αληίζηνηρν θάθειν θαη επηιέγνληαο ην Activate απφ 

ην κελνχ πνπ ζα αλνίμεη. 

 

Ο Data Manager κπνξεί λα ρξεζηκνπνηεζεί γηα ηελ επεμεξγαζία ησλ ζηνηρείσλ ελφο 

ζπζηήκαηνο πνπ έρεη ήδε κνληεινπνηήζεη ν ρξήζηεο. Γειαδή: 

 Δπηιέμηε απφ ην δέληξν ζην αξηζηεξφ παξάζπξν ηνπ Data Manager ηε δηαδξνκή 

Tutorial exercise 3 → Network Model → Network Data → Part 1. 

 Απφ ην δεμί παξάζπξν ηνπ Data Manager επηιέμηε κε δηπιφ θιηθ ην εηθνλίδην ελφο 

κεηαζρεκαηηζηή . Έηζη, ζα αλνίμεη ην ίδην παξάζπξν επεμεξγαζίαο ηνπ 

κεηαζρεκαηηζηή φπσο απηφ πνπ αλνίγεη θαη απφ ην κνλνγξακκηθφ δηάγξακκα. 

 Κιείζηε ην παξάζπξν παηψληαο ην Cancel. 

 

Γεληθφηεξα ν Data Manager είλαη έλα ηδηαίηεξα ρξήζηκν εξγαιείν γηα ην ρξήζηε θαη κπνξεί 

λα ρξεζηκνπνηεζεί γηα δηάθνξεο εξγαζίεο: 

 Γεκηνπξγία αληηθεηκέλσλ θάζε είδνπο, φπσο projects, calculation cases, ηχπνπο 

ζηνηρείσλ ζηε βηβιηνζήθε, εληνιέο ππνινγηζκψλ θ.ά. 

 Αληηγξαθή θαη επηθφιιεζε κεξψλ απφ έλα θάθειν ζε έλαλ άιιν κέζα ζηε βάζε 

δεδνκέλσλ. 

 Δπηζθφπεζε ησλ απνηειεζκάησλ ζε κνξθή πίλαθα. 

 Δπεμεξγαζία αληηθεηκέλσλ θαη ζηνηρείσλ ζε κνξθή πίλαθα. 

 Δηζαγσγή θαη εμαγσγή (import, export) κεξψλ ηεο βάζεο δεδνκέλσλ. 

 

 

2.3.2. Δημιουργύα μύασ γραμμό διακλϊδωςησ 
 

Σν ζχζηεκα ζα δηεπξπλζεί πξνζζέηνληαο έλα θαιψδην δηαλνκήο κε θνξηία (θαηαλαισηέο) 

ζην κεζαίν δπγφ. Ξεθηλήζηε ζρεδηάδνληαο ηνλ επηπιένλ δπγφ ζηα δεμηά ηνπ δπγνχ ησλ 11 kV: 

 Αλ ε επηινγή γηα ην πάγσκα ηνπ κνλνγξακκηθνχ δηαγξάκκαηνο είλαη 

ελεξγνπνηεκέλε, απελεξγνπνηήζηε ηε. 

 Δπηιέμηε ην εηθνλίδην  απφ ηελ εξγαιεηνζήθε ζρεδίαζεο θαη ηνπνζεηήζηε ην δπγφ 

ζηα δεμηά ηνπ ζηαζκνχ “D1_11a”. 

 Δπεμεξγαζηείηε ην λέν δπγφ παηψληαο δηπιφ θιηθ πάλσ ηνπ απφ ην κνλνγξακκηθφ 

δηάγξακκα, πξνθεηκέλνπ λα αλνίμεη ην αληίζηνηρν παξάζπξν δηαιφγνπ: 

Name=“D2_Swab”, Substation Name=“Station 4”, Short Name=“S4”, Type → Select 

Project Type → Bar 11 kV, Nominal Voltage=11 kV. 

 

΢ηελ πιήξε έθδνζε ηνπ PowerFactory ηα παξαπάλσ βήκαηα κπνξνχλ λα απινπνηεζνχλ. Ο 

λένο ζηαζκφο είλαη παξφκνηνο κε ηνλ ήδε ππάξρνληα D1_11a. Έηζη, ηα ζηνηρεία ηνπ κπνξνχλ 

εχθνια λα αληηγξαθνχλ απφ ηνλ ππάξρνληα ζηαζκφ ζην λέν. 

 

Ζ κέζνδνο απηή, δειαδή ε αληηγξαθή ησλ δεδνκέλσλ απφ έλα ζηνηρείν ηνπ ζπζηήκαηνο ζε 

έλα άιιν, επηηαρχλεη ην ζρεδηαζκφ ηνπ ζπζηήκαηνο θαη κεηψλεη θαη ηπρφλ ιάζε. Γηα 
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παξάδεηγκα, φηαλ ππάξρεη έλα κεγάιν δίθηπν ειεθηξηθήο ελέξγεηαο θαη απνηειείηαη απφ 

ειεθηξηθά φκνηα ζηνηρεία (δπγνχο θ.ιπ.), ν ρξήζηεο κπνξεί λα νξίζεη ηα δεδνκέλα ελφο κφλν 

ζηνηρείνπ θαη, ζηε ζπλέρεηα, αλνίγνληαο ην Data Manager, φπσο πεξηγξάθεθε παξαπάλσ, λα 

ηα αληηγξάςεη ζηα ππφινηπα φκνηα ζηνηρεία ηνπ δηθηχνπ κε κία κφλν ελέξγεηα. 

 

Ζ αληηγξαθή θαη επηθφιιεζε ησλ δεδνκέλσλ είλαη δπλαηή γηα φια ηα αληηθείκελα, 

ζπκπεξηιακβαλνκέλσλ ησλ κεηαζρεκαηηζηψλ, ησλ γξακκψλ, ησλ θνξηίσλ, ησλ γελλεηξηψλ 

θ.ιπ. Δληνχηνηο, ζηε δνθηκαζηηθή έθδνζε ηνπ πξνγξάκκαηνο (demo version) δελ είλαη 

δπλαηή ε παξαπάλσ ιεηηνπξγία. 

 

Γηα ην ζρεδηαζκφ ηνπ θαισδίνπ απφ ην δπγφ D1_11a ζην λέν D2_Swab: 

 Δπηιέμηε ην εηθνλίδην ηεο γξακκήο Line  απφ ηελ εξγαιεηνζήθε. 

 Σνπνζεηήζηε ηε κε βάζε ην κνηίβν πνπ βξίζθεηαη ζην θφλην ηνπ κνλνγξακκηθνχ 

δηαγξάκκαηνο. 

- Δπηιέμηε κε αξηζηεξφ θιηθ ην δπγφ D1_11a. 

- Σν ιεπηνκεξέο γξαθηθφ ζρέδην ηνπ ππνζηαζκνχ αλνίγεη απηφκαηα. ΢πλδέζηε 

ηε γξακκή ζε έλαλ απφ ηνπο ειεχζεξνπο δηαθφπηεο. 

- Με αξηζηεξφ θιηθ ζρεδηάζηε ηηο δχν γσλίεο ηεο γξακκήο, φπσο ππνδεηθλχεη ην 

κνηίβν. 

- Δπηιέμηε κε αξηζηεξφ θιηθ ηνλ άιιν δπγφ (D2_Swab). 

- ΢πλδέεηε ην άιιν άθξν ηεο γξακκήο ζε θάπνην ειεχζεξν δηαθφπηε. 

 Με δηπιφ αξηζηεξφ θιηθ επηιέμηε ηε γξακκή γηα λα ηελ επεμεξγαζηείηε σο εμήο: 

- Name=“L1_Swab”  

- Δπηιέμηε ηνλ ηχπν ηεο γξακκήο παηψληαο ην αληίζηνηρν βέινο  

- Select Project Type → Line Type (TypLne) 

- Types Cables (ππνθάθεινο ηεο βηβιηνζήθεο) 

- Δπηιέμηε Cable 11kV800A. 

- Length of Line=3 km 

- Παηήζηε ΟΚ. 

 Παηήζηε ζηε ζπλέρεηα ζην εηθνλίδην Busbar (Short) απφ ηελ εξγαιεηνζήθε.  

 Σνπνζεηήζηε ην δπγφ ζην ζεκείν πνπ δείρλεη ην κνηίβν, θάησ απφ ηνλ D2_Swab. 

 Δηζάγεηε ηα εμήο ζηνηρεία γηα απηφ ην δπγφ: 

- Name=“D1_Reut” 

- Type → Select Project Type → Bar 11 kV 

- Nominal Voltage=11 kV  

 Δπηιέμηε θαηφπηλ ηε γξακκή (Line) απφ ηελ εξγαιεηνζήθε ζρεδίαζεο. 

 Σνπνζεηήζηε ηε γξακκή κεηαμχ ησλ δπγψλ D2_Swab θαη D1_Reut κε ηνλ ηξφπν πνπ 

ππνδείρζεθε θαη πξνεγνπκέλσο. 

 Παηήζηε δηπιφ θιηθ γηα λα αλνίμεη ην παξάζπξν δηαιφγνπ ηεο γξακκήο  

- Name=“L_Swb_Rt” 

- Type → Select Project Type → Line Type → Types Cables → Cable 11kV400A 

- Length of Line=5 km 

 ΢πλδέζηε ηψξα έλα θνξηίν (General Load) απφ ηελ εξγαιεηνζήθε . 

 

΢ε απηφ ην ζεκείν ινηπφλ ην δίθηπν ζα πξέπεη λα είλαη φπσο απηφ ηεο Δηθφλαο 2.35. 
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Εικόνα 2.35: Ζ κνξθή ηνπ λένπ δηθηύνπ κεηά ηηο πξνζζήθεο 

 

΢ηε ζπλέρεηα, ηνπνζεηνχληαη ηα θνξηία ζηελ θαηλνχξηα γξακκή: 

 Δπηιέμηε ην θνξηίν (Load) απφ ηελ εξγαιεηνζήθε. 

 Κάληε θιηθ πάλσ ζηε γξακκή, ζηε ζέζε πνπ ζπλδέεηαη ην αλψηεξν θνξηίν ζχκθσλα 

κε ην κνηίβν. Σν παξάζπξν δηαιφγνπ (Branch-Off Element) ζα πξέπεη λα εκθαληζηεί. 

Αλ δελ εκθαληζηεί θαη ηνπνζεηεζεί ην θνξηίν απιά ζην δηάγξακκα, ζεκαίλεη φηη δελ 

επηιέρζεθε ε γξακκή ζσζηά. Παηήζηε ην Esc θαη δνθηκάζηε μαλά ηελ παξαπάλσ 

δηαδηθαζία, θάλνληαο zoom in εθφζνλ θξίλεηαη απαξαίηεην.  

 

΢πλδένληαο ην θνξηίν πάλσ ζηε γξακκή, απηφκαηα εηζάγεηαη θαη έλαο κηθξφο δπγφο/ζηαζκφο 

θαη ε γξακκή (θαιψδην) ρσξίδεηαη ζε 2 γξακκέο. Σν ζπλνιηθφ κήθνο ησλ 2 μερσξηζηψλ 

γξακκψλ είλαη ίζν κε ην κήθνο ηεο αξρηθήο γξακκήο (πξηλ ζπλδεζνχλ ηα θνξηία). Ο ρξήζηεο 

έρεη ηε δπλαηφηεηα λα θαζνξίζεη ηε ζέζε πνπ ζα ρσξηζηεί ε γξακκή.  

 

 Οξίδεηε ηε λέα ζέζε ζηα 4 km. Σν παξάζπξν δηαιφγνπ Branch-Off Element δείρλεη ην 

έγθπξν δηάζηεκα (0–5 km εδψ). 

 Ζ επηινγή Switch Options (Insert Switches on Right Side/Left Side) πξέπεη λα είλαη 

απελεξγνπνηεκέλε. 

 Παηήζηε ΟΚ. 
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Οη απνζηάζεηο πνπ ηνπνζεηνχληαη ηα θνξηία ζην γξάθεκα δελ έρνπλ ζρέζε ηηο θπζηθέο ηνπο 

ζέζεηο. Αζθαιψο, ε ζεηξά κε ηελ νπνία ηνπνζεηνχληαη ηαπηίδεηαη κε ηελ πξαγκαηηθή ζεηξά. 

 

 Δηζάγεηε ην ηειεπηαίν θνξηίν (ην πην ρακειφ ζην δηάγξακκα) κε ηνλ ίδην ηξφπν πνπ 

πεξηγξάθεηαη παξαπάλσ. Οξίζηε ηε ζέζε ζηα 0.8 km, (πνπ ζεκαίλεη φηη ηνπνζεηείηαη 

δειαδή ζηα 4.8 km, αθνχ πιένλ ην πξφγξακκα κεηξάεη ηελ απφζηαζε απφ ην λέν 

δπγφ πνπ ζπλδέζεθε λσξίηεξα), επίζεο ρσξίο ηελ επηινγή δηαθνπηψλ. 

 ΢πλδέζηε θαη ην ηξίην θνξηίν αλάκεζα ζηα άιια δχν. 

 Οξίζηε ηελ απφζηαζε ζηα 4.4 km (πιεθηξνινγήζηε δειαδή 0.4 km). 

 Δλεξγνπνηήζηε ηελ επηινγή left switch. 

 Αιιάμηε ηελ θαηεχζπλζε πνπ ζπλδέζεθε ην θνξηίν σο εμήο: 

- Παηήζηε δεμί θιηθ ζε έλα θελφ ζεκείν ηνπ δηαγξάκκαηνο ή παηήζηε Esc γηα λα 

απνδεζκεχζεηε ηελ επηινγή ηνπ θνξηίνπ απφ ην δείθηε ηνπ πνληηθηνχ. 

- Δπηιέμηε κε αξηζηεξφ θιηθ ην θνξηίν πνπ ζπλδέζαηε ηειεπηαίν θαη θξαηήζηε ην 

παηεκέλν. 

- Μεηαθηλήζηε ην θνξηίν ζηελ άιιε πιεπξά ηεο γξακκήο, φπσο ππνδεηθλχεη ην 

κνηίβν. 

- Αθήζηε ην αξηζηεξφ πιήθηξν ηνπ πνληηθηνχ γηα λα νινθιεξψζεηε ηε κεηαθίλεζε 

ζηε λέα ζέζε. 

Σν ηξίην θνξηίν πιένλ έρεη ζηξαθεί θαηά 180
ν
. Δπίζεο, ν ρξεζηήο κπνξεί λα ην πεηχρεη απηφ 

πην εχθνια, θάλνληαο κε δεμί θιηθ ζην θνξηίν (ή νπνηνδήπνηε άιιν ζηνηρείν) θαη 

επηιέγνληαο απφ ην κελνχ πνπ εκθαλίδεηαη Flip at Busbar. 

 

Μεηά απφ απηή ηε δηαδηθαζία, ε γξακκή πνπ είρε νλνκαζηεί ζηελ αξρή L_Swb_Rt, έρεη 

ρσξηζηεί ζε ηέζζεξηο λέεο γξακκέο, νπφηε εκθαλίδνληαη ηα νλφκαηα L_Swb_Rt, 

L_Swb_Rt(1), L_Swb_Rt(2), L_Swb_Rt(3). Σα λέα απηά ζηνηρεία ζα επεμεξγαζηνχλ ζηε 

ζπλέρεηα.  

 

Σν background (κνηίβν) πιένλ δελ είλαη απαξαίηεην: 

 Δπηιέμηε ην εηθνλίδην  ζηελ κπάξα εξγαιείσλ ηνπ κνλνγξακκηθνχ δηαγξάκκαηνο. 

Αλνίγεη έηζη ην παξάζπξν επεμεξγαζίαο Graphic Layers. 

 Σν Background layer βξίζθεηαη ζην πεδίν ησλ νξαηψλ layers (Visible pane). Δπηιέμηε 

ην θαη παηήζηε ην  γηα λα ην κεηαθηλήζεηε ζην αφξαην πεδίν (Invisible 

pane). Με δηπιφ θιηθ ζην Background layer πεηπραίλεηε ην ίδην. 

 Κιείζηε ην παξάζπξν.  

 

Σν κνηίβν πνπ βξηζθφηαλ ζην θφλην πιένλ είλαη δελ είλαη νξαηφ.  

 Παηήζηε ην Freeze Mode. 

 

 

2.3.3. Επεξεργαςύα των καινούριων ςτοιχεύων 
 

Ο ηχπνο θαη ην κήθνο ηεο «δηαθιαδηζκέλεο» γξακκήο (branched-off line)  έρνπλ νξηζηεί 

παξαπάλσ. Έηζη ζα αιιάμνπλ κφλν ηα νλφκαηα ησλ θαηλνχξησλ γξακκψλ πνπ 

δεκηνπξγήζεθαλ: 

 Δπηιέμηε κε δηπιφ θιηθ ηελ αλψηεξε γξακκή: 

- Name=“L_Swb_Tub” 

 Ολνκάζηε ηηο ππφινηπεο γξακκέο απφ επάλσ πξνο ηα θάησ: 
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- Name=“L_Tub_Dus” 

- Name=“L_Dus_Gom” 

- Name=“L_Gom_Reut” 

 

΢ε απηφ ην ζεκείν ζα πξέπεη λα νξηζηνχλ νη παξάκεηξνη ησλ λέσλ ηεξκαηηθψλ πνπ 

δεκηνπξγήζεθαλ πάλσ ζηηο γξακκέο, ιφγσ ησλ θνξηίσλ πνπ ζπλδέζεθαλ. Δπεηδή ηα 

terminals είλαη ίδηα θαη είλαη ρξνλνβφξν λα ηξνπνπνηεζνχλ έλα-έλα μερσξηζηά, ζα γίλεη 

ρξήζε ηνπ Data Manager πνπ παξέρεη, φπσο αλαθέξζεθε θαη ζηελ αξρή ηνπ θεθαιαίνπ, 

multi-edit δπλαηφηεηεο: 

 Αλνίμηε ην παξάζπξν ηνπ Data Manager 

 ΢ην δέληξν ηεο βάζεο δεδνκέλσλ ζηα αξηζηεξά επηιέμηε ην θάθειν “Part 1”, φπσο 

θαίλεηαη ζηελ εηθφλα πνπ αθνινπζεί. 

 

 
Εικόνα 2.36: Σν παξάζπξν ηνπ Data Manager κε ηηο λέεο γξακκέο θαη ηα ηεξκαηηθά 

 

΢ην παξάζπξν ηνπ Data Manager πνπ άλνημε, θαίλνληαη κεηαμχ άιισλ ην φλνκα θαη ν ηχπνο 

ησλ ζηνηρείσλ. Γηα ηα θαηλνχξηα terminals (Terminal, Terminal(1)…) δελ έρεη νξηζηεί αθφκα 

ν ηχπνο. Έηζη: 

 Δπηιέμηε κε δηπιφ θιηθ ην εηθνλίδην ελφο terminal ( ) απφ ηελ πξψηε ζηήιε γηα 

λα αλνίμεη ην αληίζηνηρν παξάζπξν δηαιφγνπ.  

 Οξίζηε ηνλ ηχπν ηνπ σο εμήο: Type → Select Project Type → Bar 11kV. 

 Κιείζηε ην παξάζπξν δηαιφγνπ παηψληαο OK. 

 Με ηνλ ίδην ηξφπν νξίζηε ηνλ ηχπν (ίδηνο) θαη ζηα άιια δχν ηεξκαηηθά. 

 

΢εηξά έρνπλ ηψξα ηα νλφκαηα: 

 Δπηιέμηε κε δηπιφ θιηθ ην εηθνλίδην ηνπ ζηνηρείνπ Σerminal. 

 Αιιάμηε ην φλνκα ζε “D1_Tub”. 

 ΢πλερίζηε κε ηε κεηνλνκαζία ηνπ Terminal(1) ζε “D1_Gom” θαη ηνπ Terminal(2) ζε 

“D1_Dus”. 
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 Κιείζηε ην παξάζπξν ηνπ Data Manager. 

 

Οη θαηλνχξηεο γξακκέο ζα πξέπεη λα νκαδνπνηεζνχλ κε ηα ηεξκαηηθά ζε έλα αληηθείκελν 

(Branch object). 

 Αλνίμηε ηνλ Data Manager εθ λένπ. 

 Δπηιέμηε ην θάθειν Part 1 θαη παηήζηε δεμί θιηθ. 

 Απφ ην κελνχ πνπ εκθαλίδεηαη επηιέμηε New → Branch (Δηθφλα 2.37). 

 Έλα λένο θιάδνο (branch) δεκηνπξγείηαη. 

 Ολνκάζηε ην λέν απηφ θιάδν “L_Swb_Reut”. 

 Δπηιέμηε ηα ηεξκαηηθά D1_Tub, D1_Gom, D1_Dus. 

 Κάληε δεμί θιηθ θαη απνθνπή. 

 Δπηιέμηε ην λέν θιάδν L_Swb_Reut απφ ην δέληξν ζηα αξηζηεξά. 

 Κάληε δεμί θιηθ θαη επηθφιιεζε. 

 Δπαλαιάβεηε αθξηβψο ηελ ίδηα δηαδηθαζία γηα ηηο γξακκέο L_Swb_Tub, L_Tub_Dus, 

L_Dus_Gom, L_Gom_Reut. 

 

Ζ Δηθφλα 2.38 παξνπζηάδεη ην λέν θιάδν κε ηα ζηνηρεία πνπ κεηαθέξζεθαλ κε ηελ 

πξνεγνχκελε δηαδηθαζία. 

 

 
Εικόνα 2.37: Γεκηνπξγία ελόο λένπ θιάδνπ ζηνλ Data Manager 
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Εικόνα 2.38: Ο λένο θιάδνο κε ηα ζηνηρεία πνπ κεηαθέξζεθαλ 

 

Σέινο, γηα ηνλ θιάδν απηφ: 

 Κάληε δεμί θιηθ επάλσ ζηνλ θιάδν απφ ην δέληξν. 

 Δπηιέμηε Edit απφ ην εκθαληδφκελν κελνχ ψζηε λα αλνίμεη ην παξάζπξν δηαιφγνπ 

(ElmBranch). 

 Παηήζηε ην πιήθηξν Update γηα λα ζπκπιεξσζνχλ απηφκαηα νη ζπλδέζεηο θ.ά. ηνπ 

θιάδνπ.  

 Κιείζηε ην παξάζπξν κε ην OK. 

 

 
Εικόνα 2.39: Ο ελεκεξωκέλνο θιάδνο 

  

Αθνινχζσο, πξέπεη λα ξπζκηζηνχλ νη ηχπνη ησλ ηεζζάξσλ λέσλ θνξηίσλ: 

 Δπηιέμηε φια ηα θνξηία (επηιέγνληαο έλα θαη κεηά θξαηψληαο παηεκέλν ην Ctrl γηα 

λα επηιέμεηε θαη ηα άιια). 

 Παηήζηε δεμί θιηθ πάλσ ζε θάπνην απφ ηα επηιεγκέλα θνξηία θαη επηιέμηε Edit Data. 
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 Κάληε δηπιφ θιηθ ζε έλα απφ απηά θαη, ζην παξάζπξν δηαιφγνπ πνπ αλνίγεη, 

αθνινπζήζηε ηε δηαδξνκή Type → Select Project Type → General Load Type 

(TypLod) →  Types Loads → General Load θαη θιείζηε ην παξάζπξν κε ην ΟΚ. 

 Κιείζηε θαη ην παξάζπξν δηαιφγνπ ηνπ θνξηίνπ κε ΟΚ. 

 Δπαλαιάβεηε θαη γηα ηα ππφινηπα θνξηία. 

 

Μπνξεί λα γίλεη, πιένλ, ε ξχζκηζε γηα ηελ απαίηεζε ηζρχνο γηα ηα θνξηία απηά: 

 Γηα ην αλψηεξν θνξηίν: 

- ΢ηελ θαξηέια Basic Data αιιάμηε ην φλνκα ζε “Tubin”. 

- ΢ηελ θαξηέια Load Flow: 

 Balanced/Unbalanced=Balanced 

 Active Power=4.0 MW 

 Power Factor=0.9 

 Voltage=1.0 p.u. 

 

Αλ ε επηινγή Active Power ή/θαη ε επηινγή ηνπ Power Factor δελ είλαη δηαζέζηκεο, ηφηε ζην 

Input Mode επηιέμηε ην P, cos(phi). Όια ηα θνξηία ζεσξνχληαη επαγσγηθά. 

 

 Γηα ην κεζαίν θνξηίν αθνινπζείηαη ε ίδηα δηαδηθαζία: 

- ΢ηελ θαξηέια Basic Data αιιάμηε ην φλνκα ζε “Duslin”. 

- ΢ηελ θαξηέια Load Flow: 

 Balanced/Unbalanced=Balanced 

 Active Power=1.0 MW 

 Power Factor=0.9 

 Voltage=1.0 p.u. 

 Γηα ην ηξίην θαηά ζεηξά θνξηίν επίζεο: 

- ΢ηελ θαξηέια Basic Data κεηαβάιιεηε ην φλνκα ζε “Goma”. 

- ΢ηελ θαξηέια Load Flow: 

 Balanced/Unbalanced=Balanced 

 Active Power=1.0 MW 

 Power Factor=0.9 

 Voltage=1.0 p.u. 

 Γηα ην θνξηίν πνπ βξίζθεηαη ζην κηθξφ δπγφ ζην θάησ κέξνο ηνπ δηαγξάκκαηνο:  

- ΢ηελ θαξηέια Basic Data νξίζηε φλνκα “Reutlin”. 

- ΢ηελ θαξηέια Load Flow: 

 Balanced/Unbalanced=Balanced 

 Active Power=3.0 MW 

 Power Factor=0.9 

 Voltage=1.0 p.u. 

 

΢ην ζεκείν απηφ ν ζρεδηαζκφο ηνπ ζπζηήκαηνο νινθιεξψλεηαη θαη ζεηξά έρνπλ νη 

ππνινγηζκνί. 
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2.3.4. Εκτϋλεςη υπολογιςμών 
 

΢ε πξψηε θάζε, εθηειείηαη έλαο ππνινγηζκφο ξνήο θνξηίνπ κε ηηο εμήο παξακέηξνπο: 

 Calculation Method: AC Load Flow, Balanced, positive sequence 

 Όιεο νη άιιεο επηινγέο είλαη απελεξγνπνηεκέλεο. 

 

Δίλαη ζεκαληηθφ εδψ λα θαζνξηζηεί, κε βάζε ηα απνηειέζκαηα, πνηα ζηνηρεία ηνπ δηθηχνπ 

παξνπζηάδνπλ ππεξθφξηηζε. Τπάξρεη ε δπλαηφηεηα λα «ρξσκαηηζηνχλ» ηα ζηνηρεία απηά 

πάλσ ζην δηάγξακκα: 

 Δπηιέμηε ην Diagram Colouring ( ) απφ ηε γξακκή εξγαιείσλ ηνπ κνλνγξακκηθνχ 

δηθηχνπ. 

 ΢ηελ θαξηέια Load Flow επηιέμηε ην “3. Others” θαη ηα Results, Voltages/Loading 

απφ ηα κελνχ.  

 Δπηιέμηε Colour Settings θαη ζηελ θαξηέια Voltages/Loading αιιάμηε ην Max. 

Loading of Edge Element ζε 90%, 95% θαη 100%, φπσο θαίλεηαη ζηελ Δηθφλα 2.40. 

 Κιείζηε ην παξάζπξν παηψληαο ΟΚ κεηά ηηο ξπζκίζεηο απηέο. 

 

 
Εικόνα 2.40: Παξνπζίαζε ηωλ ρξωκάηωλ ηνπ κνλνγξακκηθνύ δηθηύνπ 

 

Πιένλ, είλαη ζαθέο πσο ε γξακκή L_Swb_Tub είλαη ππεξθνξηηζκέλε. Τπεξηάζεηο ζην 

δίθηπν δε θαίλεηαη λα ππάξρνπλ (νη ζηαζκνί έρνπλ κπιε ρξψκα). Αλ δε θαίλνληαη ηα 
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ρξψκαηα ζην δίθηπν, εθηειέζηε εθ λένπ έλαλ ππνινγηζκφ ξνήο θνξηίνπ. Γηα λα βειηησζεί ε 

θαηάζηαζε (ππεξθφξηηζε ηνπ θαισδίνπ), ζα πξαγκαηνπνηεζνχλ νη εμήο αιιαγέο: 

 Κάληε δηπιφ θιηθ ζηε γξακκή L_Swb_Tub. 

 Δπηιέμηε έλα, άιιν ηχπν θαισδίνπ: 

- Type → Select project type → Cable 11kV800A 

- Παηήζηε OK. 

Δθηειέζηε ηνλ ππνινγηζκφ ξνήο θνξηίνπ εμ αξρήο, νπφηε θαίλεηαη φηη ε γξακκή δελ 

ππεξθνξηίδεηαη πιένλ. ΢ε απηφ ην ζεκείν: 

 Δπηιέμηε κία απφ ηηο γξακκέο (L_Swb_Tub, L_Dus_Gom θ.ιπ.) θαη κεηά παηήζηε 

δεμί θιηθ → Switch off. Απνκνλψλεηαη έηζη ην ζχζηεκα ησλ θνξηίσλ (γίλνληαη αρλά 

ζην δηάγξακκα). 

 Δθηειέζηε πάιη έλαλ ππνινγηζκφ θαη παξαηεξήζηε ηηο δηαθνξέο. 

 

Με ηελ επηινγή Switch off ηεο γξακκήο, ν ππνινγηζκφο βξαρπθπθιψκαηνο ζηνλ ηειεπηαίν 

δπγφ δελ έρεη λφεκα: 

 Κάληε δεμί θιηθ ζην δπγφ D1_Reut. 

 Calculate → Short Circuit 

 Method=According to IEC, Fault=3-phase Short Circuit. 

 

Απηφ ζα νδεγήζεη ζε ζθάικα, φπσο θαίλεηαη θαη απφ ην κήλπκα ζην παξάζπξν εμφδνπ 

 

 Δλεξγνπνηήζηε ηε γξακκή (Switch on). 

 Δθηειέζηε κε ηνλ ίδην ηξφπν ην βξαρπθχθισκα. Θα πξέπεη ηψξα λα εθηειείηαη ν 

ππνινγηζκφο θαλνληθά ρσξίο κήλπκα ιάζνπο. 

 

΢ε απηφ ην ζεκείν νινθιεξψλεηαη ε παξνπζίαζε ησλ βαζηθψλ ραξαθηεξηζηηθψλ ηνπ Data 

Manager ηνπ πξνγξάκκαηνο. 
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ΚΕΥΑΛΑΙΟ 3 
 

Μελϋτη ροών φορτύου 
 

3.1. Ειςαγωγό 
 

Ο θχξηνο ξφινο ελφο ζπζηήκαηνο ειεθηξηθήο ελέξγεηαο είλαη λα ηθαλνπνηεί ηε δήηεζε 

ελεξγνχ θαη άεξγνπ ηζρχνο ησλ θνξηίσλ. Ζ κειέηε ξνψλ θνξηίνπ αθνξά φρη κφλν ηνλ 

πξαγκαηηθφ θπζηθφ κεραληζκφ πνπ ειέγρεη ηε ξνή θνξηίνπ ζε έλα πιέγκα δηθηχνπ, αιιά θαη 

ηελ επηινγή κηαο «βέιηηζηεο» ξνήο κέζα απφ αλαξίζκεηεο άιιεο. 

 

Ζ επίιπζε πξνβιεκάησλ κεγάισλ δηαζηάζεσλ είλαη δπλαηή ζήκεξα κέζσ ηεο ρξήζεο 

ςεθηαθψλ ππνινγηζηψλ. Σν πξφβιεκα ησλ ξνψλ θνξηίνπ ζπλίζηαηαη ζηνλ πξνζδηνξηζκφ 

ησλ κεηαβιεηψλ ηνπ ζπζηήκαηνο (ελεξγφο θαη άεξγνο ηζρχο, ηάζε, ξεχκα) ζε κηα δεδνκέλε 

(κφληκε) θαηάζηαζε ιεηηνπξγίαο. Απηφ πξνυπνζέηεη ηελ χπαξμε φισλ ησλ απαξαίηεησλ 

δεδνκέλσλ γηα ηελ απνηχπσζε ηνπ κειεηεκέλνπ δηθηχνπ. Ζ κφληκε θαηάζηαζε ιεηηνπξγίαο 

αληηζηνηρεί ζε κηα ζπγθεθξηκέλε πξφβιεςε δήηεζεο θνξηίσλ θαη παξαγφκελεο ηζρχνο. 

Αληηθείκελν ηνπ πξνβιήκαηνο ξνήο θνξηίνπ απνηειεί ε επίιπζε ησλ κε γξακκηθψλ 

αιγεβξηθψλ εμηζψζεσλ πνπ ζπλδένπλ ηηο δηάθνξεο κεηαβιεηέο ηνπ δηθηχνπ θαη ν 

ππνινγηζκφο ησλ ηάζεσλ ησλ δπγψλ. 

 

Ζ ρξεζηκφηεηα ηεο κειέηεο ξνψλ θνξηίνπ εληνπίδεηαη ζηνπο παξαθάησ βαζηθνχο ιφγνπο [2]: 

 Σν ζπλνιηθφ πνζφ ηεο πξαγκαηηθήο ελέξγεηαο ζην δίθηπν πξνέξρεηαη απφ ηνπο 

ζηαζκνχο ησλ γελλεηξηψλ, θαη εμαξηάηαη απφ ην κέγεζφο θαη ηελ ηνπνζεζία πνπ είλαη 

θηηαγκέλνη. Ζ παξαγσγή πξέπεη λα ηζνχηαη κε ηελ απαίηεζε ηνπ ζπζηήκαηνο ζε θάζε 

ζηηγκή θαη ε ελέξγεηα λα δηαηξείηαη κεηαμχ ησλ γελλεηξηψλ ζε έλα κνλαδηθφ πνζνζηφ 

έηζη ψζηε λα επηηεπρζεί ε βέιηηζηε νηθνλνκηθή ιεηηνπξγία. Σν πνζνζηφ απηφ δελ 

είλαη ζηαζεξφ, αιιά εμαξηάηαη απφ ηελ ψξα ή ηελ εκεξνκελία πνπ επηιχεηαη ε ξνή 

θνξηίνπ, θαζφηη ζηε δηάξθεηα θάζε εκέξαο ηα θνξηία κεηαβάιινληαη ζπλερψο. Απηφ 

ζεκαίλεη φηη ε ξνή θνξηίνπ πνπ ηθαλνπνηεί ηηο απαηηήζεηο ηνπ ζπζηήκαηνο θάπνηα 

ζπγθεθξηκέλε ψξα ηεο κέξαο , ζα είλαη δηαθνξεηηθή απφ ηελ ξνή θνξηίνπ ηελ 

επφκελε ψξα. 

 Οη γξακκέο κεηάδνζεο κπνξνχλ λα κεηαθέξνπλ κφλν ζηαζεξά πνζά ελέξγεηαο θαη 

δελ πξέπεη λα ιεηηνπξγνχλ πνιχ θνληά ζηα φξηα ιεηηνπξγίαο ηνπο. 

 Δίλαη ζεκαληηθφ ηα επίπεδα ησλ ηάζεσλ ησλ δπγψλ λα θξαηνχληαη ζηαζεξά κε πνιχ 

κηθξέο αλνρέο. Απηφ κπνξεί λα επηηεπρζεί κε θαηάιιειν πξνγξακκαηηζκφ ησλ 

άεξγσλ ελεξγεηψλ. 

 Δάλ ην ζχζηεκα είλαη κέξνο ελφο κεγαιχηεξνπ δηαζπλδεκέλνπ ζπζηήκαηνο, ζα πξέπεη 

λα πιεξνί λα πξνγξακκαηηζκέλεο ζπκβάζεηο ελέξγεηαο κέζσ ησλ δηαζπλδεηηθψλ 

γξακκψλ κε ηηο γεηηνληθέο ηνπ πεξηνρέο. 
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 Οη δηαηαξαρέο κεηά απφ έλα ζθάικα ζην δίθηπν κπνξνχλ λα πξνθαιέζνπλ ζνβαξή 

βιάβε ζην ζχζηεκα. Οη ζπλέπεηεο απηήο ηεο βιάβεο κπνξνχλ λα ειαρηζηνπνηεζνχλ 

αλ πξηλ ην ζθάικα έρνπλ εθαξκνζζεί δηάθνξεο ζηξαηεγηθέο ξνψλ θνξηίνπ. 

 Ζ κειέηε ξνψλ θνξηίνπ είλαη πνιχ ζεκαληηθή ζην ζρεδηαζκφ λέσλ δηθηχσλ ή ζηελ 

πξνέθηαζε ελφο ήδε ππάξρνληνο ζπζηήκαηνο. 

 

Απφ ηα παξαπάλσ θαζίζηαηαη ζαθέο φηη ε αλάιπζε ησλ ξνψλ θνξηίνπ είλαη ην ζεκείν 

εθθίλεζεο γηα φιεο ηηο επηκέξνπο κειέηεο ησλ ζπζηεκάησλ ειεθηξηθήο ελέξγεηαο. 

 

Γηα ηηο µειέηεο ξνήο θνξηίνπ νη θαηαζηάζεηο ιεηηνπξγίαο ηνπ ζπζηήκαηνο, νη νπνίεο πξέπεη 

λα επηιεγνχλ ζε µηα ρξνληθή πεξίνδν (π.ρ. 5 εηψλ), εμαξηψληαη θαη επεξεάδνληαη απφ ηνπο 

εμήο παξάγνληεο [3]: 

 Σηο ζπλζήθεο θνξηίζεσο ηνπ ζπζηήκαηνο. Γεληθά ε ζπµπεξηθνξά ηνπ ζπζηήκαηνο 

µειεηάηαη ζε «αθξαίεο» θαηαζηάζεηο θφξηηζεο, φπσο γηα παξάδεηγκα θαηά ηηο ψξεο 

ηεο µέγηζηεο θαη ειάρηζηεο δήηεζεο θνξηίνπ. 

 Σα δηάθνξα ζελάξηα θφξηηζεο ησλ µνλάδσλ παξαγσγήο, φπσο δηαµνξθψλνληαη απφ 

ηε δηαζεζηµφηεηα ησλ µνλάδσλ. Γεληθά, ε θαηαλνµή ηεο παξαγφµελεο ηζρχνο ζηηο 

δηάθνξεο µνλάδεο παξαγσγήο γίλεηαη µε βάζε ηηο ζπλήζεηο πξαθηηθέο, φπσο 

πξνθχπηνπλ απφ ηε ζεηξά έληαμεο ησλ µνλάδσλ πνπ αθνινπζείηαη ζηελ πξάμε. 

 Σα θξηηήξηα αμηνπηζηίαο. 

 Σνλ θαζνξηζµφ ηνπ ηξφπνπ ιεηηνπξγίαο ηνπ ζπζηήµαηνο γηα ηελ ειαρηζηνπνίεζε ησλ 

απσιεηψλ θαη γηα ηελ απνθπγή θαηαπφλεζεο ηνπ εμνπιηζµνχ ηνπ (ηζρχο 

βξαρπθχθισζεο, φξηα θφξηηζεο θ.ιπ.). 

 Δλαιιαθηηθέο πεξηπηψζεηο γηα ηε ρξνληθή βειηηζηνπνίεζε έληαμεο λέσλ έξγσλ 

µεηαθνξάο. 

 

 

3.2. Μοντϋλα ςτοιχεύων ςυςτημϊτων ηλεκτρικόσ ενϋργειασ 
 

΢ηελ ελφηεηα απηή παξνπζηάδεηαη ε κνληεινπνίεζε ησλ ζηνηρείσλ ελφο ζπζηήκαηνο 

ειεθηξηθήο ελέξγεηαο, φπσο ρξεζηκνπνηείηαη ζηηο κειέηεο ξνήο θνξηίνπ. ΢πγθεθξηκέλα, 

δίλνληαη ηα κνληέια ησλ γελλεηξηψλ, ησλ γξακκψλ κεηαθνξάο, ησλ εγθάξζησλ ππθλσηψλ 

θαη απηεπαγσγψλ, ησλ κεηαζρεκαηηζηψλ θαη ησλ θνξηίσλ. Δπεηδή ε κειέηε ξνψλ θνξηίνπ 

πξνυπνζέηεη ηε ζπκκεηξηθή θαηάζηαζε ηνπ ζπζηήκαηνο, ε αλάιπζε βαζίδεηαη ζηα 

κνλνθαζηθά ηζνδχλακα θπθιψκαηα, νη παξάκεηξνη ησλ νπνίσλ εθθξάδνληαη ζε θνηλφ αλά 

κνλάδα ζχζηεκα. [3], [4] 

 

 

3.2.1. Παρϊςταςη γεννητριών 
 

Οη γελλήηξηεο παξηζηάλνληαη γηα ηηο κειέηεο ξνήο θνξηίνπ ζαλ πεγέο ελεξγνχ θαη άεξγνπ 

ηζρχνο: 

G G GS P jQ   

φπνπ SG είλαη ε κηγαδηθή παξαγφκελε ηζρχο (θαηλφκελε), PG ε πξαγκαηηθή παξαγφκελε 

ηζρχο (ελεξγφο) θαη QG  ε άεξγνο ηζρχο. 
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Σχήμα 1: Παξάζηαζε γελλήηξηαο 

 

Οη ζχγρξνλεο γελλήηξηεο ξπζκίδνληαη ζπλερψο απφ δχν δηαηάμεηο ειέγρνπ. Ο απηφκαηνο 

ξπζκηζηήο ηάζεο δηαηεξεί ζηαζεξφ ην κέηξν ηεο ηεξκαηηθήο ηάζεο ηεο γελλήηξηαο, 

ξπζκίδνληαο θαηάιιεια ην ξεχκα δηέγεξζεο. Ο ξπζκηζηή ζηξνθψλ θξαηά ζηαζεξή ηελ 

ελεξγφ παξαγσγή πξνζαξκφδνληαο ηελ παξαγφκελε κεραληθή ηζρχ ηεο θηλεηήξηαο κεραλήο. 

Έηζη, ζηηο κειέηεο ξνήο θνξηίνπ νη ζχγρξνλεο γελλήηξηεο παξηζηάλνληαη ζπλήζσο κε 

ζηαζεξή ηεξκαηηθή ηάζε (θαηά κέηξν) θαη ζηαζεξή παξαγσγή πξαγκαηηθήο ηζρχνο. 

 

 

3.2.2. Παρϊςταςη γραμμών μεταφορϊσ 
 

Ζ θάζε γξακκή κεηαθνξάο ηνπ ζπζηήκαηνο ειεθηξηθήο ελέξγεηαο ζηηο κειέηεο ξνψλ θνξηίνπ 

παξηζηάλεηαη κε ην ηζνδχλακν π κνληέιν, φπσο παξηζηάλεηαη ζην παξαθάησ ζρήκα. 

 

 
Σχήμα 2: Ηζνδύλακν π-θύθιωκα γξακκήο κεηαθνξάο 

 

΢ην ΢ρήκα 2 παξνπζηάδνληαη νη αγσγηκφηεηεο ζεηξάο ηεο γξακκήο κεηαθνξάο. Οη 

αγσγηκφηεηεο απηέο κπνξνχλ λα γξαθνχλ ζε κνξθή κηγαδηθνχ αξηζκνχ σο εμήο: 

 
 

 

3.2.3. Παρϊςταςη εγκϊρςιων πυκνωτών και αυτεπαγωγών 
 

Οη εγθάξζηνη ππθλσηέο θαη νη απηεπαγσγέο ηνπ ζπζηήκαηνο ειεθηξηθήο ελέξγεηαο ζηηο 

κειέηεο ξνψλ θνξηίνπ παξηζηάλεηαη κε ην ηζνδχλακν π κνληέιν, φπσο παξηζηάλεηαη ζην 

παξαθάησ ζρήκα. 

ysij ysji 

yij 

G G GS P jQ   
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Σχήμα 3: Ηζνδύλακν π-θύθιωκα εγθάξζηνπ ππθλωηή θαη απηεπαγωγήο 

 

Ζ αγσγηκφηεηα yi είλαη ηεο κνξθήο: yi=jbi, φπνπ bi είλαη ζεηηθή παξάκεηξνο γηα ππθλσηή θαη 

αξλεηηθή γηα απηεπαγσγή. 

 

 

3.2.4. Παρϊςταςη μεταςχηματιςτών 
 

Σηο πεξηζζφηεξεο θνξέο ζηηο κειέηεο ξνψλ θνξηίνπ ρξεζηκνπνηείηαη ην απινπνηεκέλν 

ηζνδχλακν ρσξίο ηελ αγσγηκφηεηα καγλήηηζεο, νπφηε ν κεηαζρεκαηηζηήο παξηζηάλεηαη κε 

κηα αγσγηκφηεηα ζεηξάο φπσο ζην ΢ρήκα 4. 

 

 
Σχήμα 4: Ηζνδύλακν π-θύθιωκα κεηαζρεκαηηζηή 

 

Σν ΢ρήκα 4 αλαθέξεηαη ζε έλα κεηαζρεκαηηζηή κε νλνκαζηηθή ζρέζε κεηαζρεκαηηζκνχ, 

δειαδή ηέηνηα πνπ λα αληηζηνηρεί ζην ιφγν ησλ βαζηθψλ ηάζεσλ πξσηεχνληνο θαη 

δεπηεξεχνληνο. ΢ηα δίθηπα ειεθηξηθήο ελέξγεηαο ππάξρνπλ επίζεο κεηαζρεκαηηζηέο 

ξχζκηζεο, ε ζρέζε κεηαζρεκαηηζκνχ ησλ νπνίσλ δηαθέξεη απφ ην ιφγν ησλ νλνκαζηηθψλ 

ηάζεσλ. ΢ηνπο κεηαζρεκαηηζηέο απηνχο πξέπεη λα ιακβάλεηαη ππφςε θαη ε ζρέζε 

κεηαζρεκαηηζκνχ αλάγνληαο ηηο αλά κνλάδα αληηζηάζεηο ζην έλα απφ ηα δχν ηπιίγκαηά ηνπ. 

 

 

3.2.5. Παρϊςταςη φορτύων 
 

Σα θνξηία πνπ ζπκπεξηιακβάλνληαη ζηηο ζπλεζηζκέλεο κειέηεο ξνψλ θνξηίνπ ηαμηλνκνχληαη 

ζε δχν θαηεγνξίεο: 

 Φνξηία ζηαζεξήο ελεξγνχ θαη άεξγνπ ηζρχνο, δειαδή ζηαζεξνχ ζπληειεζηή ηζρχνο 

(΢ρήκα 5α) 

 Φνξηία κε ζηαζεξή ζχλζεηε αγσγηκφηεηα (΢ρήκα 5β) 

 

 

 

 

Επγφο i  
yL 

Επγφο i 

iy  
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(α)  

(β)  
Σχήμα 5: Παξάζηαζε θνξηίωλ ζηαζεξνύ ζπληειεζηή ηζρύνο (α) θαη ζηαζεξήο αγωγηκόηεηαο (β) 

 

 

3.3. Εξιςώςεισ ροών φορτύου 
 

Σν πξφβιεκα ξνήο θνξηίνπ κπνξεί λα δηαηξεζεί ζηα αθφινπζα ππνπξνβιήκαηα: 

1) Γηαηχπσζε θαηάιιεινπ καζεκαηηθνχ κνληέινπ. Σν κνληέιν πξέπεη λα πεξηγξάθεη ηε 

ζρέζε κεηαμχ ησλ ηάζεσλ θαη ησλ ηζρχσλ ζην δηαζπλδεδεκέλν ζχζηεκα. 

2) Πξνζδηνξηζκφο ησλ πεξηνξηζκψλ ηάζεσλ θαη ηζρχσλ πνπ πξέπεη λα εθαξκνζζνχλ 

ζηνπο δπγνχο ηνπ ζπζηήκαηνο. 

3) Αξηζκεηηθφο ππνινγηζκφο ησλ εμηζψζεσλ ξνψλ θνξηίνπ κε γλψκνλα ηνπο παξαπάλσ 

πεξηνξηζκνχο. Απηνί νη ππνινγηζκνί δίλνπλ ηηο ηάζεηο φισλ ησλ δπγψλ ηνπ 

ζπζηήκαηνο. 

4) Όηαλ νη ηάζεηο ησλ δπγψλ θαζνξηζηνχλ ηφηε θαζνξίδνληαη θαη νη ηζρχεηο ησλ 

γξακκψλ κεηάδνζεο. 

iy

 

DS
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Σχήμα 7: Παξάζηαζε γεληθεπκέλνπ δπγνύ ζπζηήκαηνο ειεθηξηθήο ελέξγεηαο 

 

Οη δπγνί ελφο ζπζηήκαηνο ειεθηξηθήο ελέξγεηαο ηαμηλνκνχληαη ζε ηξεηο θαηεγνξίεο: 

 Επγφο θνξηίνπ (PQ), ζηνλ νπνίν ζεσξνχληαη γλσζηέο ε ελεξγφο θαη άεξγνο ηζρχο 

θνξηίνπ θαη θαηά ζπλέπεηα νη εγρχζεηο ελεξγνχ θαη άεξγνπ ηζρχνο. Άγλσζηα 

ζεσξνχληαη ην κέηξν θαη ε γσλία ηάζεο ηνπ δπγνχ.  

 Επγφο παξαγσγήο (PV), ζηνλ νπνίν είλαη γλσζηά ε παξαγφκελε ελεξγφο ηζρχο θαη ην 

κέηξν ηεο ηάζεο θαη άγλσζηα ε παξαγφκελε άεξγνο ηζρχο θαη ε γσλία ηεο ηάζεο. 

 Επγφο ηαιάλησζεο ή δπγφο αλαθνξάο (Slack – SL), ν νπνίνο είλαη δπγφο παξαγσγήο 

πνπ ρξεζηκνπνηείηαη γηα λα αληηζηαζκίδεη ηηο άγλσζηεο εμ αξρήο απψιεηεο ηνπ 

δηθηχνπ θαη γεληθά γηα άκεζε αληηκεηψπηζε ησλ κεηαβνιψλ ηζρχνο. ΢ηνλ δπγφ απηφ 

επηβάιιεηαη ζηαζεξή ηάζε θαηά κέηξν θαη γσλία, ελψ πξνζδηνξίδνληαη ε ελεξγφο θαη 

άεξγνο παξαγφκελε ηζρχο. ΢πλήζσο, νξίδνπκε γηα ην δπγφ ηαιάλησζεο γσλία ηάζεο 

δ=0. 

 

Θεσξνχκε φηη κία ή πεξηζζφηεξεο γξακκέο είλαη ζπλδεδεκέλεο κε ην δπγφ m , ελψ ζην δπγφ 

k  είλαη ζπλδεδεκέλε κηα ζχλζεηε αγσγηκφηεηα ky  (θάζε ζπλδπαζκφο ππθλσηψλ, 

απηεπαγσγψλ ή θνξηίσλ κε ζηαζεξή αγσγηκφηεηα). Ζ γελλήηξηα είλαη ζπλδεδεκέλε ζην δπγφ 

k θαη εγρέεη ξεχκα GKI
~

 ελψ ην θνξηίν DKS
~

απνξξνθά ξεχκα DKI
~

. Ζ ηάζε ζηνπο δπγνχο k  

θαη m  είλαη αληίζηνηρα kV
~

 θαη mV
~

. 

 

Γηα ηα ξεχκαηα ηζρχεη: 

Σν ξεχκα kmI  πνπ δηαξξέεη ηε γξακκή κεηαμχ ησλ δπγψλ k  θαη m  ηζνχηαη κε: 

  mkmkkmskmkm VyVyyI
~

*
~~
    (3.7) 

Σν ξεχκα πνπ απνξξνθάηαη απφ ηελ εγθάξζηα αγσγηκφηεηα ηζνχηαη κε: 

kkk VyI
~

*
~
      (3.8) 

Δθαξκφδνληαο ην λφκν ησλ ξεπκάησλ Kirchhoff ζην δπγφ k  πξνθχπηεη: 

kmy  

ky  
skmy  

skmy  

DKS  

Επγφο m  Επγφο k  
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 

 
   

* *

GK DK k km

m a k

GK DK k skm km k km m

m a k m a k

I I I I

I I y y y V y V



 

   

  
      

  



 

   

     

 

* *GK DK kk k km m

m a k

I I y V Y V


         (3.9) 

φπνπ 

 
 

kmkm

kam

kmskmkkk

yY

yyyy



 
  

Σα ζηνηρεία kky  θαη kmy  είλαη ζηνηρεία ηεο κήηξαο αγσγηκνηήησλ. 

 

Γηα ηηο ηζρχεηο γελλεηξηψλ θαη θνξηίσλ ηζρχεη: 

*

*

DK K DK

GK K GK

S V I

S V I

 

 

  

  
    (3.10) 

Απφ ηηο εμηζψζεηο (3.9) θαη (3.10) πξνθχπηεη:  

 

2

* * *GK DK kk k k km m

m a k

S S Y V V Y Y


              (3.11) 

 

Ζ ηειεπηαία εμίζσζε εθθξάδεη ην ηζνδχγην ηζρχνο ζην δπγφ k . Γηα έλα ζχζηεκα Ν δπγψλ 

ηζρχνπλ Ν ηέηνηεο εμηζψζεηο, νη νπνίεο απνηεινχλ ηηο εμηζψζεηο ξνήο θνξηίνπ. 

  

Οη εμηζψζεηο ξνψλ θνξηίνπ κπνξνχλ λα γξαθνχλ ζε θαξηεζηαλή ή πνιηθή κνξθή. ΢πρλφηεξα 

φκσο ρξεζηκνπνηείηαη ε πβξηδηθή, φπνπ νη ηάζεηο βξίζθνληαη ζε πνιηθή κνξθή, θαη νη 

αγσγηκφηεηεο ζε θαξηεζηαλή. 

 

Θεσξείηαη : 

kkk

sgmsgmsgm

j

kk

jbgy

jbgy

eVV





 
~

    (3.12) 

νπφηε πξνθχπηεη απφ ηελ εμίζσζε ηνπ ηζνδπγίνπ ηζρχνο (πξαγκαηηθφ/ θαληαζηηθφ κέξνο): 

 
 

    
 

2 2 cos sinGK DK k km skm k k k m km m km m

m a k m a k

P P V g g V g V V g b    
 

         
 (3.13) 

 
 

    
 

2 2 sin cosGK DK k km skm k k k m km m km m

m a k m a k

Q Q V b b V b V V g b    
 

           (3.14) 

 

Οη παξαπάλσ 2Ν κε γξακκηθέο εμηζψζεηο γηα έλα ζχζηεκα Ν δπγψλ απνηεινχλ ηηο εμηζψζεηο 

ξνήο θνξηίνπ ζε πβξηδηθή κνξθή. Θεσξνχκε ηε γε σο πξφζζεην θφκβν αλαθνξάο (Ν+1). 
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3.4. Θεμελύωςη του προβλόματοσ ροών φορτύου 
 

Οξίδεηαη ην δηάλπζκα θαηάζηαζεο x , ην νπνίν απαξηίδεηαη απφ ηα κέηξα ηάζεσλ φισλ ησλ 

δπγψλ θνξηίνπ θαη ηηο θαζηθέο γσλίεο ηάζεσλ φισλ ησλ δπγψλ - εθηφο ηνπ δπγνχ 

ηαιάλησζεο. Δίλαη δηάζηαζεο 1n m  , φπνπ n  είλαη ν ζπλνιηθφο αξηζκφο ησλ δπγψλ ηνπ 

ζπζηήκαηνο θαη m  ν αξηζκφο ησλ δπγψλ θνξηίνπ (PQ). Έηζη, απαηηνχληαη γηα ηελ επίιπζή 

ηνπ αληίζηνηρεο αλεμάξηεηεο εμηζψζεηο ξνήο θνξηίνπ [4]: 

 

 1n   εμηζψζεηο πξαγκαηηθήο ηζρχνο ηεο κνξθήο : 

 

 p pb f x
    (3.15) 

φπνπ 

 p GK DK
k

b P P 
 

       
  

2 2 cos sinp k km skm k k k m km m km m
k

m a k m a k

f V g g V g V V g b    
 

         
 

 

 m  εμηζψζεηο αέξγνπ ηζρχνο ηεο κνξθήο: 

 

 q qb f x
    (3.16) 

φπνπ 

 q GK DK
k

b Q Q 
 

       
  

2 2 sin cosq k km skm k k k m km m km m
k

m a k m a k

f V b b V b V V g b    
 

          
 

 

Σειηθά νη εμηζψζεηο ησλ ξνψλ γξακκψλ ζε πβξηδηθή κνξθή είλαη:  

      2 cos sinkm k km skm k m km m km mP V g g V V g b         
 (3.17) 

      2 sin coskm k km skm k m km m km mQ V b b V V g b          
 (3.18) 

 

Γηα ηελ θαηάζηξσζε θαη ηε ζεκειίσζε ηνπ πξνβιήκαηνο ησλ ξνψλ θνξηίνπ ζεκεηψλνπκε 

φηη: 

 Οη εμηζψζεηο πεξηιακβάλνπλ ηάζεηο, ηζρχεηο θαη γσλίεο θαη φρη ξεχκαηα, ηα νπνία 

κπνξνχλ λα πξνθχςνπλ εχθνια απφ ηηο ηξεηο παξαπάλσ ραξαθηεξηζηηθέο κεηαβιεηέο. 

 Ζ κειέηε ξνψλ θνξηίνπ γίλεηαη ζηε κφληκε θαηάζηαζε ιεηηνπξγίαο, νπφηε ε 

ζπρλφηεηα ηνπ δηθηχνπ ζεσξείηαη ζηαζεξή. Σν ίδην ηζρχεη γηα φια ηα επαγσγηθά θαη 

ρσξεηηθά ζηνηρεία ηνπ δηθηχνπ, θαη γηα ηε κήηξα αγσγηκνηήησλ. 

 Οη αληίζηνηρεο εμηζψζεηο είλαη αιγεβξηθέο θαη κε γξακκηθέο. 

 Οη γσλίεο εκθαλίδνληαη κφλν σο δηαθνξέο γσληψλ, κεηψλνληαο έηζη θαηά έλα ην 

πιήζνο ησλ κεηαβιεηψλ. 

 

Γεληθά, ην πξφβιεκα ηνπ πξνζδηνξηζκνχ ησλ ξνψλ θνξηίνπ αλάγεηαη ζηελ επίιπζε n-1 

εμηζψζεσλ κε n-1 αγλψζηνπο. Σν πξφβιεκα απηφ παξνπζηάδεη ηηο εμήο ηδηαηηεξφηεηεο: 

1. Οη εμηζψζεηο είλαη κηγαδηθέο. 

2. Οη εμηζψζεηο είλαη κε γξακκηθέο. 
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Γεδνκέλνπ φηη νη πεξηζζφηεξνη ειεθηξνληθνί ππνινγηζηέο έρνπλ ηε δπλαηφηεηα επεμεξγαζίαο 

κηγαδηθψλ αξηζκψλ, ε κηγαδηθή θχζε ησλ εμηζψζεσλ ξνήο θνξηίνπ δελ παξνπζηάδεη 

ηδηαίηεξε δπζθνιία. Δάλ ε δπλαηφηεηα απηή δελ ππάξρεη, ζα πξέπεη νη κηγαδηθέο εμηζψζεηο λα 

κεηαηξαπνχλ ζε πξαγκαηηθέο εμηζψζεηο, κε πξαγκαηηθνχο αγλψζηνπο, φπσο νη (3.17), (3.18). 

Ζ δηαδηθαζία απηή, βέβαηα, δηπιαζηάδεη ηνλ αξηζκφ ησλ εμηζψζεσλ. Οη πιένλ απνδνηηθέο 

κέζνδνη επίιπζεο ησλ εμηζψζεσλ ξνήο θνξηίνπ απαηηνχλ ην κεηαζρεκαηηζκφ απηφ ζε 

εμηζψζεηο κε πξαγκαηηθνχο ζπληειεζηέο αλεμάξηεηα απφ ηηο δπλαηφηεηεο ηνπ ειεθηξνληθνχ 

ππνινγηζηή. 

 

Ωζηφζν, ν κε γξακκηθφο ραξαθηήξαο ησλ εμηζψζεσλ ξνήο θνξηίνπ δεκηνπξγεί κία πην 

ζνβαξή δπζθνιία. Γηα ηε ιχζε ηνπο απαηνχληαη αλαθπθισηηθνί αιγφξηζκνη, φπσο είλαη ε 

κέζνδνο Newton-Raphson πνπ παξνπζηάδεηαη ζηε ζπλέρεηα. 

 

 

3.5. Σεχνικϋσ επύλυςησ του προβλόματοσ ροών φορτύου 
 

3.5.1. Γενικϊ για τισ αριθμητικϋσ μεθόδουσ επύλυςησ του 
προβλόματοσ ροών φορτύου 

 
Δίλαη πξνθαλέο απφ ηα πξνεγνχκελα φηη ν πξφβιεκα ξνψλ θνξηίνπ ζπλίζηαηαη ζηε ιχζε 

ελφο ζπζηήκαηνο κε γξακκηθψλ εμηζψζεσλ. Σν γεγνλφο φηη νη εμηζψζεηο ξνήο θνξηίνπ είλαη 

κε γξακκηθέο, δπζρεξαίλεη ηελ αλαιπηηθή επίιπζε ηνπ ζπζηήκαηνο. Έηζη, ρξεζηκνπνηνχληαη 

ςεθηαθέο κέζνδνη αξηζκεηηθήο επίιπζεο, κε ηθαλνπνηεηηθή αθξίβεηα, αθφκα θη αλ πξφθεηηαη 

γηα πνιχ κεγάια ζπζηήκαηα, κε ρηιηάδεο δπγνχο. Γεληθά, νη εμηζψζεηο ξνψλ θνξηίνπ 

κπνξνχλ λα γξαθηνχλ ζηελ αθφινπζε γεληθεπκέλε κνξθή: 

  0xg      (3.19) 

φπνπ 
x : δηάλπζκα θαηάζηαζεο δηάζηαζεο n  
g : m  εμηζψζεηο ξνήο θνξηίνπ 

 

Γηα ηελ επίιπζε ηνπ παξαπάλσ ζπζηήκαηνο κε γξακκηθψλ εμηζψζεσλ ρξεζηκνπνηνχληαη 

επαλαιεπηηθέο κέζνδνη. Ζ γεληθή δηαδηθαζία γηα ηελ επίιπζε ηεο εμίζσζεο (3.19), κε ηε 

βνήζεηα κίαο επαλαιεπηηθήο κεζφδνπ, έρεη σο εμήο [4]: 

1. Θεσξείηαη κία αξρηθή ηηκή ηνπ δηαλχζκαηνο θαηάζηαζεο x=x0. Μεδελίδεηαη ν 

κεηξεηήο αλαθπθιψζεσλ i=0. 

2. Αληηθαζίζηαηαη ε xi γηα ηνλ ππνινγηζκφ ησλ g(xi) θαη ειέγρεηαη εάλ ηθαλνπνηνχληαη 

νη εμηζψζεηο (3.19). 

3. Αλ νη εμηζψζεηο (3.19) δελ ηθαλνπνηνχληαη, κε ρξήζε ησλ xi θαη g(xi) ππνινγίδεηαη 

κία θαηλνχξηα πξνζέγγηζε xi+1. Δλεκεξψλεηαη ν κεηξεηήο αλαθπθιψζεσλ i=i+1. 

4. Αληηθαζίζηαηαη ε xi+1 ζηηο εμηζψζεηο (3.19) θαη επαλαιακβάλνληαη ηα βήκαηα 2 θαη 3 

έσο φηνπ νη εμηζψζεηο ηθαλνπνηεζνχλ. 

 

Ζ πνηφηεηα ηεο δηαδηθαζίαο θξίλεηαη απφ ηελ ηαρχηεηα ζχγθιηζήο ηεο. Οη δχν βαζηθφηεξεο 

κέζνδνη πνπ ρξεζηκνπνηνχληαη είλαη ε Gauss, κε ηελ Gauss-Seidel λα είλαη κία βειηησκέλε 

κνξθή ηεο, θαη ε Newton-Raphson. Παξαθάησ αλαιχεηαη ε κέζνδνο Newton-Raphson πνπ 

ρξεζηκνπνηεί θαη ην ινγηζκηθφ PowerFactory ζηελ αλάιπζε ξνήο θνξηίνπ. 
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3.5.2. Η μϋθοδοσ Newton-Raphson 
 

΢χκθσλα κε ηα παξαπάλσ, νη εμηζψζεηο ηνπ πξνβιήκαηνο ξνήο θνξηίνπ γξάθνληαη σο εμήο: 

 

 
 

 

  nnn

n

n

bxxxf

bxxxf

bxxxf

bxf









,......,,

,......,,

,......,,

2

222

121



    (3.20) 

 

κε αξρηθή εθηίκεζε  

 00

2

0

10 ,......,, nxxxx 
   (3.21) 

 

Αλ ε αξρηθή εθηίκεζε δελ ηθαλνπνηεί ηελ εμίζσζε ηνπ πξνβιήκαηνο, απαηηείηαη κηα 

θαιχηεξε εθηίκεζε ησλ κεηαβιεηψλ θαηάζηαζεο. Ζ κέζνδνο Newton-Raphson ζπλίζηαηαη 

ζηε γξακκηθνπνίεζε ηνπ ζπζηήκαηνο (3.19) γχξσ απφ ην ζεκείν 0x . Ζ γξακκηθνπνίεζε 

γίλεηαη κε ηε βνήζεηα ηνπ αλαπηχγκαηνο Taylor κηαο ζπλάξηεζεο πνιιψλ κεηαβιεηψλ 

ακειψληαο ηνπο φξνπο κεγαιχηεξεο ηάμεο. Έηζη, πξνθχπηεη: 
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Οη εμηζψζεηο απηέο κπνξνχλ λα γξαθηνχλ ζε κεηξηθή κνξθή: 
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Λχλνληαο ηε γξακκηθνπνηεκέλε έθθξαζε σο πξνο x , ιακβάλνπκε: 

 

    
1

0 0 0x x J x b f x


  
   (3.23) 

 

Γεληθά, γηα θάζε αλαθχθισζε l  ηζρχεη: 

 

    llll xfbxJxx 
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   (3.24) 

 

Ζ βέιηηζηε ιχζε πξνθχπηεη φηαλ γηα ην ζπγθεθξηκέλν δηάλπζκα 
lx  ε δηαθνξά  lxfb   

γίλεηαη κηθξφηεξε απφ ηελ πξνθαζνξηζκέλε αλνρή ζχγθιηζεο. 

 

΢ε πβξηδηθή κνξθή, νη εμηζψζεηο ξνήο θνξηίνπ είλαη ηεο κνξθήο: 
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Σα ζηνηρεία ησλ δηαλπζκαηηθψλ ζπλαξηήζεσλ 
,P Qf f

 θαη ησλ δηαλπζκάησλ 
,P Qb b

 νξίζηεθαλ 

ζηελ ελφηεηα 3.4. Δθαξκφδνπκε ηε κέζνδν Newton-Raphson γηα ηε ιχζε ησλ εμηζψζεσλ 

(3.24) δίλεη: 
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φπνπ γηα ηα ζηνηρεία ηεο Ηαθσβηαλήο ηζρχεη: 
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΢πκπεξαζκαηηθά, ε κέζνδνο Newton-Raphson είλαη θαηά θαλφλα ε ηαρχηεξε σο πξνο ηε 

ζχγθιηζε κέζνδνο θαη είλαη αξθεηά αθξηβήο σο πξνο ηελ απνηειεζκαηηθφηεηα ηεο. Ωζηφζν, 

είλαη πην ζχλζεηε απφ ηε κέζνδν Gauss-Seidel θαη απαηηεί ζεκαληηθή κλήκε ζηνλ 

ειεθηξνληθφ ππνινγηζηή, αθνχ είλαη αλαγθαία ε δηακφξθσζε θαη αληηζηξνθή ηεο 

Ηαθσβηαλήο κήηξαο ζε θάζε αλαθχθισζε. 
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ΚΕΥΑΛΑΙΟ 4 
 

Μελϋτη ροών φορτύου ςε απλϊ δύκτυα 
ηλεκτρικόσ ενϋργειασ 

 
΢ην θεθάιαην απηφ ζα κειεηεζεί ην πξφβιεκα ησλ ξνψλ θνξηίνπ ρξεζηκνπνηψληαο απιά 

δίθηπα ειεθηξηθήο ελέξγεηαο. Σα δίθηπα απηά ζα ζρεδηαζηνχλ ζηελ πιαηθφξκα ηνπ 

PowerFactory, πξνθεηκέλνπ λα εμεηαζηεί ην πξφβιεκα ππφ ην πξίζκα ηνπ πξνγξάκκαηνο θαη 

λα ζπγθξηζνχλ ηα απνηειέζκαηα κε απηά πνπ πξνθχπηνπλ απφ ηνπο ζρεηηθνχο ππνινγηζκνχο. 

 

 

4.1. ΢χεδιαςμόσ των δικτύων ηλεκτρικόσ ενϋργειασ και 
υπολογιςμόσ ροών φορτύου 

 
΢ηελ ελφηεηα απηή παξνπζηάδεηαη ε δηαδηθαζία πξνζνκνίσζεο ησλ δηθηχσλ ειεθηξηθήο 

ελέξγεηαο κε ρξήζε ησλ εξγαιείσλ ηνπ πξνγξάκκαηνο. Πην ζπγθεθξηκέλα, δεκηνπξγνχληαη 

ηα παξαθάησ δίθηπα: 

1. Ηδαληθή πεγή ηάζεο ΔΡ – δπγφο – θνξηίν 

2. Ηδαληθή πεγή ηάζεο ΔΡ – δπγφο – κεηαζρεκαηηζηήο – δπγφο – θνξηίν 

3. ΢χγρξνλε γελλήηξηα – δπγφο – θνξηίν 

4. ΢χγρξνλε γελλήηξηα – δπγφο – ζχγρξνλνο θηλεηήξαο 

 

Σα δίθηπα ησλ ζεκείσλ (4), (5), (6) βαζίδνληαη ζηηο αζθήζεηο (3.1), (3.2), (4.1) ηνπ βηβιίνπ 

ηνπ πξνπηπρηαθνχ καζήκαηνο «Ζιεθηξνηερληθέο Δθαξκνγέο θαη Ζιεθηξνινγηθφ 

Δξγαζηήξην» ηνπ 4νπ εμακήλνπ ηεο ΢ρνιήο Ναππεγψλ Μεραλνιφγσλ Μεραληθψλ ΔΜΠ [5]. 

 

Θεσξείηαη φηη ν ρξήζηεο πνπ ζα επηρεηξήζεη ην ζρεδηαζκφ ησλ δηθηχσλ, έρεη εμνηθεησζεί κε 

ηηο βαζηθέο ιεηηνπξγίεο ηνπ PowerFactory, κέζσ ηνπ Κεθαιαίνπ 2 ηεο παξνχζαο εξγαζίαο. 

 

 

4.1.1. Ιδανικό πηγό τϊςησ και φορτύο 
 

Αξρηθά ν ρξήζηεο δεκηνπξγεί ζην πεξηβάιινλ ηνπ PowerFactory έλα λέν project κε ηνλ 

ηξφπν πνπ έρεη πεξηγξαθεί ζην θεθάιαην 2. ΢ην λέν grid πνπ αλνίγεη, ηνπνζεηείηαη πξψηα 

έλαο απιφο δπγφο (busbar). 
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4.1.1.1. Οριςμόσ ζυγού 
 

Ο ρξήζηεο νξίδεη ηνλ ηχπν ηνπ δπγνχ σο εμήο: 

 Γηπιφ θιηθ ζην δπγφ πξνθεηκέλνπ λα αλνίμεη ην παξάζπξν δηαιφγνπ 

 Type → New Project Type 

 Οξίδεηαη ην φλνκα ηνπ δπγνχ: BB 440V 

 Nominal Voltage: 0.44 kV 

 Αθνχ θιείζεη ην παξάζπξν ηνπ Type, ζηελ θαξηέια Basic Data ν ρξήζεο νξίδεη έλα 

φλνκα π.ρ. Busbar θαη εθ λένπ ζέηεη ην Nominal Voltage → Line-Line ζηα 0.44 kV. 

 

΢εκεηψλεηαη φηη, ζε αληίζεζε κε ηηο αζθήζεηο ησλ tutorial πνπ παξνπζηάζηεθαλ ζην 

θεθάιαην 2, εδψ ν ρξήζηεο ζα πξέπεη λα νξίζεη έλαλ λέν ηχπν δπγνχ αθνχ ζηε βηβιηνζήθε 

ηνπ PowerFactory δελ ππάξρεη έηνηκν busbar type ζηα 440V. 

 

4.1.1.2. Οριςμόσ ιδανικόσ πηγόσ τϊςησ  
 

Δλ ζπλερεία, ζπλδέεηαη ζην δπγφ κηα πεγή ηάζεο ελαιιαζζφκελνπ ξεχκαηνο. ΢πγθεθξηκέλα, 

απφ ηελ εξγαιεηνζήθε επηιέγεηαη ην ζηνηρείν AC Voltage Source, παηψληαο ην εηθνλίδην 

.  Αλνίγνληαο ην παξάζπξν δηαιφγνπ ηεο πεγήο απηήο, ν ρξήζηεο ζέηεη σο Nominal Voltage 

→ Line-Line 0.44 kV. Σα ππφινηπα ζηνηρεία ηεο πεγήο δελ ηξνπνπνηνχληαη αθνχ ζεσξείηαη 

φηη ζην πιαίζην ηεο κειέηεο απηήο ε πεγή είλαη ηδαληθή. 

 

Ζ πεγή ηάζεο είλαη έλα ζηνηρείν (κηα ζπζθεπή) ην νπνίν παξέρεη ειεθηξηθή ελέξγεηα ζην 

θχθισκα. Πξαθηηθά νη πεγέο ηάζεο πξνζθέξνπλ ηάζε ζην θχθισκα. Οη πεγέο ηάζεο 

δηαθξίλνληαη ζε 2 θαηεγνξίεο: ηηο αλεμάξηεηεο θαη ηηο εμαξηεκέλεο. Ωο ηδαληθή αλεμάξηεηε 

πεγή ηάζεο, φπσο απηή πνπ κειεηάηαη ζην παξφλ δίθηπν, ζεσξείηαη ην ζηνηρείν πνπ ε ηηκή 

ηεο ηάζεο ζηα άθξα ηνπ είλαη αλεμάξηεηε απφ ην ξεχκα πνπ ην δηαξξέεη. Με άιια ιφγηα 

δειαδή, ε ηδαληθή πεγή ηάζεο έρεη κεδεληθή εζσηεξηθή αληίζηαζε. Ζ πξαγκαηηθή 

αλεμάξηεηε πεγή ηάζεο είλαη έλα ζηνηρείν δχν αθξνδεθηψλ πνπ απνηειείηαη απφ κηα ηδαληθή 

αλεμάξηεηε πεγή ηάζεο ζπλδεκέλε ζε ζεηξά κε έλαλ αληηζηάηε αληίζηαζεο R. 

 

4.1.1.3. Οριςμόσ φορτύου 
 

Αθνινχζσο, δεκηνπξγείηαη έλα ηξηθαζηθφ θνξηίν επαγσγηθνχ ηχπνπ. Απφ ηελ εξγαιεηνζήθε 

επηιέγεηαη ην ζηνηρείν General Load. Ο ρξήζηεο νξίδεη ηνλ ηχπν ηνπ θνξηίνπ σο εμήο: 

 Γηπιφ θιηθ ζην θνξηίν γηα λα αλνίμεη ην παξάζπξν δηαιφγνπ 

 Type → New Project Type → General Load Type (.TypLod) 

 Name: General Load Type 

 

Οη ππφινηπεο παξάκεηξνη ηνπ ηχπνπ ηνπ θνξηίνπ παξακέλνπλ σο έρνπλ, δειαδή: 

 Καξηέια Basic Data: System Type: AC, Technology: 3PH-„D‟ 

 Καξηέια Load Flow: ίδηνη ζπληειεζηέο θαη εθζέηεο 

 

΢ην παξάζπξν δηαιφγνπ ηνπ θνξηίνπ (.ElmLod) αθνινπζείηαη ε παξαθάησ δηαδηθαζία. 

 

Καξηέια Basic Data 

 

 Name: Load 
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Καξηέια Load Flow 

 

 Input Mode: P, cos(phi) 

 Balanced/Unbalanced: Balanced 

 Active Power: 0.03 MW 

 Power Factor: 0.85, inductive 

 

Όιεο νη ππφινηπεο παξάκεηξνη παξακέλνπλ σο έρνπλ (Δηθφλα 4.1). 

 

 
Εικόνα 4.1: Οξηζκόο παξακέηξωλ θνξηίνπ 

 

Πιένλ, ην δίθηπν πνπ ζρεδίαζε ν ρξήζηεο ζα πξέπεη λα είλαη φπσο θαίλεηαη ζηελ Δηθφλα 4.2. 
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Εικόνα 4.2: Γίθηπν ηδαληθήο πεγήο ηάζεο θαη θνξηίνπ 

 

4.1.1.4. Τπολογιςμόσ ροόσ ιςχύοσ 
 

Σν δίθηπν είλαη έηνηκν γηα λα πξαγκαηνπνηεζεί ν ππνινγηζκφο ξνήο θνξηίνπ. Απφ ηελ κπάξα 

θχξησλ εηθνληδίσλ, επηιέγεηαη ην Calculate Load Flow, νπφηε αλνίγεη θαη ην αληίζηνηρν 

παξάζπξν. Με ηηο default επηινγέο θαη ξπζκίζεηο ηνπ πξνγξάκκαηνο (δελ αιιάδεη ν ρξήζηεο 

θάπνηα παξάκεηξν), παηψληαο Execute πξαγκαηνπνηείηαη ε ξνή θνξηίνπ. ΢ηα πιαίζηα 

απνηειεζκάησλ ηνπ κνλνγξακκηθνχ δηαγξάκκαηνο εκθαλίδνληαη ηα ππνινγηζζέληα κεγέζε, 

φπσο ε ελεξγφο θαη άεξγνο ηζρχο, ην ξεχκα, ε θαηλφκελε ηζρχο, ε ηάζε (ζην δπγφ) θ.ιπ. 

(Δηθφλα 4.3), φπνπ ν ρξήζηεο κπνξεί λα πξνζζέζεη φπνηα κεγέζε επηζπκεί λα απεηθνλίδνληαη. 
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Εικόνα 4.3: Απνηειέζκαηα ππνινγηζκνύ ξνήο ηζρύνο 

 

 

4.1.2. Ιδανικό πηγό τϊςησ, μεταςχηματιςτόσ και φορτύο 
 

΢ε απηήλ ηελ πεξίπησζε, ηξνπνπνηείηαη ην δίθηπν ηεο πξνεγνχκελεο παξαγξάθνπ σο εμήο: 

πξνζηίζεηαη έλαο αθφκε δπγφο ζηα 220V θαη έλαο κεηαζρεκαηηζηήο ππνβηβαζκνχ ηεο ηάζεο 

κεηαμχ ησλ δχν δπγψλ. 

 

Ο ρξήζηεο κπνξεί ζε απηφ ην ζεκείν λα πξνζζέζεη έλα λέν grid ζην ππάξρνλ project. Απφ 

ηελ κπάξα ηνπ θχξηνπ κελνχ επηιέγεηαη Insert → Grid θαη φλνκα Source – Transformer – 

Load. Γεληθά, κία θαιή πξαθηηθή είλαη λα δεκηνπξγείηαη λέν grid θαηάιιειεο νλνκαζίαο γηα 

θάζε δίθηπν, ην νπνίν λα πξνζηίζεηαη ζηελ ίδηα study case. 

 

Αθνινπζείηαη αθξηβψο ε ίδηα δηαδηθαζία, φπσο θαη γηα ην πξνεγνχκελν δίθηπν, θαη 

ηνπνζεηνχληαη αξρηθά ε πεγή ηάζεο θαη ν δπγφο ησλ 440 V. ΢ηε ζπλέρεηα, ηνπνζεηείηαη ν 

λένο δπγφο. 

 

4.1.2.1. Οριςμόσ ζυγού 220V 
 

Ο ρξήζηεο νξίδεη ηνλ ηχπν ηνπ δπγνχ σο εμήο: 

 Γηπιφ θιηθ ζην δπγφ πξνθεηκέλνπ λα αλνίμεη ην παξάζπξν δηαιφγνπ 

 Type → New Project Type 

 Οξίδεηαη ην φλνκα ηνπ δπγνχ: BB 220V 

 Nominal Voltage: 0.22 kV 
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 Αθνχ θιείζεη ην παξάζπξν ηνπ Type, ζηελ θαξηέια Basic Data ν ρξήζεο νξίδεη έλα 

φλνκα π.ρ. Busbar low θαη εθ λένπ ζέηεη ην Nominal Voltage → Line-Line ζηα 0.22 

kV. 

 

4.1.2.2. Οριςμόσ μεταςχηματιςτό 
 

΢εηξά έρεη ν κεηαζρεκαηηζηήο. Απφ ηελ εξγαιεηνζήθε επηιέγεηαη ην ζηνηρείν 2-Winding-

Transformer. Αξρηθά, ζπλδέεηαη ε κία άθξε ηνπ ζηνλ επάλσ δπγφ (440V) θαη ε άιιε ζην 

δπγφ ησλ 220V. 

 

Ο ρξήζηεο νξίδεη ηα εμήο ζηνηρεία: 

 Type → New Project Type 

 ΢ην παξάζπξν πνπ αλνίγεη απηνκάησο (.TypTr2), ζηε θαξηέια Basic Data νξίδνληαη 

(Δηθφλα 4.4):  

- Name = 440/220 V Transformer  

- Rated Power: 0.05 MVA 

- Rated Voltage: HV-Side 0.44 kV, LV-Side 0.22 kV 

- Positive Sequence Impedance: Short-Circuit Voltage uk: 3%, Copper Losses: 0 

kW 

 Παηψληαο ΟΚ θιείλεη ην παξάζπξν .TypTr2 θαη ζην παξάζπξν .ElmTr2 ειέγρεηαη φηη 

νη ζπλδέζεηο ηνπ κεηαζρεκαηηζηή είλαη ζσζηέο. Δάλ δελ είλαη ζσζηέο θιείλνληαο ην 

παξάζπξν ζα εκθαληζηεί κήλπκα ιάζνπο, νπφηε ν ρξήζηεο ζα πξέπεη λα επηιέμεη Flip 

Connections. 

 

΢εκεηψλεηαη φηη δηαηεξήζεθαλ νη αξρηθέο ηηκέο γηα ηηο απψιεηεο ηνπ κεηαζρεκαηηζηή 

(Positive Sequence Impedance), δειαδή γηα ην ζπληειεζηή ηάζεο βξαρπθπθιψκαηνο θαη ηηο 

απψιεηεο ραιθνχ, γεγνλφο πνπ δελ επεξεάδεη ην ζθνπφ ηνπ παξαδείγκαηνο πξνο ην παξφλ. 

 

 
Εικόνα 4.4: Οξηζκόο ηύπνπ θαη παξακέηξωλ κεηαζρεκαηηζηή 
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΢ηε ζπλέρεηα, ζπλδέεηαη ην ηξηθαζηθφ θνξηίν ζην δπγφ ησλ 220V. Οη παξάκεηξνη ηνπ 

θνξηίνπ είλαη ίδηεο κε απηέο ηνπ πξψηνπ δηθηχνπ. Σν ηειηθφ δίθηπν παξνπζηάδεηαη ζηελ 

Δηθφλα 4.5. 

 

 
Εικόνα 4.5: Γίθηπν ηδαληθήο πεγήο ηάζεο, κεηαζρεκαηηζηή θαη θνξηίνπ 

 

4.1.2.3. Τπολογιςμόσ ροόσ ιςχύοσ 
 

΢ην ζεκείν απηφ, ην δίθηπν είλαη έηνηκν γηα ηνπο ππνινγηζκνχο. ΢εκεηψλεηαη φηη, εθφζνλ ν 

ρξήζηεο έρεη επηιέμεη λα ελζσκαηψζεη έλα λέν grid ζην ππάξρνλ project, θαιφ ζα ήηαλ λα 

«απελεξγνπνηήζεη» ην grid ηνπ πξψηνπ δηθηχνπ, πξνθεηκέλνπ νη ππνινγηζκνί λα γίλνληαη 

κφλν ζην grid πνπ εξγάδεηαη θάζε θνξά. ΢ε δηαθνξεηηθή πεξίπησζε, νπνηνζδήπνηε 

ππνινγηζκφο (Load Flow, Short Circuit, θ.ν.θ.) γίλεηαη ηαπηφρξνλα ζε φια ηα ελεξγά grid ηνπ 

project. Ζ απελεξγνπνίεζε ή ελεξγνπνίεζε ελφο grid γίλεηαη κε δεμί θιηθ ζην φλνκα ηνπ 

εθάζηνηε grid (ζην παξάζπξν πνπ βξίζθεηαη ζηα αξηζηεξά ηνπ παξαζχξνπ ζρεδίαζεο) θαη 

επηινγή deactivate ή activate αληίζηνηρα. 

 

Θα πξαγκαηνπνηεζνχλ δχν δηαθνξεηηθνί ππνινγηζκνί ξνήο θνξηίνπ. Αξρηθά, γίλεηαη ν 

ππνινγηζκφο Load Flow φπσο αθξηβψο θαη ζην πξψην δίθηπν κε ηηο default ξπζκίζεηο ηνπ 

PowerFactory. Σα απνηειέζκαηα πνπ αθνξνχλ ην θνξηίν θαίλνληαη ζηνλ Πίλαθα 4.1 πνπ 

αθνινπζεί. Δπίζεο, ζηελ Δηθφλα 4.6 δίλνληαη ηα απνηειέζκαηα ηνπ ππνινγηζκνχ ζε φιν ην 

δίθηπν. 

 

Φνξηίν 30 kW – Load Flow 1 

P (kW) 30 

Q (kVar) 18.6 

S (kVA) 35.301 

I (A) 93.713 

Πίλαθαο 4.1 



77 
 

 

 
Εικόνα 4.6: Τπνινγηζκόο ξνήο ηζρύνο ζηελ πξώηε πεξίπηωζε 

 

΢ηε ζπλέρεηα, ν ρξήζηεο αλνίγεη εθ λένπ ην παξάζπξν πνπ αθνξά ην Load Flow Calculation. 

΢ηελ θαξηέια Basic Options → Load Options επηιέγεηαη Consider Voltage Dependency of 

Loads, φπσο θαίλεηαη ζηελ Δηθφλα 4.7. 
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Εικόνα 4.7: Παξάζπξν ξπζκίζεωλ ππνινγηζκνύ Load Flow 

 

Σα απνηειέζκαηα πιένλ είλαη δηαθνξνπνηεκέλα (Πίλαθαο 4.2). Παξαηεξήζηε ηηο δηαθνξέο 

ηφζν ζην θνξηίν φζν θαη ζην δπγφ ησλ 220V θαη ζηα ππφινηπα ζηνηρεία (Δηθφλα 4.8). 

 

Φνξηίν 30 kW – Load Flow 2 

P (kW) 29.3 

Q (kVar) 18.2 

S (kVA) 34.509 

I (A) 91.587 

Πίλαθαο 4.2 
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Εικόνα 4.8: Τπνινγηζκόο ξνήο ηζρύνο ζηε δεύηεξε πεξίπηωζε 

 

΢ηελ πξαγκαηηθφηεηα, ε ηζρχο ελφο ζηαηηθνχ θνξηίνπ εμαξηάηαη απφ ηελ ηάζε. Ζ εμάξηεζε 

απηή ηεο ηζρχνο απφ ηελ ηάζε ιακβάλεηαη ππφςε φηαλ ν ρξεζηήο ελεξγνπνηεί ηελ επηινγή 

Consider Voltage Dependency of Loads θαηά ην Load Flow. Σν πξφγξακκα πξνζεγγίδεη ηελ 

ηζρχ (ελεξγφ θαη άεξγν) θάλνληαο ρξήζε ησλ παξαθάησ εμηζψζεσλ, νη νπνίεο ζπληζηνχλ ην 

γηλφκελν ηεο νλνκαζηηθήο ηζρχνο (δείθηεο 0) θαη ελφο παξάγνληα απνηεινχκελνπ απφ ηξεηο 

ζπληειεζηέο θαη ηξεηο αληίζηνηρνπο εθζέηεο: 

 
φπνπ  

P0: νλνκαζηηθή ελεξγφο ηζρχο ηνπ θνξηίνπ 

Q0: νλνκαζηηθή άεξγνο ηζρχο ηνπ θνξηίνπ 

v/v0: ιφγνο ηάζεσλ 

 

Ο ρξήζηεο έρεη ηε δπλαηφηεηα λα νξίζεη ηνπο ζπληειεζηέο ησλ εμηζψζεσλ απηψλ κέζα απφ 

ην παξάζπξν δηαιφγνπ ηνπ ηχπνπ ηνπ θνξηίνπ (.TypLod) ζηελ θαξηέια Load Flow. Γηα 

παξάδεηγκα, φηαλ νη εθζέηεο ησλ εμηζψζεσλ απηψλ θαηά ζεηξά ιάβνπλ ηηο ηηκέο 0, 1 θαη 2 
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(φπσο είλαη θαη νη default επηινγέο ηνπ πξνγξάκκαηνο), πξφθεηηαη γηα πεξίπησζε ζηαζεξήο 

ηζρχνο, ζηαζεξνχ ξεχκαηνο θαη ζηαζεξήο αληίζηαζεο, αληίζηνηρα. (Complex Load) 

 

4.1.2.4. Τπολογιςμόσ τϊςησ πηγόσ  
 

Έλα ελδηαθέξνλ εξψηεκα, ζην ππφ κειέηε δίθηπν, ζρεηίδεηαη κε ηελ εχξεζε ηεο ηάζεο ηεο 

ηδαληθήο πεγήο ψζηε ην θνξηίν λα θαηαλαιψλεη ηελ νλνκαζηηθή ηνπ ηζρχ ζηελ νλνκαζηηθή 

ηάζε. Πξνθεηκέλνπ λα δνζεί απάληεζε ζην εξψηεκα απηφ, ζα ηξνπνπνηεζνχλ νξηζκέλεο 

παξάκεηξνη ηνπ δηθηχνπ. 

 

Αξρηθά, ππνινγίδνπκε ηε βαζηθή αληίζηαζε ζηελ πιεπξά ρακειήο ηάζεο ηνπ 

κεηαζρεκαηηζηή: 

968.0
50000

2202


S

V
Zbase  

 

Αθνινχζσο, ζεσξνχκε φηη νη απψιεηεο ηζρχνο ζην κεηαζρεκαηηζηή είλαη αξθεηά πςειέο, 

ψζηε λα θαλεί θαιχηεξα ην απνηέιεζκα ηεο δηαδηθαζίαο. Τπνζέηνπκε φηη νη πςειέο 

απψιεηεο νθείινληαη απνθιεηζηηθά ζηελ αληίδξαζε ηνπ κεηαζρεκαηηζηή: 

    Ω 484.0968.05.0..

p.u. 0.5Xx

p.u. 0Rr

1

1







baseZupXX

 

 

Σν ξεχκα ζην θνξηίν ππνινγίδεηαη κέζσ ηεο νλνκαζηηθήο ηζρχνο θαη ηεο νλνκαζηηθήο ηάζεο 

σο εμήο: 

A 623.92

85.0
3

220
3

30000

cos3
cos3 













V

P
IIVP L

L  

 

Δθαξκφδνπκε ηηο ζρέζεηο ηάζεο-ξεχκαηνο ζε εκηηνληθή κφληκε θαηάζηαζε ζην 

κεηαζρεκαηηζηή, πξνθεηκέλνπ λα ππνινγίζνπκε ηελ απαηηνχκελε ηάζε ηεο ηδαληθήο πεγήο: 

     

   

   

  







V 196.14123.269
~

3
~~

V 196.143783.155V 1044.386336.150
~

1044.386165.23
3

220
7945.487281.78484.0

3

220

79.31623.92484.0
3

220~~~

,2,2,2

,2

22222





VVV

jV

jjj

jIjXREV

 

 

p.u. 1.22329p.u. 
440

246.538
V 246.538

~

V 196.14246.538
~

220

440~~

,1

,1,2,1









V

VVV

 

 

Ζ πξνεγνχκελε δηαδηθαζία θαηέιεμε ζηελ εχξεζε ηεο ηάζεο ηεο ηδαληθήο πεγήο ψζηε ην 

θνξηίν λα θαηαλαιψλεη ηελ νλνκαζηηθή ηνπ ηζρχ ζηελ νλνκαζηηθή ηάζε. Παξαηεξνχκε φηη 

απαηηείηαη κία αξθεηά κεγάιε αχμεζε ηεο ηάζεο ζηελ πεγή ψζηε λα ππεξθαιπθζνχλ νη 

πςειέο απψιεηεο ζην κεηαζρεκαηηζηή. Σα παξαπάλσ απνηειέζκαηα δίλεη κε κεγάιε 
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αθξίβεηα θαη ην PowerFactory, εθφζνλ ζέζνπκε ηάζε (Voltage, Magnitude) 1.22329 p.u. 

ζηελ θαξηέια Load Flow ηεο πεγήο, φπσο θαίλεηαη ζην δίθηπν κε ηα απνηειέζκαηα ζηελ 

Δηθφλα 4.9. 

 

 
Εικόνα 4.9: Τπνινγηζκόο ξνήο θνξηίνπ 

 

 

 

4.1.3. ΢ύγχρονη γεννότρια και φορτύο 
 

Σν ζπγθεθξηκέλν δίθηπν απνηειείηαη απφ κία ηξηθαζηθή ζχγρξνλε γελλήηξηα ηεζζάξσλ 

πφισλ πνπ ηξνθνδνηεί έλα θνξηίν, ζχκθσλα κε ηελ άζθεζε (3.1) ηνπ βηβιίνπ ηνπ 

πξνπηπρηαθνχ καζήκαηνο «Ζιεθηξνηερληθέο Δθαξκνγέο θαη Ζιεθηξνινγηθφ Δξγαζηήξην» 

[5]. 

 

4.1.3.1. Οριςμόσ ζυγού 
 

Σνπνζεηείηαη έλαο απιφο δπγφο (busbar). Ο ρξήζηεο νξίδεη ηνλ ηχπν ηνπ δπγνχ σο εμήο: 

 Γηπιφ θιηθ ζην δπγφ πξνθεηκέλνπ λα αλνίμεη ην παξάζπξν δηαιφγνπ 

 Type → New Project Type 

 Οξίδεηαη ην φλνκα ηνπ δπγνχ: BB 800V 

 Nominal Voltage: 0.8 kV 
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 Αθνχ θιείζεη ην παξάζπξν ηνπ Type, ζηελ θαξηέια Basic Data ν ρξήζεο νξίδεη έλα 

φλνκα π.ρ. Busbar θαη εθ λένπ ζέηεη ην Nominal Voltage → Line-Line ζηα 0.8 kV. 

 

4.1.3.2. Οριςμόσ ςύγχρονησ γεννότριασ 
 

΢ηε ζπλέρεηα, ζπλδέεηαη ζην δπγφ κία ζχγρξνλε γελλήηξηα, ρξεζηκνπνηψληαο ην ζηνηρείν 

Synchronous Machine ( ) απφ ηελ εξγαιεηνζήθε. ΢ην παξάζπξν δηαιφγνπ ηεο γελλήηξηαο 

ηίζεληαη ηα εμήο: 

 Name: Synchronous Machine 

 Type → New Project Type 

 

Καξηέια Basic Data 

 

 Name: Gen 500 kVA/800 V 

 Nominal Apparent Power: 0.5 MVA 

 Nominal Voltage: 0.8 kV 

 Power Factor: 0.85 

 Connection: Y 

 

Καξηέια Load Flow 

 

΢ην ζεκείν απηφ ζα αμηνπνηεζεί ε πιεξνθνξία γηα ηελ εζσηεξηθή αληίζηαζε ηεο γελλήηξηαο, 

ζχκθσλα κε ηελ νπνία L=10 mH/θάζε: 

p.u. 454369.2
28.1

10105022 3










s

base

sd X
Z

Lf
XX  

φπνπ 

Ω 28.1
500000

80022

 basebase Z
S

V
Z  

 

Θεσξείηαη φηη ε γελλήηξηα έρεη ξφηνξα θπιηλδξηθήο κνξθήο, νπφηε ε επαγσγηθή αληίδξαζε 

ηνπ εγθάξζηνπ άμνλα Xq είλαη θαηά πξνζέγγηζε ίζε κε ηελ αληίδξαζε επζέσο άμνλα: Xd=Xq. 

 

 

Καξηέια IEC 61363 

 

Γηα ιφγνπο πιεξφηεηαο, ρξεζηκνπνηνχκε θαη ηελ ηηκή R=0.01 Ω/θάζε, ε νπνία δίλεηαη σο 

πιεξνθνξία γηα ηελ εζσηεξηθή αληίζηαζε ηεο γελλήηξηαο, σο εμήο: 

p.u. 007813.0
28.1

01.0
 str

base

str R
Z

R
R  

 

΢ηε ζπλέρεηα, αθνχ θιείζεη ην παξάζπξν ηνπ Type, ζηελ θαξηέια Load Flow ν ρξήζεο 

νξίδεη ηα εμήο: 

 Δπηινγή Reference Machine 

 Input Mode: S, cos(phi) 

 Apparent Power: 0.5 MVA 

 Power Factor: 0.85, inductive 
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Όιεο νη ππφινηπεο παξάκεηξνη παξακέλνπλ σο έρνπλ (Δηθφλα 4.10). 

 

 
Εικόνα 4.10: Οξηζκόο παξακέηξωλ ζύγρξνλεο γελλήηξηαο 

 

Αμίδεη λα ηνληζηεί φηη ε ηάζε πνπ εκθαλίδεηαη ζην δίθηπν, θαηά ηνλ ππνινγηζκφ ηεο ξνήο 

θνξηίνπ, θαζνξίδεηαη απφ ηελ ηηκή ηεο ηάζεο ζην δπγφ θαη φρη απφ ηελ ηηκή ηεο ηάζεο ζηνλ 

ηχπν ηεο γελλήηξηαο. Απηφ δηφηη ε ηειεπηαία ηηκή είλαη ε νλνκαζηηθή ηηκή ηνπ ηχπνπ ηεο 

γελλήηξηαο, δειαδή απηή πνπ νξίδεηαη απφ ηνλ θαηαζθεπαζηή, φπσο θαη ηα ππφινηπα κεγέζε 

ζηνλ ηχπν. Αληίζεηα, ε ηηκή ηεο ηάζεο ζην παξάζπξν δηαιφγνπ ηνπ δπγνχ θαζνξίδεη ηελ 

εκθαληδφκελε ηάζε. Με ην ίδην ζθεπηηθφ, ε ηάζε ζηνλ ηχπν ηνπ δπγνχ δελ θαζνξίδεη ηελ 

εκθαληδφκελε ηάζε. 

 

4.1.3.3. Οριςμόσ φορτύου 
 

΢πλδέεηαη ην θνξηίν ζην δίθηπν. Απφ ηελ εξγαιεηνζήθε επηιέγεηαη ην ζηνηρείν General Load. 

Ο ρξήζηεο νξίδεη ηνλ ηχπν ηνπ θνξηίνπ σο εμήο: 

 Γηπιφ θιηθ ζην θνξηίν γηα λα αλνίμεη ην παξάζπξν δηαιφγνπ 

 Υξήζε ηνπ ππάξρνληνο ηχπνπ: Type → Select Project Type → General Load Type 

(TypLod) 

 

΢ην παξάζπξν δηαιφγνπ ηνπ θνξηίνπ (.ElmLod) αθνινπζείηαη ε παξαθάησ δηαδηθαζία. 
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Καξηέια Basic Data 

 

 Name: Load 

 

Καξηέια Load Flow 

 

 Input Mode: S, cos(phi) 

 Balanced/Unbalanced: Balanced 

 Active Power: 0.25 MW 

 Power Factor: 0.85, inductive 

 

Όιεο νη ππφινηπεο παξάκεηξνη παξακέλνπλ σο έρνπλ (Δηθφλα 4.11). 

 

 
Εικόνα 4.11: Οξηζκόο παξακέηξωλ θνξηίνπ 

 

Ζ κνξθή ηνπ ηειηθνχ δηθηχνπ παξνπζηάδεηαη ζηελ Δηθφλα 4.12. 
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Εικόνα 4.12: Γίθηπν ζύγρξνλεο γελλήηξηαο θαη θνξηίνπ 

 

4.1.3.4. Τπολογιςμόσ ροόσ ιςχύοσ 
 

΢ην ζεκείν απηφ, εθηειείηαη ν ππνινγηζκφο ξνήο θνξηίνπ ζην δίθηπν, πξνθεηκέλνπ λα 

δηαπηζησζνχλ ηα απνηειέζκαηα ηεο ηξνθνδφηεζεο ηνπ θνξηίνπ απφ ηε γελλήηξηα. ΢ηελ 

παξάγξαθν απηή δε ζα ρξεζηκνπνηεζεί ε επηινγή Consider Voltage Dependency of Loads, 

δηφηη ε ξνή θνξηίνπ πξνο ην ηξηθαζηθφ θνξηίν θαζνξίδεηαη απνθιεηζηηθά απφ ηα 

ραξαθηεξηζηηθά ηεο γελλήηξηαο. ΢ηα δχν πξνεγνχκελα δίθηπα, φπνπ ε ηξνθνδφηεζε 

πξαγκαηνπνηείηαη κέζσ κίαο ηδαληθήο πεγήο ηάζεο, ε ελ ιφγσ επηινγή επεξεάδεη ηα 

απνηειέζκαηα, επεηδή είλαη ην θνξηίν (κε ηα ραξαθηεξηζηηθά ηνπ) ν παξάγνληαο πνπ 

θαζνξίδεη ηε ξνή. ΢πλεπψο, ε επηινγή Consider Voltage Dependency of Loads γηα ηνλ 

ππνινγηζκφ ξνήο ηζρχνο δελ παίδεη ξφιν ζην ζπγθεθξηκέλν δίθηπν. Σα απνηειέζκαηα ηνπ 

ππνινγηζκνχ παξνπζηάδνληαη ζηελ Δηθφλα 4.13. 
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Εικόνα 4.13: Απνηειέζκαηα ππνινγηζκνύ ξνήο ηζρύνο 

 

4.1.3.5. Δημιουργύα διαγραμμϊτων ρευμϊτων ωσ προσ το χρόνο 
 

Σν PowerFactory παξέρεη ηε δπλαηφηεηα γξαθηθήο απεηθφληζεο νπνησλδήπνηε κεγεζψλ 

πξνθχπηνπλ απφ ηνπο ππνινγηζκνχο πνπ πεξηέρεη. Παξαθάησ παξνπζηάδεηαη ε δηαδηθαζία 

δεκηνπξγίαο δηαγξάκκαηνο ησλ ξεπκάησλ ησλ ηξηψλ θάζεσλ ηνπ θνξηίνπ σο πξνο ην ρξφλν. 

Πξφθεηηαη γηα θπκαηνκνξθέο εκηηνλνεηδνχο κνξθήο κε ζπγθεθξηκέλε δηαθνξά θάζεο κεηαμχ 

ηνπο. 

 

Αξρηθά, πξέπεη λα επηιεγνχλ νη επηζπκεηέο κεηαβιεηέο γηα απεηθφληζε ζην δηάγξακκα. Απηφ 

δηφηη ην πξφγξακκα δηαζέηεη κία πιεζψξα κεηαβιεηψλ πνπ φιεο κπνξνχλ λα απνζεθεπηνχλ 

θαη λα αλαιπζνχλ. Ωζηφζν, ε απνζήθεπζε φισλ ησλ κεηαβιεηψλ ζα απαηηνχζε πνιχ ρξφλν, 

ζα δέζκεπε ζεκαληηθφ κέξνο ηεο κλήκεο, παξάγνληαο ππεξβνιηθά κεγάια αξρεία 

απνηειεζκάησλ, θαη ζα θαζηζηνχζε πξαθηηθά δχζθνιν ηνλ εληνπηζκφ ηεο επηζπκεηήο 

κεηαβιεηήο. Γηα ηνπο ιφγνπο απηνχο, ζην PowerFactory αθνινπζείηαη ε πξαθηηθή επηινγήο 

ησλ κεηαβιεηψλ, νη νπνίεο πξφθεηηαη λα απνηειέζνπλ αληηθείκελν κειέηεο, πξηλ απφ ηελ 

εθηέιεζε ηνπ εθάζηνηε ππνινγηζκνχ. ΢ηελ πξνθεηκέλε πεξίπησζε καο ελδηαθέξεη ν 

ππνινγηζκφο RMS/EMT Simulation θαη ζπγθεθξηκέλα ε εμέηαζε ηεο ρξνληθήο εμέιημεο ησλ 

ξεπκάησλ ησλ ηξηψλ θάζεσλ ηνπ θνξηίνπ. 

 

Γηα ην ζθνπφ απηφ, απαηηείηαη ν ππνινγηζκφο ησλ αξρηθψλ ζπλζεθψλ κέζσ ησλ εμήο 

βεκάησλ: 
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 Calculation → RMS/EMT Simulation → Initial Conditions ψζηε λα αλνίμεη ην 

ζρεηηθφ παξάζπξν (Δηθφλα 4.14). 

 Simulation Method: Instantaneous Values (Electromagnetic Transients) γηαηί καο 

ελδηαθέξνπλ νη ζηηγκηαίεο ηηκέο. 

 Verify Initial Conditions: επηινγή 

 Automatic Step Adaptation: Παξφηη ζπκβάιιεη ζηελ ηαρχηεξε ζχγθιηζε ηνπ 

ππνινγηζκνχ, δελ επηιέγεηαη γηα λα είλαη πην νκαιέο νη θακπχιεο. 

 Execute 

 

 
Εικόνα 4.14: Τπνινγηζκόο αξρηθώλ ζπλζεθώλ 

 

Αθνινχζσο, επηιέγνληαη νη επηζπκεηέο κεηαβιεηέο γηα ην δηάγξακκα: 

 Γεμί θιηθ ζην θνξηίν ηνπ δηθηχνπ 

 Define → Results for RMS/EMT Simulation 

 ΢ην παξάζπξν Results πνπ αλνίγεη, δηπιφ θιηθ ζην ζηνηρείν Load (ζην αξηζηεξφ άθξν 

ηεο γξακκήο) 

 ΢ηελ θαξηέια EMT-Simulation: 

- Variable Set: Currents, Voltages and Powers 

- Bus Name: bus1:A 

- Δπηινγή κεηαβιεηήο I:bus1:A (Phase Current) θαη απνζήθεπζή ηεο κε ην θνπκπί 

, ψζηε λα πεξάζεη ζηε ζηήιε Selected Variables. 

- Bus Name: bus1:Β 
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- Δπηινγή κεηαβιεηήο I:bus1:Β (Phase Current) 

- Bus Name: bus1:C 

- Δπηινγή κεηαβιεηήο I:bus1:C (Phase Current) 

- OK ζην παξάζπξν επηινγήο κεηαβιεηψλ 

- Close ζην παξάζπξν απνηειεζκάησλ 

 

Οη επηιεγκέλεο κεηαβιεηέο γηα ηα ξεχκαηα ησλ ηξηψλ θάζεσλ ζα πξέπεη λα βξίζθνληαη ζηε 

ζηήιε Selected Variables (Δηθφλα 4.15) 

 

 
Εικόνα 4.15: Δπηινγή κεηαβιεηώλ γηα ην δηάγξακκα 

 

΢εκεηψλεηαη φηη ην παξάζπξν απνηειεζκάησλ κπνξεί λα εκθαληζηεί θαη κέζσ ηεο δηαδξνκήο 

Calculation → RMS/EMT Simulation → Result Variables. Δπίζεο, απφ ηελ κπάξα ησλ 

θχξησλ εηθνληδίσλ κπνξεί λα ελεξγνπνηεζεί ε κπάξα Stability κε ην θνπκπί , ην νπνίν 

ρξεζηκνπνηείηαη γηα άλνηγκα ηεο θαηάιιειεο ζεηξάο επηινγψλ, αλάινγα κε ηνλ απαηηνχκελν 

ππνινγηζκφ. Όπσο ζεκεηψζεθε ήδε, ζηελ πεξίπησζή καο πξφθεηηαη γηα ηνλ ππνινγηζκφ 

RMS/EMT Simulation. Ζ ζεηξά επηινγψλ δηαζέηεη θνπκπί γηα ππνινγηζκφ ησλ αξρηθψλ 

ζπλζεθψλ ( ), θαζψο θαη θνπκπί γηα έλαξμε ηεο πξνζνκνίσζεο ( ). 

 

Πξηλ απφ ηελ πξνζνκνίσζε, ζα δεκηνπξγεζεί ην δηάγξακκα γηα ηελ απεηθφληζε ησλ 

κεηαβιεηψλ: 

 Δπηιέγεηαη Insert → Virtual Instrument Panel, ψζηε λα δεκηνπξγεζεί λέα ζειίδα 

θαηάιιειε γηα δηαγξάκκαηα. 

 ΢ην παξάζπξν Append Vis, επηιέγεηαη ν ηχπνο ηνπ δηαγξάκκαηνο θαη ν ζρεηηθφο 

αξηζκφο: 

- Object: Subplot VisPlot 

- Number of VIs: 1 
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 Παηψληαο δηπιφ θιηθ νπνπδήπνηε κέζα ζην ρψξν ηνπ λένπ δηαγξάκκαηνο, αλνίγεη ην 

παξάζπξν δηαιφγνπ ηνπ δηαγξάκκαηνο, ψζηε λα θαζνξηζηνχλ νη κεηαβιεηέο ηνπ. 

 ΢ην πεδίν Curves ζην θάησ κέξνο ηνπ παξαζχξνπ, κε δηπιφ ζην πεδίν Element 

αλνίγεη ην παξάζπξν γηα ηελ επηινγή ηνπ ζηνηρείνπ ηνπ δηθηχνπ, ζην νπνίν αλήθνπλ 

νη επηζπκεηέο κεηαβιεηέο. ΢ηελ πξνθεηκέλε πεξίπησζε, επηιέγεηαη ην ζηνηρείν Load. 

 ΢ην πεδίν Variable, κε δηπιφ θιηθ επηιέγεηαη ε κεηαβιεηή m:I:bus1:A, δειαδή ην 

ξεχκα ηεο πξψηεο θάζεο. 

 Σα πεδία Colour, Style θαη Width θαζνξίδνπλ ην ρξψκα, ηνλ ηχπν θαη ην πάρνο ηεο 

θακπχιεο. 

 Παηψληαο δεμί θιηθ ζηνλ αξηζκφ ηεο γξακκήο πνπ θαζνξίζηεθε θαη επηιέγνληαο 

Append Row(s), πξνζηίζεηαη κία γξακκή γηα ηελ απεηθφληζε ελφο αθφκα κεγέζνπο. 

Με ηελ ίδηα δηαδηθαζία επηιέγεηαη ε κεηαβιεηή m:I:bus1:Β, δειαδή ην ξεχκα ηεο 

δεχηεξεο θάζεο. 

 Δηζάγεηαη λέα γξακκή θαη επηιέγεηαη ε κεηαβιεηή m:I:bus1:C. 

 Δπηβεβαηψλνληαη νη αιιαγέο (Δηθφλα 4.16) παηψληαο OK. 

 

 
Εικόνα 4.16: Δπηινγή θαζηθώλ ξεπκάηωλ γηα απεηθόληζε ζην δηάγξακκα ωο πξνο ην ρξόλν 

 

Ζ πξνζνκνίσζε κπνξεί, πιένλ, λα εθηειεζηεί: 

 Απφ ηελ κπάξα Stability επηιέγεηαη ην Start Simulation ( ). 

 Δπηιέγεηαη ρξφλνο πξνζνκνίσζεο 5 s. 

 Execute 
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Σν δηάγξακκα δείρλεη απνηειέζκαηα κεηά ηελ πξνζνκνίσζε. Με ηηο επηινγέο Scale x-Axes 

automatically ( ) θαη Scale y-Axes automatically ( ), πνπ βξίζθνληαη ζηελ κπάξα ηνπ 

παξαζχξνπ ησλ γξαθηθψλ, ε θιίκαθα ηνπ δηαγξάκκαηνο θαζνξίδεηαη απηφκαηα, ψζηε λα 

είλαη εκθαλείο νη θακπχιεο. Δπίζεο, κε ηηο επηινγέο Zoom x-Axis ( ) θαη Zoom y-Axis (

) κεγεζχλεηαη κία ζπγθεθξηκέλε πεξηνρή ηνπ δηαγξάκκαηνο. ΢ην κειεηψκελν δηάγξακκα, 

ε κνξθή ησλ θακππιψλ κεηά ηελ εθαξκνγή ηεο απηφκαηεο θιίκαθαο είλαη δπζδηάθξηηε. Γηα 

ην ιφγν απηφ, επηιέγεηαη ε κεγέζπλζε θαηά ηνλ άμνλα x, δειαδή ζε κία ζπγθεθξηκέλε 

ρξνληθή πεξίνδν. Σν δηάγξακκα ιακβάλεη ηε κνξθή ηεο Δηθφλαο 4.17, δειαδή ηε κνξθή 

ηξηψλ θπκαηνκνξθψλ κε ζπγθεθξηκέλε δηαθνξά θάζεο. Με ηελ επηινγή Scale x-Axes 

automatically ην δηάγξακκα κπνξεί λα επαλέιζεη ζηελ αξρηθή ηνπ κνξθή. 

 

 
Εικόνα 4.17: Γξαθηθή απεηθόληζε ρξνληθήο εμέιημεο ηωλ ξεπκάηωλ ηωλ ηξηώλ θάζεωλ ηνπ θνξηίνπ 

 

Οη θακπχιεο ησλ ξεπκάησλ ησλ ηξηψλ θάζεσλ αθνξνχλ ηηο ζηηγκηαίεο ηηκέο. Δληνχηνηο, 

ππάξρεη ε δπλαηφηεηα ππνινγηζκνχ ησλ ελεξγψλ (RMS) ηηκψλ. Κάηη ηέηνην απαηηεί ηελ 

θαηάιιειε επηινγή θαηά ηνλ ππνινγηζκφ ησλ αξρηθψλ ζπλζεθψλ: 

 Απφ ηελ κπάξα Stability επηιέγεηαη ην Calculate Initial Conditions ( ). 

 Simulation Method: RMS Values (Electromechanical Transients) 

 Network Representation: Unbalanced, 3-Phase (ABC) 

 Execute 

 

Καηφπηλ, εθηειείηαη θαη πάιη ε πξνζνκνίσζε γηα 5 s, φπσο θαη πξνεγνπκέλσο. Σν δηάγξακκα 

απεηθνλίδεη ηψξα κία επζεία παξάιιειε ζηνλ άμνλα ηνπ ρξφλνπ, δειαδή κία ζπγθεθξηκέλε 

ηηκή ξεχκαηνο. Ζ ηηκή απηή είλαη ε RMS ηηκή ηνπ ξεχκαηνο, είλαη ίδηα θαη γηα ηηο ηξεηο 

θάζεηο ηνπ θνξηίνπ (εθφζνλ νη θαζηζέηεο ησλ ξεπκάησλ ησλ θάζεσλ έρνπλ ην ίδην κέηξν θαη 
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δηαθέξνπλ σο πξνο ηε γσλία ηνπο) θαη ζπκπίπηεη κε ηελ ηηκή πνπ αλαθέξεηαη ζην πιαίζην 

απνηειεζκάησλ ηνπ θνξηίνπ ζην κνλνγξακκηθφ δηάγξακκα (Δηθφλα 4.13). Σν ηειεπηαίν 

κπνξεί λα δηαπηζησζεί κέζσ κεγέζπλζεο θαηά ηνλ άμνλα y (Δηθφλα 4.18). 

 

 
Εικόνα 4.18: Γξαθηθή απεηθόληζε ηεο RMS ηηκήο ηωλ ξεπκάηωλ ηωλ ηξηώλ θάζεωλ ηνπ θνξηίνπ 

 

 

4.1.4. ΢ύγχρονη γεννότρια και ςύγχρονοσ κινητόρασ 
 

Σν ζπγθεθξηκέλν δίθηπν απνηειείηαη απφ κία ηξηθαζηθή ζχγρξνλε γελλήηξηα ηεζζάξσλ 

πφισλ πνπ ηξνθνδνηεί έλα ζχγρξνλν θηλεηήξα, ζχκθσλα κε ηελ άζθεζε (3.2) ηνπ βηβιίνπ 

ηνπ πξνπηπρηαθνχ καζήκαηνο «Ζιεθηξνηερληθέο Δθαξκνγέο θαη Ζιεθηξνινγηθφ 

Δξγαζηήξην» [5]. 

 

Αθνινπζείηαη ε ίδηα δηαδηθαζία, φπσο απηή πνπ εθηέζεθε ζηελ παξάγξαθν 4.1.3, 

πξνθεηκέλνπ λα ηνπνζεηεζεί έλα ίδηνο δπγφο ησλ 800 V. 

 

4.1.4.1. Οριςμόσ ςύγχρονησ γεννότριασ 
 

Γηα ηε ζχγρξνλε γελλήηξηα ηνπ δηθηχνπ ρξεζηκνπνηνχληαη ηα ίδηα ζηνηρεία κε απηά ηεο 

πξνεγνχκελεο γελλήηξηαο (500 kVA, 800 V), κε ηε δηαθνξά φηη κεηαβάιιεηαη ν ζπληειεζηήο 

ηζρχνο ζε 0.8. Γηα ην ιφγν απηφ, δεκηνπξγείηαη λένο ηχπνο γελλήηξηαο κε δηαθνξεηηθφ φλνκα 

(π.ρ. Gen 500 kVA/800 V (2)), ψζηε λα κε ραζεί ν πξνεγνχκελνο ηχπνο. 

 

Δπίζεο, κεηαβάιιεηαη ε εζσηεξηθή αληίζηαζε ηεο γελλήηξηαο σο εμήο: 
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p.u. 945243.2
28.1

10125022 3










s

base

sd X
Z

Lf
XX  

φπνπ 

Ω 28.1
500000

80022

 basebase Z
S

V
Z  

 

p.u. 015625.0
28.1

02.0
 str

base

str R
Z

R
R  

 

΢ηελ θαξηέια Load Flow ηνπ αξρηθνχ παξαζχξνπ δηαιφγνπ ρξεζηκνπνηνχληαη νη ίδηεο ηηκέο 

θαη επηινγέο, φπσο απηέο πνπ δίλνληαη ζηελ Δηθφλα 4.10, κε αιιαγή ηνπ ζπληειεζηή ηζρχνο 

ζε 0.8. 

 

4.1.4.2. Οριςμόσ ςύγχρονου κινητόρα 
 

Δπηιέγεηαη ην ζηνηρείν Synchronous Machine ( ) απφ ηελ εξγαιεηνζήθε, πξνθεηκέλνπ λα 

δεκηνπξγεζεί ν ζχγρξνλνο θηλεηήξαο. ΢ην παξάζπξν δηαιφγνπ ηνπ ζηνηρείνπ, κέζσ ηεο 

επηινγήο Motor ζην ρψξν ηνπ Generator/Motor θαζνξίδεηαη ε ιεηηνπξγία ηεο κεραλήο σο 

θηλεηήξαο (Δηθφλα 4.19). Αθνινχζσο, έρνπκε ηα εμήο βήκαηα: 

 Name: Synchronous Motor 

 Type → New Project Type 

 

 
Εικόνα 4.19: Δπηινγή ηξόπνπ ιεηηνπξγίαο γηα ηε ζύγρξνλε κεραλή 

 

Καξηέια Basic Data 

 

 Name: Motor 400 kVA/800 V 

 Nominal Apparent Power: 0.4 MVA 

 Nominal Voltage: 0.8 kV 

 Power Factor: 0.8 

 Connection: Y 
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Καξηέια Load Flow 

 

Με βάζε ηηο ηηκέο ηεο εθθψλεζεο ηεο άζθεζεο γηα ηελ εζσηεξηθή αληίζηαζε ηνπ θηλεηήξα, 

έρνπκε: 

p.u. 681554.3
28.1

10155022 3










s

base

sd X
Z

Lf
XX  

φπνπ 

Ω 28.1
500000

80022

 basebase Z
S

V
Z  

 

Ζ επαγσγηθή αληίδξαζε ηνπ εγθάξζηνπ άμνλα Xq είλαη θαηά πξνζέγγηζε ίζε κε ηελ 

αληίδξαζε επζέσο άμνλα: Xd=Xq 

 

Καξηέια IEC 61363 

 

p.u. 007813.0
28.1

01.0
 str

base

str R
Z

R
R  

 

Αθνχ θιείζεη ην παξάζπξν ηνπ Type, ζηελ θαξηέια Load Flow ν ρξήζεο νξίδεη ηα εμήο: 

 Input Mode: S, cos(phi) 

 Apparent Power: 0.415692 MVA 

 Power Factor: 0.8, inductive 

 

Ζ ηηκή ηεο απαίηεζεο γηα ηε θαηλφκελε ηζρχ ηνπ ζχγρξνλνπ θηλεηήξα θαζνξίδεηαη κε βάζε 

ηελ απαίηεζε ηεο άζθεζεο, ζηελ νπνία βαζίδεηαη ην ππφ κειέηε δίθηπν, γηα απνξξφθεζε 

ξεχκαηνο 300 Α απφ ηνλ θηλεηήξα κε ηάζε 800 V θαη ζπληειεζηή ηζρχνο 0.8 επαγσγηθφ. Ζ 

ιχζε ηνπ ελ ιφγσ πξνβιήκαηνο δίλεηαη ζηελ παξάγξαθν 4.2.4, απφ φπνπ πξνθχπηεη ε 

παξαθάησ ηηκή ηεο κηγαδηθήο ηζρχνο. Όιεο νη ππφινηπεο παξάκεηξνη παξακέλνπλ σο έρνπλ 

(Δηθφλα 4.20). 
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Εικόνα 4.20: Οξηζκόο παξακέηξωλ ζύγρξνλνπ θηλεηήξα 

 

΢ηε βάζε ησλ παξαπάλσ, ην δίθηπν ζα πξέπεη λα είλαη φπσο ζηελ Δηθφλα 4.21. 
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Εικόνα 4.21: Γίθηπν ζύγρξνλεο γελλήηξηαο θαη ζύγρξνλνπ θηλεηήξα 

 

4.1.4.3. Τπολογιςμόσ ροόσ ιςχύοσ 
 

Μπνξεί, πιένλ, λα πξαγκαηνπνηεζεί ν ππνινγηζκφο ηεο ξνήο θνξηίνπ ζην δίθηπν. ΢ρεηηθά κε 

ηελ επηινγή Consider Voltage Dependency of Loads, ηζρχνπλ νη ίδηεο παξαηεξήζεηο πνπ 

εθηέζεθαλ ζηελ ππνπαξάγξαθν 4.1.3.4. Σα απνηειέζκαηα ηνπ ππνινγηζκνχ 

πεξηιακβάλνληαη ζηελ παξαθάησ εηθφλα ηνπ δηθηχνπ (Δηθφλα 4.22). 
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Εικόνα 4.22: Απνηειέζκαηα ππνινγηζκνύ ξνήο ηζρύνο 

 

Παξαηεξείηαη κία ππεξθφξησζε (103.9%) ηνπ ζχγρξνλνπ θηλεηήξα, γεγνλφο πνπ νθείιεηαη 

ζηελ απαίηεζε γηα θαηλφκελε ηζρχ ίζε κε 415.692 kVA, ηε ζηηγκή πνπ ε νλνκαζηηθή 

θαηλφκελε ηζρχο ηνπ θηλεηήξα (ζηνλ νξηζκφ ηνπ ηχπνπ) είλαη 400 kVA. 

 

  



97 
 

4.2. Θεωρητικού υπολογιςμού δικτύων ηλεκτρικόσ ενϋργειασ 
 

΢ηελ παξνχζα ελφηεηα πξαγκαηνπνηνχληαη νη ππνινγηζκνί γηα ηα δίθηπα ησλ παξαγξάθσλ 

4.1.3. θαη 4.1.4. πνπ ζρεδηάζηεθαλ ζηελ πξνεγνχκελε ελφηεηα, κε βάζε ην γλσζηφ 

ζεσξεηηθφ ππφβαζξν γηα ηελ εχξεζε βαζηθψλ κεγεζψλ, φπσο είλαη ε ηζρχο, ην ξεχκα θαη ε 

ηάζε. Με απηφλ ηνλ ηξφπν, ζα εμεηαζηνχλ ηα απνηειέζκαηα ηνπ ππνινγηζκνχ ξνψλ θνξηίνπ 

ηνπ PowerFactory. 

 

 

4.2.1. ΢ύγχρονη γεννότρια και φορτύο 
 

Γηα ην θνξηίν είλαη γλσζηή ε ηξηθαζηθή κηγαδηθή ηζρχο ηνπ θαζψο θαη ν ζπληειεζηήο ηζρχνο, 

δειαδή: 

𝑆 3𝜑 = 250 𝑘𝑉𝐴 

𝑐𝜊𝑠𝜑 = 0.85 
 

Ηζρχνπλ, επίζεο, ηα εμήο: 

S 3φ = P3φ + jQ3φ =  S 3φ cosφ + j S 3φ sinφ 

sinφ =  1 − cos2φ = 0.5268 

 

Έηζη, πξνθχπηνπλ ε ελεξγφο θαη ε άεξγνο ηζρχο ηνπ θνξηίνπ κέζσ ησλ ζρέζεσλ πνπ 

αθνινπζνχλ: 

P3φ =  S 3φ cosφ = 250 ∙ 0.85 = 212.5 kW 

Q3φ =  S 3φ sinφ = 250 ∙ 0.5268 = 131.7 kVAr  

 

Σν θνξηίν απηφ είλαη θαη ην κνλαδηθφ πνπ ηξνθνδνηεί ε γελλήηξηα ηνπ δηθηχνπ. Γηα απηφ ην 

ιφγν, ηα παξαπάλσ κεγέζε δίλνπλ θαη ηελ παξαγφκελε ηζρχ ηεο γελλήηξηαο ε νπνία ζα είλαη 

κηθξφηεξε απφ ηελ νλνκαζηηθή ηεο ηηκή.  

 

Σν ξεχκα αλά θάζε ηνπ θνξηίνπ, κε δεδνκέλε ηελ πνιηθή ηάζε ζηα άθξα ηνπ 𝑉 𝜑 =

800 𝑉∟0⁰, δίλεηαη απφ ηε ζρέζε: 

Ι φ =  
S 3φ

 3∙V φ
 

∗

=
212.5−j131.7

 3∙800
∙ 103A = 153.4 − j95

A

φάση
= 180.43∟-31.8⁰ A/θάζε 

 

 

4.2.2. ΢ύγχρονη γεννότρια και ςύγχρονοσ κινητόρασ 
 

Αξρηθά, ππνινγίδνπκε ηηο αληηδξάζεηο ηεο γελλήηξηαο θαη ηνπ θηλεηήξα, κε βάζε ηα ζηνηρεία 

γηα ηηο εζσηεξηθέο αληηζηάζεηο ηνπο: 

XG = 2πfLG = 2π ∙ 50 ∙ 12 ∙ 10−3 = 3.7699 Ω 

XΜ = 2πfLΜ = 2π ∙ 50 ∙ 15 ∙ 10−3 = 4.7124 Ω 
φπνπ XG, XM είλαη νη αληηδξάζεηο ηεο γελλήηξηαο θαη ηνπ θηλεηήξα αληίζηνηρα. 

 

Σν ξεχκα πνπ εμέξρεηαη απφ ηε γελλήηξηα (ίζν κε ην ξεχκα πνπ απνξξνθά ν θηλεηήξαο) είλαη 

ζχκθσλα κε ηα δεδνκέλα: 

Ι AG = Ι AM = 300∟−cos−1 0.8 = 300∟ − 36.87° Α 
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Δθαξκφδνληαο ην λφκν ηάζεσλ ηνπ Kirchhoff πξνθχπηνπλ νη ΖΔΓ ησλ ζχγρξνλσλ κεραλψλ, 

ζχκθσλα κε ηηο εμηζψζεηο πνπ αθνινπζνχλ: 

Ε G = V + Ι AG ∙ (RG + jXG ) 
Ε M = V − Ι AM ∙ (RM + jXM ) 

φπνπ 

𝛦 𝐺 : ΖΔΓ ηεο γελλήηξηαο 

𝛦 𝛭 : ΖΔΓ ηνπ θηλεηήξα. 

𝑉 =
800

 3
 𝑉: θαζηθή ηάζε 

Σα ππφινηπα κεγέζε είλαη γλσζηά ή έρνπλ ππνινγηζηεί παξαπάλσ. Έηζη, πξνθχπηνπλ ηα 

παξαθάησ απνηειέζκαηα ζε πνιηθέο ζπληεηαγκέλεο (Πίλαθαο 4.3). Απφ ηηο παξαπάλσ 

εμηζψζεηο δίλεηαη ε θαζηθή ηάζε. Λφγσ ζπλδεζκνινγίαο αζηέξα, ε πνιηθή πξνθχπηεη 

πνιιαπιαζηάδνληαο ην απνηέιεζκα κε  3. 

 

Απνηειέζκαηα ππνινγηζκώλ γηα ηε γελλήηξηα θαη ηνλ θηλεηήξα 

Μέγεζνο Γελλήηξηα Κηλεηήξαο 

ΖΔΓ θαζηθή (V) 1457.3 1194.2 

ΖΔΓ πνιηθή (V) 2524.1 2068.4 

Γσλία (deg) 38.2 109 

Πίλαθαο 4.3 

 

Ζ κηγαδηθή ηξηθαζηθή ηζρχο (ελεξγφο θαη άεξγνο), ηελ νπνία απνδίδεη ε γελλήηξηα ζηνλ 

θηλεηήξα, δίλεηαη απφ ηελ εμίζσζε: 

𝑆 3𝜑 =  3 ∙ 𝑉 𝜋𝜊𝜆 ∙ 𝛪 𝐴𝐺
∗

=  3 ∙ 800 ∙ 300∟36.87° = 415692.194∟36.87° VA =  

= 332.553 + j 249.416 VA 

΢πλεπψο, ηζρχεη φηη P = 332.553 kW θαη Q = 249.416 kVAr. 

 

Ο θηλεηήξαο απνξξνθά ηελ ηζρχ απηή πνπ παξέρεηαη απφ ηε γελλήηξηα θαη ζηνλ άμνλά ηνπ 

απνδίδεη ηζρχ (αγλννχληαη νη εζσηεξηθέο απψιεηεο ηξηβψλ, αλεκηζκνχ θ.ιπ.) πνπ δίλεηαη απφ 

ηε ζρέζε:  

Re  3 ∙ E M,πολ ∙ Ι AM
∗
 = 889.667 kW 
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4.3. ΢ύγκριςη αποτελεςμϊτων PowerFactory και 
θεωρητικών υπολογιςμών 

 
΢ηνπο Πίλαθεο 4.4 θαη 4.5 πνπ αθνινπζνχλ γίλεηαη ε ζχγθξηζε ζεσξεηηθψλ απνηειεζκάησλ 

θαη ησλ αληίζηνηρσλ ηηκψλ ηνπ πξνγξάκκαηνο, γηα ηα δίθηπα ηεο ελφηεηαο 4.1.3 θαη 4.1.4 

 

΢ύγθξηζε απνηειεζκάησλ - Γίθηπν 4.1.3 

Μεγέζε Θεσξεηηθνί ππνινγηζκνί PowerFactory 

P (kW) 212.5 212.5 

Q (kVAr) 131.7 131.7 

I (A) 180.430 180.422 

Πίλαθαο 4.4 

 

 

΢ύγθξηζε απνηειεζκάησλ - Γίθηπν 4.1.4 

Μεγέζε Θεσξεηηθνί ππνινγηζκνί PowerFactory 

P (kW) 332.553 332.6 

Q (kVAr) 249.416 249.4 

S (kVA) 415.692 415.692 

Πίλαθαο 4.5 
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ΚΕΥΑΛΑΙΟ 5 
 

Προςομούωςη εκκύνηςησ επαγωγικού κινητόρα 
πραγματικού δικτύου πλούου 

 
5.1. Εκκύνηςη κινητόρων και πτώςη τϊςησ 

 
΢ε θάζε πινίν ρξεζηκνπνηνχληαη δεθάδεο αζχγρξνλνη θηλεηήξεο γηα δηάθνξνπο ζθνπνχο. 

Έηζη, ππάξρνπλ θηλεηήξεο πνπ θηλνχλ αληιίεο (έξκαηνο, λεξνχ, θαπζίκσλ, ιηπαληηθψλ), 

ζπκπηεζηέο θχξηαο κεραλήο (main air compressors), δηάθνξεο θηεξσηέο ή αλεκηζηήξεο 

εμαεξηζκνχ θ.α. Γηα θάζε θηλεηήξα ππάξρεη πάλσ ζην πινίν εγθαηεζηεκέλνο έλαο πίλαθαο – 

ην ιεγφκελν starter panel – γηα ηελ εθθίλεζε ή ηελ παχζε ηεο ιεηηνπξγίαο ηνπ θηλεηήξα. 

Έλαο ηέηνηνο πίλαθαο θαίλεηαη ζηελ Δηθφλα 5.1. Οη πίλαθεο απηνί ρξεηάδνληαη ηαθηηθφ 

έιεγρν θαη ζπληήξεζε γηα ηελ ζσζηή θαη απξνβιεκάηηζηε ιεηηνπξγία ηνπο. 

 

 
Εικόνα 5.1: Πίλαθαο εθθίλεζεο θηλεηήξα 

 

΢ηελ Δηθφλα 5.2 θαίλεηαη ην «θνπηί» ζπλδέζεσλ ελφο επαγσγηθνχ θηλεηήξα πινίνπ. 
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Εικόνα 5.2: «Κνπηί» ζπλδέζεωλ επαγωγηθνύ θηλεηήξα 

 

Καηά ηελ εθθίλεζε ελφο θηλεηήξα, ην ξεχκα παίξλεη πνιχ κεγαιχηεξεο ηηκέο ζε ζρέζε κε ην 

ξεχκα κφληκεο ιεηηνπξγίαο ηνπ θηλεηήξα θαη ζπγθεθξηκέλα είλαη 5 κε 6 θνξέο κεγαιχηεξν. 

Σν ξεχκα παξακέλεη πςειφ κέρξηο φηνπ ν θηλεηήξαο επηηχρεη ηελ νλνκαζηηθή ηνπ ηαρχηεηα. 

Απηφ κπνξεί λα δηαξθέζεη απφ κεξηθά δεπηεξφιεπηα κέρξη θαη έλα ιεπηφ. Σν απνηέιεζκα 

είλαη ε πηψζε ηάζεο εθείλε ηε ζηηγκή ζην δίθηπν ηνπ πινίνπ (θάηη πνπ κπνξεί λα γίλεη 

αληηιεπηφ ι.ρ. απφ ηα θψηα πνπ «ηξεκνπαίδνπλ»). Σα ραξαθηεξηζηηθά ηεο πηψζεο ηάζεο 

ζπλδένληαη άκεζα κε ηα ραξαθηεξηζηηθά ηνπ θηλεηήξα πνπ εθθηλεί, φπσο ην κέγεζφο ηνπ, ε 

κέζνδνο εθθίλεζεο, ην θνξηίν θ.α. Δπηπιένλ, ην κέγεζνο ηεο πηψζεο εμαξηάηαη άκεζα απφ 

ηηο παξακέηξνπο ηνπ ειεθηξηθνχ ζπζηήκαηνο ηνπ πινίνπ. Ζ δηάξθεηα ηεο πηψζεο ηάζεο 

εμαξηάηαη θαηά θχξην ιφγν απφ ηε ξνπή αδξάλεηαο ηνπ θηλεηήξα, ελψ κπνξεί λα κεγαιψζεη 

εάλ θαη άιινη θηλεηήξεο είλαη ζπλδεκέλνη ζηνλ ίδην δπγφ. [6] 

 

Πέξα απφ ηνπο ζπλεζηζκέλνπο ηξφπνπο εθθίλεζεο θηλεηήξσλ είηε κε απεπζείαο ζχλδεζε ζην 

δίθηπν ηνπ πινίνπ (αθνξά κηθξήο ηζρχνο θηλεηήξεο) είηε κε δηαθφπηε αζηέξα-ηξηγψλνπ πνπ 

κεηψλεη ζεκαληηθά ην ξεχκα εθθίλεζεο, ππάξρνπλ ζχγρξνλεο κέζνδνη γηα ηελ απνθπγή 

κεγάισλ πηψζεσλ ηάζεο φπσο ε εθθίλεζε κε απηνκεηαζρεκαηηζηή, εθθίλεζε κε 

απηνκεηαζρεκαηηζηή θαη ππθλσηή θαη ε ρξήζε νκαιψλ εθθηλεηψλ (soft starters).  
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5.2. Μοντελοπούηςη εκκύνηςησ κινητόρα πλούου ςτο 
περιβϊλλον του PowerFactory 

 
΢ε απηήλ ηελ ελφηεηα ζα πξαγκαηνπνηεζεί ε πξνζνκνίσζε ελφο πξαγκαηηθνχ αζχγρξνλνπ 

θηλεηήξα πινίνπ θαη ζα ζπγθξηζνχλ ηα απνηειέζκαηα κε ηα αληίζηνηρα ζεσξεηηθά. 

 

Ο θηλεηήξαο πνπ επηιέρζεθε αλήθεη ζε πινίνπ ηχπνπ bulk carrier θαη αθνξά ηελ αληιία 

έξκαηνο (ballast pump motor). ΢ε ηέηνηνπ είδνπο πινία απηνί νη θηλεηήξεο είλαη νη 

κεγαιχηεξνη (πάλσ απφ 100 kW ζπλήζσο), εθφζνλ δελ ππάξρνπλ πιεπξηθνί πξνσζηήξηνη 

κεραληζκνί (thrusters), κε ζπλέπεηα θαηά ηελ εθθίλεζε ηνπο λα παξαηεξείηαη ε κεγαιχηεξε 

πηψζε ηάζεο ιφγσ ηνπ αξρηθνχ ξεχκαηνο ζε ζρέζε κε ηνπο ππφινηπνπο θηλεηήξεο. Σα 

δηαζέζηκα ραξαθηεξηζηηθά ηνπ ελ ιφγσ θηλεηήξα δίλνληαη ζηνλ Πίλαθα 1 θαη αθνξνχλ ηελ 

ιεηηνπξγία ηνπ ζηελ νλνκαζηηθή ηζρχ. 

 

Υαξαθηεξηζηηθά αληιίαο έξκαηνο ζην 100% ηνπ θνξηίνπ 

Voltage (V) 440 

Frequency (Hz) 60 

Nominal Power (kW) 110 

Speed (rpm) 1766 

Poles 4 

I (A) 168 

cosθ 0.92 

Efficiency (%) 93.5 

Slip 1.89 

Starting current (A) 1030 

Πίλαθαο 5.1 

 

5.2.1. ΢χεδιαςμόσ του δικτύου τησ αντλύασ ϋρματοσ 
 

Αθνινπζεί ε δηαδηθαζία κνληεινπνίεζεο ελφο απινπνηεκέλνπ δηθηχνπ γηα ηελ πξνζνκνίσζε 

εθθίλεζεο. 

 

Αξρηθά ν ρξήζηεο δεκηνπξγεί ζην πεξηβάιινλ ηνπ PowerFactory έλα λέν project κε ηνλ 

ηξφπν πνπ έρεη πεξηγξαθεί ζην θεθάιαην 2. ΢ην λέν grid πνπ αλνίγεη, ηνπνζεηείηαη πξψηα 

έλαο απιφο δπγφο (busbar). 

 

5.2.1.1. Οριςμόσ ζυγού 
 

Ο ρξήζηεο νξίδεη ηνλ ηχπν ηνπ δπγνχ σο εμήο: 

 Γηπιφ θιηθ ζην δπγφ πξνθεηκέλνπ λα αλνίμεη ην παξάζπξν δηαιφγνπ 

 Type → New Project Type 

 Οξίδεηαη ην φλνκα ηνπ δπγνχ: BB 440V 

 Nominal Voltage: 0.44 kV 

 Αθνχ θιείζεη ην παξάζπξν ηνπ Type, ζηελ θαξηέια Basic Data ν ρξήζεο νξίδεη έλα 

φλνκα π.ρ. Busbar θαη εθ λένπ ζέηεη ην Nominal Voltage → Line-Line ζηα 0.44 kV. 
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΢ηε ζπλέρεηα ζην δπγφ ζπλδέεηαη ην ζηνηρείν Grid  απφ ηελ εξγαιεηνζήθε πνπ 

ππνθαζηζηά νπζηαζηηθά ην δίθηπν ειεθηξηθήο ελέξγεηαο ηνπ πινίνπ. Οη ξπζκίζεηο γηα ην 

ζηνηρείν Grid παξακέλνπλ φπσο είλαη πξνεπηιεγκέλεο απφ ην ινγηζκηθφ. 

 

5.2.1.2. Οριςμόσ επαγωγικού κινητόρα 
 

Δπηιέγεηαη ην ζηνηρείν Asynchronous Machine  απφ ηελ εξγαιεηνζήθε, πξνθεηκέλνπ λα 

δεκηνπξγεζεί ν αζχγρξνλνο θηλεηήξαο. 

΢ην παξάζπξν δηαιφγνπ ηνπ ζηνηρείνπ, κέζσ ηεο επηινγήο Motor ζην πεδίν ηνπ 

Generator/Motor θαζνξίδεηαη ε ιεηηνπξγία ηεο κεραλήο σο θηλεηήξαο. Αθνινχζσο, έρνπκε 

ηα εμήο βήκαηα: 

 Name: 110kW 

 Type → New Project Type 
 

΢ην λέν παξάζπξν δηαιφγνπ πνπ αλνίγεη απηνκάησο (.ΣypAsmo), ξπζκίδνληαη αξρηθά νη 

παξάκεηξνη ηνπ θηλεηήξα ζηελ θαξηέια Load Flow.  

 

Καξηέια Load Flow 

 

Καζψο ηα ζηνηρεία απηά (επαγσγηθέο αληηδξάζεηο, αληηζηάζεηο θιπ) δελ ήηαλ δηαζέζηκα γηα 

ηνλ ελ ιφγσ θηλεηήξα, ζέηνληαη ηα αληίζηνηρα ζηνηρεία πνπ νξίδεη ην πξφηππν IEC 61363 [7] 

γηα ηνπο θηλεηήξεο άλσ ησλ 100 kW γηα ηε κειέηε κεηαβαηηθψλ θαηλνκέλσλ. Έηζη (Δηθφλα 

5.3): 

 

 Rs = 0.034 p.u. 

 Xs = 0.075 p.u. 

 Xm = 4 p.u. 

 RrA = 0.021 p.u. 

 XrA = 0.075 p.u. 
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Εικόνα 5.3: Οξηζκόο παξακέηξωλ επαγωγηθνύ θηλεηήξα ζηελ θαξηέια Load Flow 

 

Καξηέια Basic Data (Δηθφλα 5.4) 

 

 Name: Pump Motor 

 Rated Voltage: 0.44 kV 

 Input Mode: Slip-Torque/Current Characteristic  

 Rated Mechanical Power: 110 kW 

 Rated Power Factor: 0.92 

 Efficiency at nominal Operation: 93.5 

 Nominal Frequency: 60 Hz 

 Nominal Speed: 1766 rpm 

 Number of Pole Pairs: 2 

 Connection: D 
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Εικόνα 5.4: Οξηζκόο παξακέηξωλ επαγωγηθνύ θηλεηήξα ζηελ θαξηέια Basic Data 

 

΢ρεηηθά κε ηελ ξνπή αδξάλεηαο ηνπ θηλεηήξα, ιφγσ έιιεηςεο ζηνηρείσλ ηνπ θαηαζθεπαζηή, 

ζεσξήζεθε ηππηθή ηηκή ηεο ηάμεο ησλ 2.3 Kg·m
2
 ζχκθσλα κε ζηνηρεία απφ ην δηαδίθηπν. 

΢πλεπψο, ν ρξήζηεο ζηελ Καξηέια RMS-Simulation ζέηεη: 

 

Καξηέια RMS-Simulation 

 

 Inertia: 2.3 Kg·m2 
 

Αθνχ θιείζεη ην παξάζπξν δηαιφγνπ ηνπ Type, ζην γεληθφ παξάζπξν δηαιφγνπ ηνπ θηλεηήξα 

(.ElmAsm), ζηελ θαξηέια Load Flow ηίζεηαη Active Power = 0.11 MW, φπσο είλαη ε 

νλνκαζηηθή ηζρχο ηνπ θηλεηήξα. ΢ηελ θαξηέια RMS-Simulation (.ElmAsm) κπνξεί λα 

θαζνξηζηεί ην κεραληθφ θνξηίν ηνπ θηλεηήξα πνπ ζηελ πεξίπησζε απηή είλαη κηα αληιία. 

Οη αληιίεο, πνπ ρξεζηκνπνηνχληαη θαηά θφξνλ θαη ζε ζπλεξγαζία κε ειεθηξηθφ θηλεηήξα, 

αλπςψλνπλ θάπνην ξεπζηφ (ζαιαζζηλφ, γιπθφ ή πφζηκν λεξφ, θαχζηκα, ιχκαηα θ.ν.θ., ζηελ 

πξνθεηκέλε πεξίπησζε ζαιάζζην έξκα) κε ζπγθεθξηκέλν εηδηθφ βάξνο, θαηά καλνκεηξηθφ 

χςνο, κε κία ζηαζεξή παξνρή. Οη πιένλ ρξεζηκνπνηνχκελεο αληιίεο είλαη νη θπγνθεληξηθέο 

κε θχξην ραξαθηεξηζηηθφ ηνπο ην φηη ε απαηηνχκελε ξνπή ζηξέςεο είλαη αλάινγε ηνπ 

ηεηξαγψλνπ ηεο ηαρχηεηαο πεξηζηξνθήο [8]. ΢πλεπψο, ε κειεηψκελε αληιία έρεη 

ραξαθηεξηζηηθή θακπχιε ξνπήο ηεο κνξθήο 2nT  , φπσο είλαη θαη ε πξνεπηινγή ηνπ 

πξνγξάκκαηνο (Proportional factor=1, Exponent=2). Ζ ξνπή αδξάλεηαο ηεο αληιίαο δε 

ιακβάλεηαη ππφςε ζε απηήλ ηελ πξνζνκνίσζε.  

Σν δίθηπν πνπ ζρεδηάζηεθε, ζχκθσλα κε ηα παξαπάλσ, ζα πξέπεη λα είλαη φπσο θαίλεηαη 

ζηελ Δηθφλα 5.5 πνπ αθνινπζεί.  
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Εικόνα 5.5: Γίθηπν γηα ηελ πξνζνκνίωζε εθθίλεζεο θηλεηήξα 
 

 

5.2.2. Τπολογιςμόσ εκκύνηςησ κινητόρα 
 

΢ε απηφ ην ζεκείν ζα πξαγκαηνπνηεζεί ν ππνινγηζκφο ηνπ motor starting ζην πεξηβάιινλ 

ηνπ PowerFactory. Ο ρξήζηεο επηιέγεη ηνλ θηλεηήξα θαη κε δεμί θιηθ απφ ην κελνχ πνπ 

αλνίγεη: 

 CalculateMotor Starting.  
 

Απηνκάησο αλνίγεη έλα λέν παξάζπξν ξπζκίζεσλ θαη επηινγψλ γηα ηελ εθθίλεζε θηλεηήξα 

(Δηθφλα 5.6). Ο ρξήζηεο ζα πξέπεη ζε απηφ ην ζεκείν λα επηιέμεη ηνλ θηλεηήξα γηα ηνλ νπνίν 

ζα πξαγκαηνπνηεζεί ε πξνζνκνίσζε. Δπηιέγνληαο ην βειάθη  δίπια απφ ην Motor(s), 

επηιέγεηαη ν θηλεηήξαο απφ ην λέν παξάζπξν πνπ αλνίγεη. ΢ηε ζπλέρεηα νξίδεηαη ην 

Simulation Time ζηα 5 sec θαη επηιέγεηαη ην Execute.  
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Εικόνα 5.6: Παξάζπξν ξπζκίζεωλ εθθίλεζεο θηλεηήξα 

 

Καζψο «ηξέρεη» ε πξνζνκνίσζε απηφκαηα δεκηνπξγνχληαη δπν λέεο θαξηέιεο κε ηα 

δηαγξάκκαηα πνπ αθνξνχλ ηηο παξακέηξνπο ηεο εθθίλεζεο, φπσο ην ξεχκα, ε ηάζε, ε ξνπή 

ηνπ θηλεηήξα, νη ζηξνθέο ιεηηνπξγίαο θιπ.  

 

΢ην παξάζπξν απνηειεζκάησλ ηνπ θηλεηήξα, κε δεμί θιηθ θαη επηιέγνληαο Edit Format for 

Edge Elements ν ρξήζηεο έρεη ηε δπλαηφηεηα λα επηιέμεη λα εκθαλίδεηαη θαη ην ξεχκα 

εθθίλεζεο φπσο θαίλεηαη θαη ζηελ Δηθφλα 5.7, ζχκθσλα κε ηελ δηαδηθαζία πνπ έρεη 

πεξηγξαθεί θαη ζε πξνεγνχκελα θεθάιαηα ηεο παξνχζαο εξγαζίαο.  
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Εικόνα 5.7: Δπηινγή παξακέηξωλ πνπ εκθαλίδνληαη ζην παξάζπξν απνηειεζκάηωλ ηνπ θηλεηήξα 

 

5.3. ΢ύγκριςη αποτελεςμϊτων PowerFactory και 
πραγματικών τιμών 

 
΢ε απηή ηελ ελφηεηα παξνπζηάδνληαη ηα απνηειέζκαηα απφ ηελ πξνζνκνίσζε εθθίλεζεο ηνπ 

θηλεηήξα. Σα δηαγξάκκαηα πνπ θαίλνληαη ζηηο εηθφλεο πνπ αθνινπζνχλ  δείρλνπλ ηελ πηψζε 

ηάζεο πνπ παξαηεξείηαη θαηά ηελ εθθίλεζε θαζψο θαη ην ξεχκα  ηνπ θηλεηήξα θαηά ηε 

δηάξθεηα ηεο πξνζνκνίσζεο. (Δηθφλεο 5.8, 5.9). Δπίζεο, απφ ην παξάζπξν αλαθνξάο (Output 

Window) θαίλεηαη φηη ε εθθίλεζε ηνπ θηλεηήξα ήηαλ επηηπρήο, ελψ ν ρξφλνο εθθίλεζεο θαηά 

πξνζέγγηζε ήηαλ 0.573 sec. ΢ηνλ Πίλαθα 2 δίλνληαη ηα απνηειέζκαηα. Σν ξεχκα εθθίλεζεο 

είλαη πεξίπνπ 6 θνξέο κεγαιχηεξν απφ ην ξεχκα θαλνληθήο ιεηηνπξγίαο, φπσο αλακελφηαλ. 

 

΢ύγθξηζε απνηειεζκάησλ 

Μέγεζνο Θεσξεηηθά ΢ηνηρεία PowerFactory Απόθιηζε 

Starting Current (A) 1030 1078 4.7% 

Steady State Current (A) 168 158 6% 

Starting power factor - 0.348 - 

Successful Start yes yes - 

Aprox. Starting time 

(sec) 
- 0.573 - 

Πίλαθαο 5.2 
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Εικόνα 5.8: Ρεύκα θηλεηήξα θαηά ηε δηάξθεηα ηεο πξνζνκνίωζεο 

 

 
Εικόνα 5.9: Πηώζε ηάζεο 

 

Αλαθνξηθά κε ην ραξαθηεξηζκφ ηεο εθθίλεζεο ηνπ θηλεηήξα σο επηηπρνχο, ην πξφγξακκα 

αθνινπζεί ην εμήο θξηηήξην γηα αζχγρξνλνπο θηλεηήξεο [9]: 

Πξαγκαηηθή ηαρχηεηαΟλνκαζηηθή ηαρχηεηα – Οιίζζεζε, 

φπνπ 

Πξαγκαηηθή ηαρχηεηα: ε ηηκή ηεο κεηαβιεηήο s:speed 

Οιίζζεζε: ε ηηκή ηεο κεηαβιεηήο t:aslkp 
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Οη απνθιίζεηο ησλ ππνινγηζκψλ απφ ηα αληίζηνηρα ζεσξεηηθά ζηνηρεία (Πίλαθαο 2) κπνξνχλ 

λα απνδνζνχλ ζε κηα ζεηξά απφ παξακέηξνπο, φπσο ην γεγνλφο φηη ηα ζηνηρεία γηα ηηο 

αληηζηάζεηο θαη επαγσγηθέο αληηδξάζεηο ηνπ ξφηνξα θαη ηνπ ζηάηε δελ ήηαλ δηαζέζηκα, 

νπφηε έγηλε ρξήζε ηππηθψλ ηηκψλ ζχκθσλα κε ην πξφηππν IEC 61363-1 [7] γηα θηλεηήξεο 

άλσ ησλ 100 kW.  Δπηπξνζζέησο, δε ιακβάλνληαη ππφςε ηα αθξηβή ραξαθηεξηζηηθά ηνπ 

κεραληθνχ θνξηίνπ ηνπ θηλεηήξα, φπσο ε ραξαθηεξηζηηθή θακπχιε ιεηηνπξγίαο ηνπ θαη ε 

ξνπή αδξάλεηαο, ελψ είλαη νπζηαζηηθά άγλσζηε θαη ε αθξηβήο ξνπή αδξάλεηαο ηνπ ίδηνπ ηνπ 

θηλεηήξα, πνπ φπσο αλαθέξζεθε θαη ζηελ αξρή ηνπ παξφληνο θεθαιαίνπ, επεξεάδεη άκεζα 

ηελ δηάξθεηα ηεο πηψζε ηάζεο.  

 

΢εκείωζε: ΢ηελ θαξηέια RMS-Simulation (.ElmAsm) ηνπ θηλεηήξα, ν ρξήζηεο έρεη ηε 

δπλαηόηεηα λα επηιέμεη ηε κέζνδν εθθίλεζεο από ηελ αληίζηνηρε ελόηεηα Motor Starting. 

Δπηιέγνληαο ηε κέζνδν αζηέξα-ηξηγώλνπ γηα παξάδεηγκα κπνξεί λα παξαηεξήζεη ηηο δηαθνξέο  

ζην ξεύκα εθθίλεζεο, ην νπνίν κεηώλεηαη. 
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ΚΕΥΑΛΑΙΟ 6 
 

ΜΕΛΕΣΗ ΡΟΩΝ ΥΟΡΣΙΟΤ ΢Ε ΠΡΑΓΜΑΣΙΚΟ 
ΔΙΚΣΤΟ ΠΛΟΙΟΤ  

 
΢ε απηφ ην θεθάιαην πξαγκαηνπνηείηαη ν ζρεδηαζκφο θαη ε κειέηε ξνήο θνξηίνπ ελφο 

πξαγκαηηθνχ δηθηχνπ πινίνπ θαη ζπγθεθξηκέλα δεμακελφπινηνπ ην νπνίν δηαζέηεη θαη 

πιεπξηθνχο πξνσζηήξηνπο κεραληζκνχο (bow & stern thrusters).  

 

΢ηνλ Πίλαθα 6.1 αλαθέξνληαη ηα βαζηθά ραξαθηεξηζηηθά ησλ ηεζζάξσλ ειεθηξνγελλεηξηψλ 

ηνπ πινίνπ. 

Βαζηθά ραξαθηεξηζηηθά ειεθηξνγελλεηξηψλ 

 
Πίλαθαο 6.1 

 

΢ηνλ Πίλαθα 6.2 (α, β, γ, δ) δίλνληαη ην είδνο ησλ θηλεηήξσλ πνπ απνηεινχλ ην δίθηπν, ν 

αξηζκφο ηνπο, ε ηζρχο εμφδνπ, ν βαζκφο απφδνζεο, ε ηζρχο εηζφδνπ θαη ν ζπληειεζηήο 

ιεηηνπξγίαο. Με θφθθηλν ρξψκα επηζεκαίλνληαη νη θηλεηήξεο πνπ νκαδνπνηνχληαη ζην δπγφ 

ησλ 440V, κε πξάζηλν ρξψκα νη θηλεηήξεο ζην δπγφ ησλ 6600V θαη κε θίηξηλν νη θηλεηήξεο 

πνπ νκαδνπνηνχληαη ζηα 220V.  
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΢ηνηρεία θηλεηήξσλ 

 
Πίλαθαο 6.2α 
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΢ηνηρεία θηλεηήξσλ 

 
Πίλαθαο 6.2β 
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΢ηνηρεία θηλεηήξσλ 

 
Πίλαθαο 6.2γ 
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΢ηνηρεία θηλεηήξσλ 

 
Πίλαθαο 6.2δ 

 

΢ην δπγφ πςειήο ηάζεο ησλ 6.6kV ελζσκαηψλνληαη νη γελλήηξηεο (4), νη πξνσζηήξηνη 

κεραληζκνί θαη ε αληιία θνξηίνπ (cargo pump) μερσξηζηά. Οη θηλεηήξεο απηνί είλαη νη 

κεγαιχηεξνη-απφ άπνςε ηζρχνο-ζην δίθηπν πνπ κειεηάηαη. Γηα φινπο ηνπο ππφινηπνπο 

θηλεηήξεο έγηλε νκαδνπνίεζε ζε αληίζηνηρνπο ηζνδχλακνπο θηλεηήξεο. Έηζη ζηνπο δπγνχο 

ησλ 440V θαη 220V ζα ζπλδεζνχλ 2 ηζνδχλακνη θηλεηήξεο ζηνλ θαζέλα. Σν πινίν δηαζέηεη 

θπζηθά θαη γελλήηξηα έθηαθηεο αλάγθεο, σζηφζν ζηηο θαηαζηάζεηο πνπ κειεηψληαη θαη 
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δίλνληαη παξαθάησ, ε γελλήηξηα απηή δελ ζπκκεηέρεη θαη σο εθ ηνχηνπ δελ 

ζπκπεξηιακβάλεηαη.  

 

Λφγσ έιιεηςεο επηκέξνπο ζηνηρείσλ γηα ηνπο δηάθνξνπο θαηαλαισηέο θαη θηλεηήξεο, ε 

νκαδνπνίεζε έγηλε κε βάζε ηα ζηνηρεία απφ ην πξνπηπρηαθφ κάζεκα «Δλεξγεηαθά 

΢πζηήκαηα Πινίνπ» ηνπ 8
νπ

 εμακήλνπ ηεο ζρνιήο ΝΜΜ ΔΜΠ. Αθφκε, επηκέξνπο 

παξάκεηξνη ησλ θηλεηήξσλ, κεηαζρεκαηηζηψλ θαη γελλεηξηψλ πνπ απαξηίδνπλ ην δίθηπν θαη 

δελ ήηαλ δηαζέζηκνη (φπσο ζπληειεζηέο ηζρχνο θ.α.) ειήθζεζαλ βάζεη ηππηθψλ ηηκψλ απφ 

αληίζηνηρεο εγθαηαζηάζεηο πινίσλ θαη απφ ην πξφηππν IEC 61363 (γηα ηνπο θηλεηήξεο).  

 

Ζ κειέηε ξνήο θνξηίνπ ζα πξαγκαηνπνηεζεί γηα ηηο εμήο 3 θαηαζηάζεηο: 

 

 Κατάςταςη κανονικήσ πορείασ (Normal Sea Going) 

 Κατάςταςη χειριςμών  (Port In/Out) 

 Κατάςταςη εκφόρτωςησ (Unloading) 

 

6.1. ΢χεδιαςμόσ δικτύου ςτο PowerFactory 
 

Αξρηθά ν ρξήζηεο νξίδεη έλα λέν project φπσο έρεη πεξηγξαθεί ζε πξνεγνχκελα Κεθάιαηα 

ηεο παξνχζαο.  

 

 

6.1.1. Ζυγόσ 6600V 
 
Οξηζκόο δπγνύ 

 

Σνπνζεηείηαη έλα ζχζηεκα δπγνχ κε δηαθφπηε (Single Busbar System With Tie Breaker), 

επηιέγνληαο ην εηθνλίδην  απφ ηελ εξγαιεηνζήθε. Έηζη ν θχξηνο δπγφο «ρσξίδεηαη» ζε 2 

επηκέξνπο ηκήκαηα πνπ ελψλνληαη κε έλα δηαθφπηε. ΢ε θάζε έλα ηκήκα ινηπφλ νξίδνληαη ηα 

εμήο: 

 Γηπιφ θιηθ ζην δπγφ πξνθεηκέλνπ λα αλνίμεη ην παξάζπξν δηαιφγνπ 

 Type → New Project Type 

 Οξίδεηαη ην φλνκα ηνπ δπγνχ: BB 6600V 

 Nominal Voltage: 6.6kV 

 Αθνχ θιείζεη ην παξάζπξν ηνπ Type, ζηελ θαξηέια Basic Data ν ρξήζεο νξίδεη έλα 

φλνκα π.ρ. No. 1 HV switchboard (γηα ην δεμί ηκήκα)/(No. 2 HV switchboard γηα ην 

2
ν
 ηκήκα αξηζηεξά) θαη εθ λένπ ζέηεη ην Nominal Voltage → Line-Line ζηα 6.6 kV. 

 

 

Οξηζκόο ζύγρξνλσλ γελλεηξηώλ 

 

΢ε θάζε ηκήκα ηνπ θχξηνπ δπγνχ ζπλδένληαη 2 γελλήηξηεο, κηα ησλ 4300 kW θαη κηα ησλ 

3300 kW, 4 ζην ζχλνιν. Ζ δηαδηθαζία νξηζκνχ είλαη αθξηβψο ε ίδηα γηα θάζε κηα γελλήηξηα. 

Έηζη επηιέγεηαη ην εηθνλίδην ηεο ζχγρξνλεο κεραλήο  απφ ηελ εξγαιεηνζήθε θαη κε δηπιφ 

θιηθ αλνίγεη απηνκάησο ην παξάζπξν δηαιφγνπ.  

΢ην παξάζπξν δηαιφγνπ ηεο γελλήηξηαο ηίζεληαη ηα εμήο (ε παξέλζεζε δίλνληαη ηα αληίζηνηρα 

ζηνηρεία γηα ηνλ δεχηεξν ηχπν γελλήηξηαο): 
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 Name: DG1/(DG2) 

 Type → New Project Type 
 

Καξηέια Basic Data 

 

 Name: Gen 3300kW/(Gen 4300kW) 

 Nominal Apparent Power: 3.8824 MVA/(5.0588 MVA) 

 Nominal Voltage: 6.6 kV 

 Power Factor: 0.85 

 Connection: YN 
 

΢ηε ζπλέρεηα, αθνχ θιείζεη ην παξάζπξν ηνπ Type, ζηελ θαξηέια Load Flow ν ρξήζεο 

νξίδεη ηα εμήο: 

 

 Input Mode: P, cos(phi) 

 Active Power: 3.3 MW/(4.3 MW) 

 Power Factor: 0.85, inductive 

 Voltage: 1 p.u. 
 

Με απηφ ηνλ ηξφπν ζηνλ δπγφ No. 1 HV switchboard γηα παξάδεηγκα ν ρξήζηεο ζπλδέεη ηηο 2 

απφ ηηο 4 ζπλνιηθά γελλήηξηεο. Δπηιέγνληαο ηηο 2 γελλήηξηεο ηαπηφρξνλα (κε ην Ctrl) θαη 

θάλνληαο δεμί θιηθ ζε κηα απφ απηέο, επηιέγεη Copy. ΢ηε ζπλέρεηα κε δεμη θιηθ κέζα ζην grid 

θαη επηιέγνληαο Paste , κπνξεί λα «αληηγξάςεη» ηηο 2 απηέο γελλήηξηεο ζην δπγφ No. 2 HV 

switchboard ρσξίο λα ρξεηάδεηαη λα ηηο νξίζεη απφ ηελ αξρή. Με απηφ ηνλ ηξφπν ζπλδένληαη 

ινηπφλ θαη νη 4 γελλήηξηεο ηνπ δηθηχνπ.  

 

Οξηζκόο αζύγρξνλσλ θηλεηήξσλ 

 

΢ην δπγφ απηφ ζα ζπλδεζνχλ ηα thrusters θαζψο θαη ε αληιία θνξηίνπ. Σν πινίν πνπ 

κειεηάηαη δηαζέηεη 5 thrusters ζην ζχλνιν. Σα ζηνηρεία ηνπο είλαη ηα εμήο: 

1. Bow azimuth thruster (1 set): 2500kW 

2. Bow tunnel thruster (2 sets): 2200kW 

3. Stern azimuth thruster (1 set): 2500kW 

4. Stern tunnel thruster (1 set): 2200kW 

 

Ζ αληιία θνξηίνπ (cargo oil pump) είλαη ηεο ηάμεο ησλ 2000 kW.  

΢ην ηκήκα No. 1 HV switchboard ζα ζπλδεζεί ε αληιία θνξηίνπ, έλα Bow tunnel thruster έλα 

Stern tunnel thruster.  

 

Αληιία θνξηίνπ 

 

Δπηιέγεηαη ην ζηνηρείν Asynchronous Machine απφ ηελ εξγαιεηνζήθε. Αθνινχζσο έρνπκε ηα 

εμήο βήκαηα: 

 

 Name: Cargo oil pump 

 Type → New Project Type 
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Καξηέια Basic Data (.TypAsmo) 

 

 Name: Motor 2000 kW 

 Rated Voltage: 6.6 kV 

 Input Mode: Electrical Parameter 

 Power Rating → Rated Mechanical Power: 2000 kW 

 Nominal Frequency: 60 Hz 

 No of Pole Pairs: 1  

 Connection: D 
 

 

Καξηέια Load Flow (.TypAsmo) 

 

 Rs = 0.034 p.u. 

 Xs = 0.075 p.u. 

 Xm = 1.568 p.u. (προκειμένου ο ςυντελεςτήσ ιςχφοσ να προςεγγίςει την τιμή 0.75 
όπωσ φαίνεται ςτην καρτέλα Basic Data) 

 RrA = 0.021 p.u. 

 XrA = 0.075 p.u. 
  

΢ε απηή ηε θάζε δελ ξπζκίδεηαη θάπνηα άιιε παξάκεηξνο γηα ηελ αληιία.  

 

Bow tunnel thruster 

 

Οκνίσο, επηιέγεηαη ην ζηνηρείν Asynchronous Machine απφ ηελ εξγαιεηνζήθε. 

 

 Name: No. 1 bow tunnel thruster 

 Type → New Project Type 
 

Καξηέια Basic Data (.TypAsmo) 

 

 Name: Motor 2200 kW 

 Rated Voltage: 6.6 kV 

 Input Mode: Electrical Parameter 

 Power Rating → Rated Mechanical Power: 2200 kW 

 Nominal Frequency: 60 Hz 

 No of Pole Pairs: 1  

 Connection: D 
 

Καξηέια Load Flow (.TypAsmo) 

 

 Rs = 0.034 p.u. 

 Xs = 0.075 p.u. 

 Xm = 1.568 p.u.  

 RrA = 0.021 p.u. 

 XrA = 0.075 p.u. 
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Stern tunnel thruster 

 

 Name: No. 5 stern tunnel thruster 

 Type → New Project Type 
 

Καξηέια Basic Data (.TypAsmo) 

 

 Name: Motor 2200 kW 

 Rated Voltage: 6.6 kV 

 Input Mode: Electrical Parameter 

 Power Rating → Rated Mechanical Power: 2200 kW 

 Nominal Frequency: 60 Hz 

 No of Pole Pairs: 1  

 Connection: D 
 

Καξηέια Load Flow (.TypAsmo) 

 

 Rs = 0.034 p.u. 

 Xs = 0.075 p.u. 

 Xm = 1.568 p.u.  

 RrA = 0.021 p.u. 

 XrA = 0.075 p.u. 
 

΢ην ηκήκα No. 2 HV switchboard ηνπ δπγνχ ζπλδένληαη κε φκνην ηξφπν ηα ππφινηπα 3 

thrusters. Οη επηκέξνπο παξάκεηξνη είλαη ίδηνη ζηελ θαξηέια Load Flow (.TypAsmo) ελψ ην 

κφλν πνπ αιιάδεη είλαη ην φλνκα θάζε θηλεηήξα θαη ε νλνκαζηηθή ηζρχο ζχκθσλα κε ηα 

ζηνηρεία πνπ δφζεθαλ γηα θάζε πξνσζηήξην κεραληζκφ παξαπάλσ.  

 

 

 

6.1.2. Ζυγόσ 440V 
 

Με ηνλ ίδην αθξηβψο ηξφπν φπσο θαη ζηνλ δπγφ ησλ 6600 kV: 

 

Οξηζκόο δπγνύ 

 

Σνπνζεηείηαη έλα ζχζηεκα δπγνχ κε δηαθφπηε (Single Busbar System With Tie Breaker), 

επηιέγνληαο ην εηθνλίδην  απφ ηελ εξγαιεηνζήθε. Έηζη ν δπγφο «ρσξίδεηαη» ζε 2 

επηκέξνπο ηκήκαηα πνπ ελψλνληαη κε έλα δηαθφπηε. ΢ε θάζε έλα ηκήκα ινηπφλ νξίδνληαη ηα 

εμήο: 

 Γηπιφ θιηθ ζην δπγφ πξνθεηκέλνπ λα αλνίμεη ην παξάζπξν δηαιφγνπ 

 Type → New Project Type 

 Οξίδεηαη ην φλνκα ηνπ δπγνχ: BB 440V (θαη ζηα 2 ηκήκαηα) 

 Nominal Voltage: 0.44kV 

 Αθνχ θιείζεη ην παξάζπξν ηνπ Type, ζηελ θαξηέια Basic Data ν ρξήζεο νξίδεη έλα 

φλνκα π.ρ. No. 1 LV switchboard (γηα ην δεμί ηκήκα)/(No. 2 LV switchboard γηα ην 2
ν
 

ηκήκα αξηζηεξά) θαη εθ λένπ ζέηεη ην Nominal Voltage → Line-Line ζηα 0.44 kV. 
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Οξηζκόο ηζνδύλακσλ θηλεηήξσλ 

 

Βάζεη ηεο νκαδνπνίεζεο ησλ επηκέξνπο θηλεηήξσλ επηιέρζεθε ν ηζνδχλακνο θηλεηήξαο πνπ 

πξνέθπςε λα πινπνηεζεί ζε 2 ίδηνπο θηλεηήξεο ηζρχνο 987.15 kW ν θαζέλαο (έλαο γηα θάζε 

πιεπξά ηνπ δπγνχ). 

 Name: 440 V equiv. motor 1/(440 V equiv. motor 2) 

 Type → New Project Type 
 

Καξηέια Basic Data (.TypAsmo) 

 

 Name: Motor 987.15 kW 

 Rated Voltage: 0.44 kV 

 Input Mode: Electrical Parameter 

 Power Rating → Rated Mechanical Power: 987.15 kW 

 Nominal Frequency: 60 Hz 

 No of Pole Pairs: 1  

 Connection: D 
 

Καξηέια Load Flow (.TypAsmo) 

 

 Rs = 0.034 p.u. 

 Xs = 0.075 p.u. 

 Xm = 1.568 p.u.  

 RrA = 0.021 p.u. 

 XrA = 0.075 p.u. 
 

Με Copy/Paste ζπλδέεηαη ν ίδηνο θηλεηήξαο θαη ζηελ άιιε πιεπξά ηνπ δπγνχ (π.ρ. ζην No. 2 

LV switchboard)  

 

 

6.1.3. Ζυγόσ 220V 
 

Ζ ίδηα αθξηβψο ινγηθή αθνινπζείηαη θαη ζην δπγφ ησλ 220V. Οξίδεηαη δειαδή έλαο δπγφο 

(Single Busbar System With Tie Breaker) κε νλφκαηα No. 1 220 V feeder panel θαη No. 2 

220 V feeder panel αληίζηνηρα γηα θάζε ηνπ πιεπξά. Οη ηζνδχλακνη θηλεηήξεο (πνπ θαη εδψ 

είλαη ίδηνη) έρνπλ νλνκαζηηθή ηζρχ 150 kW έθαζηνο θαη νη παξάκεηξνη ζηελ θαξηέια Load 

Flow ηνπ ηχπνπ ηνπ θηλεηήξα, είλαη ίδηνη κε ηνπο ππφινηπνπο, ζχκθσλα πάληα κε ην πξφηππν 

IEC 61363.  

 

Μεηαζρεκαηηζηέο 

 

΢ε απηφ ην ζεκείν, ζα πξέπεη λα ζπλδεζνχλ νη θαηάιιεινη κεηαζρεκαηηζηέο ζην δίθηπν ιφγσ 

ησλ δηαθνξεηηθψλ επηπέδσλ ηάζεο. Δπεηδή θάζε δπγφο απνηειείηαη απφ 2 επηκέξνπο ηκήκαηα, 

ηνπνζεηνχληαη 2 κεηαζρεκαηηζηέο θάζε θνξά (4 ζην ζχλνιν).  
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Επγνί 6600-440V 

 

Δπηιέγεηαη ην ζηνηρείν 2-Winding Transformer απφ ηελ εξγαιεηνζήθε. Αθνινχζσο 

αλνίγνληαο ην παξάζπξν δηαιφγνπ: 

 

 Name: No. 1 main transformer 

 Type → New Project Type 
 

 

Καξηέια Basic Data (.TypTr2) 

 

 Name: 6600/450 V Tr 

 Rated Power: 2.2 MVA 

 Nominal Frequency: 60 Hz 

 Rated Voltage: HV-Side 6.6 kV, LV-Side 0.45 kV 

 

Ο κεηαζρεκαηηζηήο απηφο «αληηγξάθεηαη» θαη ζην άιιν ηκήκα ησλ δπγψλ, κεηνλνκάδνληαο 

ηνλ ζε No. 2 main transformer.  

 

Επγνί 440-220V 

 

Όκνηα ηνπνζεηνχληαη άιινη 2 ίδηνη κεηαζρεκαηηζηέο κε ζηνηρεία: 

 

 Name: No. 1 sec transformer 

 Type → New Project Type 
Καξηέια Basic Data (.TypTr2) 

 

 Name: 440/230 V Tr 

 Rated Power: 0.23 MVA 

 Nominal Frequency: 60 Hz 

 Rated Voltage: HV-Side 0.44 kV, LV-Side 0.23 kV 

 
΢ε απηφ ην ζεκείν νινθιεξψλεηαη ν ζρεδηαζκφο ηνπ δηθηχνπ ζηελ πιαηθφξκα ηνπ 

PowerFactory. ΢ηελ Δηθφλα 6.1 πνπ αθνινπζεί θαίλεηαη ε ηειηθή κνξθή ηνπ δηθηχνπ.  
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Εικόνα 6.1: Γίθηπν ηζρύνο δεμακελόπινηνπ 
 

΢ην ζεκείν απηφ δεκηνπξγνχληαη 2 λέα grid κέζα ζην ίδην project πξνθεηκέλνπ λα κειεηεζεί 

θάζε κηα απφ ηηο 3 θαηαζηάζεηο (normal sea going, port in/out θαη unloading) απηφλνκα. Ο 

ρξήζηεο ζα πξέπεη λα αληηγξάςεη απηνχζην ην δίθηπν (Δηθφλα 6) ζηα θαηλνχξηα grid, 

δίλνληαο ζε θάζε έλα ηα νλφκαηα ησλ 3 θαηαζηάζεσλ γηα ιφγνπο πιεξφηεηαο θαη επθνιίαο. 

΢ηελ Δηθφλα 6.2 θαίλεηαη ε ηειηθή κνξθή ηνπ project. 

 

Εικόνα 6.2: Σειηθή κνξθή ηνπ δηθηύνπ κε ηα 3 grid ελζωκαηωκέλα  
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6.2 Προςομούωςη ροόσ φορτύου ςτο περιβϊλλον του 
PowerFactory 

 
Ζ απαίηεζε ηζρχνο ζε θάζε θαηάζηαζε ιεηηνπξγίαο είλαη δηαθνξεηηθή. Έηζη ζε θάζε κηα απφ 

απηέο, ιεηηνπξγνχλ δηαθνξεηηθνί θηλεηήξεο θαη κάιηζηα θάπνηνη δελ ιεηηνπξγνχλ ζηελ 

νλνκαζηηθή ηνπο ηζρχ αιιά ζε κηθξφηεξε (απηφ θαζνξίδεηαη απφ ηνλ ζπληειεζηή ιεηηνπξγίαο 

πνπ θαίλεηαη ζηνπο πίλαθεο ηνπ ειεθηξηθνχ ηζνινγηζκνχ).  

Πξνθεηκέλνπ λα πξαγκαηνπνηεζεί ε πξνζνκνίσζε ξνήο θνξηίνπ ζε θάζε θαηάζηαζε, ζα 

πξέπεη λα νξηζηεί πνηεο γελλήηξηεο βξίζθνληαη ζε ιεηηνπξγία, πνηνη θηλεηήξεο ιεηηνπξγνχλ 

θαη πφζε ηζρχ θαηαλαιψλνπλ. Όια απηά ηα ζηνηρεία έρνπλ ιεθζεί απφ ηνλ ηζνινγηζκφ. Έηζη 

έρνπκε ηα εμήο: 

 

 

6.2.1.Κατϊςταςη κανονικόσ πορεύασ (Normal Sea going) 
 
΢ηε ζπγθεθξηκέλε θαηάζηαζε βξίζθνληαη ζε ιεηηνπξγία ηα εμήο: 

 

Επγόο 6600 kV 

 

Γελλήηξηεο: 1 x 3300 kW 

Κηλεηήξεο: 0 (απνζπλδένληαη δειαδή ηα thrusters θαη ε αληιία θνξηίνπ)  

 

Επγόο 440 kV 

 

Equivalent motor 1: ζε ιεηηνπξγία 

Equivalent motor 2: ζε ιεηηνπξγία 

΢ην παξάζπξν δηαιφγνπ θάζε θηλεηήξα (.ElmAsm), ζηελ θαξηέια Load Flow νξίδεηαη 

Active Power = 0.3309 MW 

 

Επγόο 220 kV 

 

Equivalent motor 1: ζε ιεηηνπξγία 

Equivalent motor 2: ζε ιεηηνπξγία 

΢ην παξάζπξν δηαιφγνπ θάζε θηλεηήξα (.ElmAsm), ζηελ θαξηέια Load Flow νξίδεηαη 

Active Power = 0.12315 MW 

 

΢εκείωζε: Γηα λα απνζπλδεζνύλ νη γελλήηξηεο, θηλεηήξεο θιπ από ηνπο δπγνύο, κε δεμί θιηθ 

ζην εθάζηνηε ζηνηρείν από ην κελνύ πνπ αλνίγεη επηιέγεηαη Disconnect Element. Έλαο δεύηεξνο 

ηξόπνο, πην γξήγνξνο, είλαη κε δηπιό θιηθ ζην δηαθόπηε θάζε ζηνηρείνπ. Ζ 

ζύλδεζε/απνζύλδεζε ζηνηρείωλ από ην δίθηπν πεξηγξάθεηαη θαη ζην αληίζηνηρν θεθάιαην ηωλ 

tutorial.  
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6.2.2.Κατϊςταςη χειριςμών ςτο λιμϊνι (At port in/out) 
 
Επγόο 6600 kV 

 

Γελλήηξηεο (2): 1 x 3300 kW θαη 1 x 4300 kW 

Κηλεηήξεο: 1 x bow tunnel thruster 2200 kW   

΢ην παξάζπξν δηαιφγνπ ηνπ thruster (.ElmAsm), ζηελ θαξηέια Load Flow νξίδεηαη Active 

Power = 1.9708 MW 

 

 

Επγόο 440 kV 

 

Equivalent motor 1: ζε ιεηηνπξγία 

Equivalent motor 2: ζε ιεηηνπξγία 

΢ην παξάζπξν δηαιφγνπ θάζε θηλεηήξα (.ElmAsm), ζηελ θαξηέια Load Flow νξίδεηαη 

Active Power = 0.5646 MW 

 

Επγόο 220 kV 

 

Equivalent motor 1: ζε ιεηηνπξγία 

Equivalent motor 2: ζε ιεηηνπξγία 

΢ην παξάζπξν δηαιφγνπ θάζε θηλεηήξα (.ElmAsm), ζηελ θαξηέια Load Flow νξίδεηαη 

Active Power = 0.12615 MW 

 

 

6.2.3 Κατϊςταςη εκφορτώςεωσ (At unloading) 
 
Επγόο 6600 kV 

 

Γελλήηξηεο (2): 1 x 3300 kW θαη 1 x 4300 kW 

Κηλεηήξεο: Cargo oil pump 2000 kW   

΢ην παξάζπξν δηαιφγνπ ηεο αληιίαο (.ElmAsm), ζηελ θαξηέια Load Flow νξίδεηαη Active 

Power = 1.6842 MW 

 

Επγόο 440 kV 

 

Equivalent motor 1: ζε ιεηηνπξγία 

Equivalent motor 2: ζε ιεηηνπξγία 

΢ην παξάζπξν δηαιφγνπ θάζε θηλεηήξα (.ElmAsm), ζηελ θαξηέια Load Flow νξίδεηαη 

Active Power = 0.7488 MW 

 

Επγόο 220 kV 

 

Equivalent motor 1: ζε ιεηηνπξγία 

Equivalent motor 2: ζε ιεηηνπξγία 

΢ην παξάζπξν δηαιφγνπ θάζε θηλεηήξα (.ElmAsm), ζηελ θαξηέια Load Flow νξίδεηαη 

Active Power = 0.1183 MW 
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΢ε απηφ ην ζεκείν ην δίθηπν είλαη έηνηκν γηα ηελ πξνζνκνίσζε. Ο ρξήζηεο έρεη ηε 

δπλαηφηεηα λα «ηξέμεη» ηαπηφρξνλα ην load flow ζε φια ηα δηαγξάκκαηα (grid). Ωζηφζν 

δχλαηαη λα απελεξγνπνηήζεη θάπνην ή θάπνηα grid θαη λα γίλνληαη νη ππνινγηζκνί κφλν ζε 

έλα θάζε θνξά. ΢ην αξηζηεξφ παξάζπξν ηνπ PowerFactory ππάξρεη ε ιίζηα κε φια ηα 

δηαγξάκκαηα πνπ ππάξρνπλ ζην project. Δπηιέγνληαο θάζε θνξά έλα grid κε δεμί θιηθ, απφ 

ην κελνχ πνπ αλνίγεη ππάξρεη ε δπλαηφηεηα deactivate (θαη activate αληίζηνηρα).  

Καηά ηα γλσζηά (βιέπε θεθάιαηα 2,3) εθηειείηαη ν ππνινγηζκφο ηνπ Load Flow κε ηηο 

default επηινγέο ηνπ πξνγξάκκαηνο.  

 

 

6.2.4  Power frequency controller 
 
΢ηηο θαηαζηάζεηο ρεηξηζκψλ (port in/out) θαη εθθφξησζεο (unloading) παξαηεξείηαη φηη ε κηα 

απφ ηηο 2 γελλήηξηεο θάζε θνξά, θνξηίδεηαη ζην 100% ελψ ε δεχηεξε ζε πνιχ κηθξφηεξν 

πνζνζηφ. Απηφ θπζηθά δελ αληηπξνζσπεχεη πξαγκαηηθέο ζπλζήθεο ιεηηνπξγίαο αθνχ νη 

γελλήηξηεο πνπ ιεηηνπξγνχλ παξάιιεια θαη εμππεξεηνχλ ηε δήηεζε ηζρχνο ζην δίθηπν ηνπ 

πινίνπ, κνηξάδνληαη ηε δήηεζε απηή αλάινγα βέβαηα θαη κε ηα ζηνηρεία ηνπο (νλνκαζηηθή 

ηζρχο, ζπληειεζηήο ηζρχνο). Απηφ ζπκβαίλεη δηφηη απηφκαηα ην PowerFactory νξίδεη κηα 

γελλήηξηα σο γελλήηξηα αλαθνξάο (slack) πξνθεηκέλνπ λα εθηειεζηεί ην load flow (κε ηηο 

default επηινγέο), εθφζνλ βέβαηα δελ έρεη γίλεη θάπνηα δηαθνξεηηθή ξχζκηζε απφ ηνλ ρξήζηε 

(π.ρ. νξηζκφο ελφο controller). 

 

Πξνθεηκέλνπ λα δηνξζσζεί απηφ, ππάξρεη ε δπλαηφηεηα λα νξηζηεί έλαο frequency controller 

φπσο ραξαθηεξηζηηθά νλνκάδεηαη κέζα ζην PowerFactory, ν νπνίνο ζα αλαιάβεη λα 

θαζνξίζεη ηελ ηζρχ θάζε γελλήηξηαο ρσξίο λα παξαηεξείηαη ην θαηλφκελν πνπ πεξηγξάθεθε 

παξαπάλσ. 

 

Οξηζκφο Power Frequency Controller 

 

O ρξήζηεο ζα πξέπεη λα επηιέμεη ηαπηφρξνλα ηηο 2 γελλήηξηεο θαη έλα απφ ηα 2 ηκήκαηα ηνπ 

δπγνχ ησλ 6600 kV. ΢ηε ζπλέρεηα κε δεμί θιηθ ζε κηα απφ ηηο γελλήηξηεο: DefinePower 

Frequency Controller, νπφηε αλνίγεη ην παξάζπξν δηαιφγνπ ηνπ controller φπσο θαίλεηαη 

ζηελ Δηθφλα 6.3 
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Εικόνα 6.3: Παξάζπξν δηαιόγνπ Power Frequency Controller 

 

Καξηέια Basic Data 

 

 Name: Power Frequency Controller 
 

Καξηέια Load Flow 

 

 Control Mode: Frequency Control 

 Active Power Distribution: According to Nom. Power 
 

Απηφο ν ξπζκηζηήο θαζνξίδεη ηε ηζρχ πνπ παξάγεη ε θάζε γελλήηξηα σο εμήο: 

 
𝑃𝑖

𝑃𝜊𝜆
=

𝑆𝑖,𝑛𝑜𝑚

𝑆𝜊𝜆 ,𝑛𝑜𝑚
 

 

ελψ ην πνζνζηφ θφξηηζεο θάζε γελλήηξηαο πξνθχπηεη απφ ην ιφγν 

 
𝑆𝜆𝜀𝜄𝜏

𝑆𝑖,𝑛𝑜𝑚
 

 

φπνπ 

 𝑃𝑖  : ε ελεξγφο ηζρχο θάζε γελλήηξηαο 

𝑃𝜊𝜆  : ε ζπλνιηθή ελεξγφο ηζρχο πνπ απαηηείηαη απφ ηνπο θαηαλαισηέο ηνπ δηθηχνπ 

𝑆𝑖,𝑛𝑜𝑚 : ε νλνκαζηηθή θαηλφκελε ηζρχο ηεο γελλήηξηαο,  

𝑆𝜊𝜆 ,𝑛𝑜𝑚 : ε ζπλνιηθή θαηλφκελε ηζρχο φισλ ησλ γελλεηξηψλ πνπ ιεηηνπξγνχλ 
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𝑆𝜆𝜀𝜄𝜏 : ε θαηλφκελε ηζρχο ιεηηνπξγίαο ηεο εθάζηνηε γελλήηξηαο.  

 

Δθηεινχκε εθ λένπ ηνλ ππνινγηζκφ ξνήο θνξηίνπ επηιέγνληαο απφ ηελ κπάξα θχξησλ 

εηθνληδίσλ ην Calculate Load Flow ( ), νπφηε αλνίγεη ην παξάζπξν δηαιφγνπ ηνπ 

ππνινγηζκνχ. ΢ηελ θαξηέια Basic Options δηαηεξνχκε ηηο default επηινγέο ηνπ 

πξνγξάκκαηνο, ελψ ζηελ θαξηέια Active Power Control επηιέγνπκε according to Secondary 

Control (Δηθφλα 6.), πξνθεηκέλνπ ην PowerFactory λα εθηειέζεη ηνλ ππνινγηζκφ ζχκθσλα 

κε ηε ξχζκηζε γηα ηελ παξαγφκελε ηζρχ. Ζ ξχζκηζε απηή αθνξά ηηο θαηαζηάζεηο ρεηξηζκψλ 

ζην ιηκάλη θαη εθθφξησζεο. Ωζηφζν, δελ επεξεάδεη ηα απνηειέζκαηα ηεο θαηάζηαζεο ελ 

πισ, θαζφηη ζε απηήλ δελ έρεη νξηζηεί θάπνηνο έιεγρνο. ΢ε απηή ηε βάζε, ν ππνινγηζκφο 

δίλεη ηα απνηειέζκαηα ζηα πιαίζηα απνηειεζκάησλ ηνπ κνλνγξακκηθνχ δηαγξάκκαηνο. Ο 

Πίλαθαο 6.3 πεξηιακβάλεη ηα απνηειέζκαηα ηεο ξνήο θνξηίνπ ζην δίθηπν, γηα ηηο ηξεηο 

θαηαζηάζεηο ιεηηνπξγίαο ηνπ πινίνπ. Σν κέγεζνο πνπ εμεηάδεηαη είλαη απηφ ηεο ελεξγνχ 

ηζρχνο γηα ηηο γελλήηξηεο θαη ηνπο θηλεηήξεο. Δπίζεο, παξαηίζεληαη θαη νη θνξηίζεηο ησλ 

ζηνηρείσλ, νη νπνίεο πξνθχπηνπλ απφ ην πειίθν ηεο ζπλνιηθήο θαηλφκελεο ηζρχνο πξνο ηελ 

νλνκαζηηθή θαηλφκελε ηζρχ. 

 

 
Εικόνα 6.4: Δθηέιεζε ππνινγηζκνύ ξνήο θνξηίνπ ζύκθωλα κε ηνλ έιεγρν ηεο παξαγόκελεο ηζρύνο
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Απνηειέζκαηα ππνινγηζκνύ ξνήο θνξηίνπ 

 Nominal Normal sea going At port in/out At unloading 

 Output (kW) Power (kW) Loading (%) Power (kW) Loading (%) Power (kW) Loading (%) 

DG1 3300 908.1 58.3 1455.6 64.7 1484.3 65.1 

DG2 4300 0.0 0.0 0.0 0.0 0.0 0.0 

DG3 4300 0.0 0.0 1896.7 55.8 1934.1 54.0 

DG4 3300 0.0 0.0 0.0 0.0 0.0 0.0 

Total 15200 908.1 - 3352.3 - 3418.4 - 

Cargo oil pump 2000 0.0 0.0 0.0 0.0 1684.2 86.9 

No. 1 bow tunnel thruster 2200 0.0 0.0 1970.8 89.9 0.0 0.0 

No. 5 stern tunnel thruster 2200 0.0 0.0 0.0 0.0 0.0 0.0 

No. 3 bow azimuth thruster 2500 0.0 0.0 0.0 0.0 0.0 0.0 

No. 2 bow tunnel thruster 2200 0.0 0.0 0.0 0.0 0.0 0.0 

No. 4 stern azimuth thruster 2500 0.0 0.0 0.0 0.0 0.0 0.0 

440 V equiv. motor 1 987.15 330.9 66.0 564.6 74.3 748.8 83.1 

440 V equiv. motor 2 987.15 330.9 66.0 564.6 74.3 748.8 83.1 

220 V equiv. motor 1 150 123.1 88.6 126.1 89.7 118.3 86.9 

220 V equiv. motor 2 150 123.1 88.6 126.1 89.7 118.3 86.9 

Total 15874.3 908 - 3352.2 - 3418.4 - 

Πίλαθαο 6.3 

 

 



129 
 

΢ηνλ πξνεγνχκελν πίλαθα, δίλνληαη ηα αζξνίζκαηα ησλ kW ηφζν ησλ γελλεηξηψλ φζν θαη 

ησλ θηλεηήξσλ. Όπσο ήηαλ αλακελφκελν, ε ζπλνιηθή παξαγσγή ηζρχνο ηζνχηαη κε ηε 

ζπλνιηθή θαηαλάισζε ηζρχνο ζε θαζεκία απφ ηηο ηξεηο θαηαζηάζεηο ιεηηνπξγίαο ηνπ πινίνπ. 

Δπίζεο, ε θφξηηζε ησλ γελλεηξηψλ, ζηηο θαηαζηάζεηο ρεηξηζκψλ ζην ιηκάλη θαη εθθφξησζεο, 

παξακέλεη ζε απνδεθηά επίπεδα, ράξε ζηε ξχζκηζε γηα ηελ παξαγφκελε ηζρχ, ε νπνία δελ 

επηηξέπεη ηελ ππεξθφξηηζε ηεο κίαο απφ ηηο δχν γελλήηξηεο. Δπηπιένλ, ε θφξηηζε ησλ 

θηλεηήξσλ δελ ππεξβαίλεη ζε θακία πεξίπησζε ην 90%. 
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ΚΕΥΑΛΑΙΟ 7 
Επύλογοσ 

 
7.1. ΢ύνοψη και ςυμπερϊςματα 

 
Σν DIgSILENT PowerFactory είλαη έλα ηζρπξφ ινγηζκηθφ αλάιπζεο ζπζηεκάησλ ειεθηξηθήο 

ελέξγεηαο, ην νπνίν ρξεζηκνπνηείηαη γηα εθαξκνγέο ζρεηηθέο κε ηελ παξαγσγή, ηε κεηάδνζε 

θαη ηε δηαλνκή ειεθηξηθήο ελέξγεηαο, θαζψο θαη γηα κειέηεο βηνκεραληθψλ ζπζηεκάησλ. 

Καηά ηελ πινπνίεζε ηεο παξνχζαο δηπισκαηηθήο εξγαζίαο, ε νπνία ζθνπφ έρεη ηε 

δηεξεχλεζε ησλ δπλαηνηήησλ πνπ πξνζθέξεη ην ελ ιφγσ ινγηζκηθφ ζηνλ ηνκέα ηεο λαπηηθήο 

κεραλνινγίαο θαη ζπγθεθξηκέλα ζηε κειέηε ξνψλ θνξηίνπ ηφζν ζε απινπνηεκέλα δίθηπα 

φζν θαη ζε δίθηπα πινίσλ, έγηλε πξνζπάζεηα λα επηηεπρζνχλ νη παξαθάησ ζηφρνη: 

1. Γλσξηκία ηνπ αλαγλψζηε κε ηηο βαζηθέο πηπρέο ηνπ PowerFactory, κέζα απφ ηελ 

έθζεζε αλαιπηηθψλ νδεγηψλ γηα ηε ιεηηνπξγία ηνπ, πξνθεηκέλνπ λα θαηαζηεί εθηθηή 

ε αθαδεκατθή ρξήζε ηνπ γηα εθαξκνγέο ζηνλ ηνκέα ηεο λαπηηθήο κεραλνινγίαο 

2. ΢πλνπηηθή έθζεζε ηεο ζεσξίαο γηα ηελ επίιπζε πξνβιεκάησλ ξνψλ θνξηίνπ 

3. Μειέηε πξνβιεκάησλ ξνψλ θνξηίνπ ζε απιά δίθηπα ειεθηξηθήο ελέξγεηαο θαη 

εμέηαζε ησλ απνηειεζκάησλ ησλ πξνζνκνηψζεσλ ππφ ην πξίζκα ησλ αλαιπηηθψλ 

ζρέζεσλ ηεο ειεθηξνηερλίαο 

4. Πξνζνκνίσζε εθθίλεζεο ελφο επαγσγηθνχ θηλεηήξα απφ πξαγκαηηθφ δίθηπν πινίνπ 

θαη ζχγθξηζε ησλ απνηειεζκάησλ κε ηηο αληίζηνηρεο ηηκέο πνπ δίλνληαη ζε ζρεηηθφ 

ηερληθφ θπιιάδην ηνπ πινίνπ 

5. Μειέηε ξνψλ θνξηίνπ ζην ειεθηξηθφ δίθηπν ελφο πξαγκαηηθνχ πινίνπ κεηαθνξάο 

παξαγψγσλ πεηξειαίνπ θαη αληηκεηψπηζε ηνπ πξνβιήκαηνο θαηαλνκήο ηεο 

παξαγφκελεο ειεθηξηθήο ηζρχνο απφ ηηο ειεθηξνγελλήηξηεο 

6. Γεκηνπξγία κίαο αληηπξνζσπεπηηθήο βάζεο δεδνκέλσλ – βηβιηνζήθεο κε 

νινθιεξσκέλα ζρέδηα (projects) ζηελ πιαηθφξκα ηνπ PowerFactory, ηα νπνία είλαη 

δηαζέζηκα γηα αθαδεκατθή ρξήζε 

 

Μέζα απφ ηελ πξνεγνχκελε δηαδηθαζία θαη ηελ επίιπζε ησλ πξνβιεκάησλ πνπ πξνέθπςαλ, 

έγηλε δπλαηή ε δηεξεχλεζε ησλ δπλαηνηήησλ πνπ πξνζθέξεη ην κειεηψκελν ινγηζκηθφ 

παθέην, θαζψο θαη ν εληνπηζκφο νξηζκέλσλ πξνβιεκαηηθψλ ζηνηρείσλ. 

 

Ωο βαζηθά πιενλεθηήκαηα ηνπ PowerFactory ζεσξνχληαη ηα αθφινπζα: 

 Γπλαηφηεηα ρξήζεο γηα ηελ αλάιπζε ηφζν απιψλ ειεθηξηθψλ δηθηχσλ φζν θαη 

ζχλζεησλ ζπζηεκάησλ ειεθηξηθήο ελέξγεηαο κεγάιεο θιίκαθαο 

 Τπνζηήξημε φισλ ησλ ζηνηρείσλ θαη αλαπαξαζηάζεσλ ειεθηξηθψλ δηθηχσλ, θαζψο 

θαη φισλ ησλ ηερλνινγηψλ θάζεσλ, γηα δίθηπα ΔΡ ή ΢Ρ 

 Πιεζψξα κεηαβιεηψλ γηα ηελ θαιχηεξε δπλαηή πεξηγξαθή ησλ ζηνηρείσλ ησλ 

ζπζηεκάησλ ειεθηξηθήο ελέξγεηαο, κε δπλαηφηεηα επηινγψλ δηαθνξεηηθψλ κνληέισλ 

αλαπαξάζηαζεο 

 Δχρξεζηα δηαγξάκκαηα ειεθηξηθψλ δηθηχσλ θαη πνηνηηθέο γξαθηθέο αλαπαξαζηάζεηο 

 Πνηθηιία ζρεηηθά απιψλ ηξφπσλ αιιειεπίδξαζεο ηνπ ρξήζηε κε ην ινγηζκηθφ 
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 Λεπηνκεξήο θαζνδήγεζε ηνπ ρξήζηε γηα ηελ εηο βάζνο κειέηε θαη εμεηδίθεπζε, κέζσ 

ελφο ηδηαίηεξα αλαιπηηθνχ manual [9] 

 Δλζσκάησζε φισλ ησλ γλσζηψλ ππνινγηζκψλ θαη δηαδηθαζηψλ αλάιπζεο πνπ 

αθνξνχλ ηα ζπζηήκαηα ειεθηξηθήο ελέξγεηαο, φπσο είλαη ε αλάιπζε ξνψλ θνξηίνπ 

(load flow analysis), ε αλάιπζε βξαρπθπθιψκαηνο (short-circuit analysis), ε 

εθθίλεζε θηλεηήξα (motor starting), ε αξκνληθή αλάιπζε (harmonics analysis), ε 

πξνζνκνίσζε κεηαβαηηθψλ θαηλνκέλσλ (RMS/ EMT simulation), ν ππνινγηζκφο 

ηδηνηηκψλ (eigenvalue calculation), ε αλάιπζε θαηαζηάζεσλ έθηαθηεο αλάγθεο 

(contingency analysis) θ.ιπ. 

 Υξήζε κίαο κνλαδηθήο βάζεο δεδνκέλσλ γηα ηελ απνζήθεπζε φισλ ησλ δεδνκέλσλ 

γηα ηνλ εμνπιηζκφ ελφο ζπζηήκαηνο ειεθηξηθήο ελέξγεηαο, κε ζηφρν ηελ εχθνιε 

εθηέιεζε φισλ ησλ δηαδηθαζηψλ πξνζνκνίσζεο εληφο ηνπ ίδηνπ πξνγξακκαηηζηηθνχ 

πεξηβάιινληνο 

 

Ωο θχξηα κεηνλεθηήκαηα ηνπ PowerFactory, ππφ ην πξίζκα ηεο αθαδεκατθήο ρξήζεο, 

εληνπίδνληαη ηα εμήο: 

 Πνιππινθφηεηα θαη αλάγθε ζπζηεκαηηθήο ελαζρφιεζεο γηα ηελ εμνηθείσζε κε ην 

πξφγξακκα, ιφγσ ηνπ πξννξηζκνχ ηνπ γηα ηε κειέηε ζχλζεησλ ζπζηεκάησλ 

ειεθηξηθήο ελέξγεηαο θαη βηνκεραληθέο εθαξκνγέο κεγάιεο θιίκαθαο 

 Αλεπαξθήο ππνζηήξημε ηεο γλσξηκίαο κε ην πξφγξακκα γηα αξράξηνπο θαη θνηηεηέο 

κε ζεσξεηηθέο γλψζεηο πξνπηπρηαθνχ ή/θαη κεηαπηπρηαθνχ επηπέδνπ, κε κνλαδηθή 

εμαίξεζε ηελ χπαξμε ελφο πεξηεθηηθνχ θαη εχζηνρνπ tutorial [1] 

 Έιιεηςε λαπηηθψλ εθαξκνγψλ ηνπ πξνγξάκκαηνο 

 Γπζθνιία θαζνξηζκνχ ησλ ζηνηρείσλ ελφο ειεθηξηθνχ δηθηχνπ, ιφγσ χπαξμεο κίαο 

πιεζψξαο παξακέηξσλ, νη ηηκέο ησλ νπνίσλ δελ είλαη πάληα γλσζηέο 

 Σερληθέο δπζθνιίεο ζηε δεκηνπξγία δηαγξακκάησλ ησλ κειεηψκελσλ κεγεζψλ θαη 

αλεπαξθήο επεμήγεζε ζην manual ηνπ πξνγξάκκαηνο 

 ΢πρλή αλεπάξθεηα ησλ κελπκάησλ ζθαικάησλ γηα ηε δηφξζσζε ησλ ειεθηξηθψλ 

δηθηχσλ θαηά ην ζρεδηαζκφ 

 

 

7.2. Προτϊςεισ για ακαδημαώκό χρόςη του PowerFactory και 
περαιτϋρω μελϋτη 

 
Παξά ηηο δπζθνιίεο πνπ εκθαλίδεη ε εμνηθείσζε κε ην PowerFactory, ιφγσ ηεο 

πνιππινθφηεηάο ηνπ, ην ππφ κειέηε ινγηζκηθφ παθέην πξνζθέξεηαη γηα αθαδεκατθή ρξήζε, 

απνηειψληαο κία πνηνηηθφηεξε ελαιιαθηηθή ζε ζρέζε κε άιια πξνγξάκκαηα, φπσο είλαη ην 

ETAP θαη ην PSCAD, θαζφηη είλαη πιεξέζηεξν θαη αλαλεψλεηαη ζπλερψο. Μέζσ ηεο 

θαηάιιειεο ππνζηήξημεο, ην ζπγθεθξηκέλν ινγηζκηθφ ζα κπνξνχζε λα απνηειέζεη ηε βάζε 

γηα ηελ θαιχηεξε θαηαλφεζε ηεο ζεσξίαο ηεο ειεθηξνηερλίαο θαη ηελ εκβάζπλζε ζε 

αξηζκεηηθέο κεζφδνπο, φπσο ε κέζνδνο Newton-Raphson. Πην ζπγθεθξηκέλα, ζην πιαίζην 

ηνπ πξνπηπρηαθνχ καζήκαηνο «Ζιεθηξνηερληθέο Δθαξκνγέο θαη Ζιεθηξνινγηθφ 

Δξγαζηήξην» ηνπ 4νπ εμακήλνπ ηεο ΢ρνιήο Ναππεγψλ Μεραλνιφγσλ Μεραληθψλ ΔΜΠ, ην 

PowerFactory ζα κπνξνχζε λα ζπλεηζθέξεη ζηνλ εκπινπηηζκφ ηεο αθαδεκατθήο δηαδηθαζίαο 

θαη ζηελ άκεζε εθαξκνγή ησλ ζεσξεηηθψλ γλψζεσλ ζηελ επίιπζε πξαγκαηηθψλ 

πξνβιεκάησλ. Πξφθεηηαη γηα πξνβιήκαηα λαπηηθήο κεραλνινγίαο, ηα νπνία έλαο Ναππεγφο 

Μεραλνιφγνο Μεραληθφο πηζαλά ζα θιεζεί λα αληηκεησπίζεη θαηά ηε δηάξθεηα ηεο 

επαγγεικαηηθήο ηνπ ζηαδηνδξνκίαο. 
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Όπσο αλαθέξζεθε θαη ζηελ ελφηεηα 7.1, ε παξνχζα δηπισκαηηθή εξγαζία επηδηψθεη, κεηαμχ 

άιισλ, λα πξνζθέξεη ην θαηάιιειν ππφβαζξν γηα κειινληηθή αθαδεκατθή ρξήζε ηνπ 

PowerFactory, κέζσ ηεο έληαμήο ηνπ ζηα αληίζηνηρα καζήκαηα ηεο ΢ρνιήο. ΢ηελ 

θαηεχζπλζε απηή, ην θεθάιαην 2 πεξηιακβάλεη γεληθέο νδεγίεο γηα ηελ εμνηθείσζε ησλ 

θνηηεηψλ κε ην πεξηβάιινλ ηνπ πξνγξάκκαηνο. Δπίζεο, ην ζεσξεηηθφ ππφβαζξν ζε 

ζπλδπαζκφ κε ην καζεκαηηθφ κνληέιν ηεο κεζφδνπ Newton-Raphson, πνπ ρξεζηκνπνηεί θαη 

ην ίδην ην ινγηζκηθφ ζηνπο θψδηθέο ηνπ γηα ηηο ξνέο θνξηίνπ, παξνπζηάδεηαη ζην θεθάιαην 3. 

Δθαξκνγέο ζηε κειέηε ξνψλ θνξηίνπ ζε απιά δίθηπα παξνπζηάδνληαη αλαιπηηθά ζην 

θεθάιαην 4, κε ζηφρν ηε κνληεινπνίεζε θαη θαηαλφεζε πξνβιεκάησλ, αζθήζεσλ θαζψο θαη 

ηελ εθπφλεζε εξγαζηψλ ζηα πξνπηπρηαθά καζήκαηα «Ζιεθηξνηερλία» θαη «Ζιεθηξνηερληθέο 

Δθαξκνγέο θαη Ζιεθηξνινγηθφ Δξγαζηήξην». Αθνινχζσο, ε πξνζνκνίσζε εθθίλεζεο 

επαγσγηθνχ θηλεηήξα πινίνπ ζην θεθάιαην 5 απνηειεί έλα ηππηθφ παξάδεηγκα ρξήζεο ηνπ 

ινγηζκηθνχ ζηε κειέηε κεηαβαηηθψλ θαηλνκέλσλ θαηά ηελ εθθίλεζε θηλεηήξσλ. Σέινο, ζην 

θεθάιαην 6 πξαγκαηνπνηείηαη κία κειέηε ξνήο θνξηίνπ βαζηδφκελε ζε έλα πξαγκαηηθφ 

δίθηπν πινίνπ κεηαθνξάο παξαγψγσλ πεηξειαίνπ, αληηκεησπίδνληαο παξάιιεια ην 

πξφβιεκα ηεο θαηαλνκήο ηεο παξαγφκελεο ειεθηξηθήο ελέξγεηαο ζηηο γελλήηξηεο θαη ηνπο 

θαηαλαισηέο. Σα δχν ηειεπηαία θεθάιαηα κπνξνχλ λα απνηειέζνπλ ηε βάζε γηα εθαξκνγέο 

θαη πεξαηηέξσ κειέηε αληίζηνηρσλ πξνβιεκάησλ ζην πιαίζην ηνπ καζήκαηνο «Δλεξγεηαθά 

΢πζηήκαηα Πινίνπ».   

 

Δπηπξφζζεηα, ην PowerFactory δηαζέηεη ηνπο ππνινγηζκνχο δηαζηαζηνιφγεζεο θαισδίσλ 

(cable sizing) θαη πξνζηαζίαο (protection), νη νπνίνη πξνζθέξνληαη γηα κειινληηθέο κειέηεο 

ηφζν ζε ζρέζε κε ηε ξνή θνξηίνπ (ππεξθφξησζε/ππεξέληαζε ζηνηρείσλ) φζν θαη κε 

κεηαβαηηθά θαηλφκελα φπσο ε εθθίλεζε θηλεηήξσλ. ΢ηελ πξψηε πεξίπησζε, γηα παξάδεηγκα, 

κπνξνχλ λα εμεηαζηνχλ νη παξάκεηξνη γηα ηελ θαηάιιειε επηινγή θαισδίσλ ζε ζρέζε κε ηηο 

αλακελφκελεο ηηκέο ηνπ ξεπκάησλ ζηα δηάθνξα ζεκεία ιεηηνπξγίαο ησλ ζηνηρείσλ ηνπ 

εθάζηνηε δηθηχνπ. Σν manual ηνπ πξνγξάκκαηνο [9] πεξηέρεη ηηο απαηηνχκελεο νδεγίεο θαη 

πιεξνθνξίεο γηα ηελ εθηέιεζε ησλ ππνινγηζκψλ απηψλ.  

 

Δπηπιένλ, ηδηαίηεξν ελδηαθέξνλ παξνπζηάδεη ε πξνζνκνίσζε θαη κειέηε ξνήο θνξηίνπ ζε 

πξαγκαηηθά δίθηπα δηάθνξσλ ηχπσλ πινίσλ θαη γηα δηαθνξεηηθέο θαηαζηάζεηο ιεηηνπξγίαο 

(ελ πισ, ελ φξκσ θ.ά.), φπσο γηα παξάδεηγκα ζην πιαίζην ηνπ καζήκαηνο «Θέκα Μειέηεο 

θαη ΢ρεδίαζεο Πινίνπ», εθφζνλ ππάξρνπλ δηαζέζηκα ζηνηρεία γηα ηηο γελλήηξηεο θαη ηνπο 

θηλεηήξεο ησλ δηθηχσλ απηψλ. Σέινο, ηνκείο πνπ πξνζθέξνληαη γηα πεξαηηέξσ κειέηε ζην 

πεξηβάιινλ ηνπ PowerFactory είλαη ε κειέηε αληίζηνηρσλ πξνβιεκάησλ ζε εγθαηαζηάζεηο 

΢Ρ, ε κειέηε ησλ δηάθνξσλ κεζφδσλ εθθίλεζεο θηλεηήξα, ε αλάιπζε ζρεηηθά κε ηε βέιηηζηε 

ξνή ηζρχνο αληίζηνηρα ειεθηξηθά δίθηπα θαη ηέινο ε αλάιπζε αξκνληθψλ πνπ πξνθαινχληαη 

απφ κε γξακκηθά θνξηία θαη επηθέξνπλ κία ζεηξά πξνβιεκάησλ ζην δίθηπν ηνπ πινίνπ, φπσο 

ππεξθνξηίζεηο θαη ιαλζαζκέλε ιεηηνπξγία κεηξεηηθψλ νξγάλσλ. [10] 
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